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1.  Information About OLIGO 

1.1.  Copyright, License Agreements, Warranty, Copy 
Protection, & Technical Support 

OLIGO is a copyrighted software program.  As an OLIGO user, you are obligated 
to abide by the following license agreement. 

1.1.1.  Copyright 
The OLIGO®

 software copyright is owned by Wojciech Rychlik.  Molecular 
Biology Insights, Inc. is a manufacturer and primary distributor of the software. 
All copyrights are protected under the US Copyright Law and International Treaty 
provisions.  Therefore, you may not copy or reproduce the software, its 
documentation, or other package components with the exceptions noted under 
the specific licenses. 
By abiding by this contract, you agree not to reverse engineer, decompile, 
disassemble or otherwise attempt to discover the source code of the software. 

1.1.2.  Single-user License 
The single-user license is intended for one principal investigator’s use in his/her 
laboratory or other research environment.  The single-user license allows for two 
copies of the program in the lab or office computers.  Each additional computer 
license needs to be purchased separately, and the standard single user license 
may be expanded to maximum of 4 computers.  For every one computer license 
the copyright owner permits one additional home computer installation. 
The single-user license requires that the principal investigator or license holder 
register with an authorized distributor. 

1.1.3.  Multi-user License 
This multi-user license permits the installation of this software on the computers 
that belong to several principal investigators.  Each principal investigator in the 
multi-user agreement receives his/her own single-user license and is obligated to 
abide by the terms of the single-user license for 1 computer. 
The multi-user license requires that all principal investigators or their assigns 
register with an authorized distributor. 
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1.1.4.  Network License 
The network license permits the installation of this program on your facility's 
network, and its use simultaneously on given number of client computers (nodes) 
specified in the license contract.  
The license does not permit the installation of the program on computers other 
than those stated.   
The network license requires that the network administrator, or the users register 
with an authorized distributor. 

1.1.5.  License Transfer 
The authorized distributor licenses software to a particular user.  You may not 
rent, sublicense, or lend the software to another user.  You may, however, 
transfer the full software license and documentation package to another user.  If 
the license is transferred, contact your distributor to update the license.  This 
assumes that the software is removed from the original machines. 
The user must make all reasonable efforts to see that employees, agents, or 
other persons under the direction of, or in collaboration with, the user abide by 
the terms of this agreement. 

1.1.6.  Limited Warranty 
Molecular Biology Insights, Inc. (MBI) does not and cannot warrant the 
performance or results you obtain as a result of using the software or 
documentation.  MBI is not liable for any special, indirect, incidental, or 
consequential damages in any way relating to the use, or arising from the use, of 
this software or program disks. 
MBI gives a 30-day money back guarantee.  You may return this software within 
30 days from the date of purchase for a full refund minus the shipping and 
handling cost. 

1.1.7.  Governing Laws & General Provisions 
This agreement is governed by the laws of the State of Colorado, USA.  
The user agrees that the software and documentation will not be shipped, 
transferred, or exported to any country or used in any manner prohibited by the 
United States Export Administration Act or any other export laws, restrictions, or 
regulations. 

1.1.8.  Copy Protection 
OLIGO 7 customers must register their software license in order to use the 
program.   
Note  The program will not run on your computer until it is registered. 
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 The OLIGO 6 registration process is included with the installation procedures on 
a separate insert, which comes with this manual.  
Once the workstation code is generated, contact MBI, Inc. or its affiliates to 
submit the workstation code and receive the access code for your OLIGO 
program, if you cannot use internet.  

1.1.9.  Technical Support 
Technical support is available to registered users.  For the assistance, please 
contact your OLIGO distributor for technical support.  When you request 
technical support, have the following information available, or include it on your 
fax or E-mail. 
• Your name 
• Name of the licensed end user, if different 
• Institution 
• OLIGO license number 
The software updates may be downloaded from MBI web page www.oligo.net by 
using Oligo Help menu option. This service is free of charge.  MBI is the 
manufacturer of Oligo and you may contact the company with regards to 
technical help. 

1.2.  Essential Criteria for Optimal PCR Primers, 
Sequencing Primers, and Hybridization Probes 

OLIGO is a multi-functional program that searches for and selects 
oligonucleotides from a sequence file for polymerase chain reaction (PCR), DNA 
sequencing, site-directed mutagenesis, and various hybridization applications.  It 
calculates hybridization/melting temperatures and secondary structure of 
oligonucleotides based on the nearest neighbor thermodynamic values (Ref. 1, 2, 
5). Oligo also searches for restriction enzyme sites, analyzes open reading 
frames and more.  Oligo 7 citation recommendation is the reference number 26. 
There are three essential criteria for optimal PCR, sequencing primers, and for 
optimal hybridization probes.   

1.2.1.  Specificity 
Primers and probes should be highly specific for the intended target sequence 
and not hybridize to other sites in the nucleic acid sample.  Because sequencing 
conditions are typically not very stringent and the formation of primer-template 
duplexes with imperfect homology may be significant, specific primers are 
essential.  PCR or sequencing results are generally poor (because of high 
background) if there is base-pairing between the primer 3' position and sites 
other than the intended target in the active sequence. 
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1.2.2.  Free of Dimer and Hairpin Structures 
Another important requisite of primers, but not hybridization probes, is that they 
do not form dimers and/or hairpins during reactions.  Oligonucleotides that form 
dimers or hairpins function poorly in site-directed mutagenesis and in sequencing 
reactions, especially if double stranded DNA is used.  Dimer and/or hairpin-
forming primers are particularly troublesome when 3'-termini are tied up; this can 
cause internal primer extension, which eliminates the primer from the reaction 
and may contribute to false priming. 

1.2.3.  Form Stable Duplexes 
Primers and probes should form stable duplexes with the active sequence under 
the intended conditions.  GC-rich regions are more stable than AT-rich regions. 
Generally, primers should not have 3'-ends that are too stable.  This increases 
the chance of false priming.  For more information on false priming, refer to 
Chapter 7 - The OLIGO Analyze Menu. 
The OLIGO program is designed specifically to search for and list the position, 
sequence, and other data of all oligonucleotides (or primer pairs) that optimally 
meet these major requirements, plus several other criteria outlined in this 
manual. 

1.3.  Hardware and Software Configurations 

1.3.1.  Requirements 
  Macintosh PC (Windows) 

 Computer Type Mac with Power PC 
(G3, G4, or G5) or 
Intel processors 

Pentium and up 

 Operating System System 10.3 or 
higher 

Windows 95 and 
higher 

 Disk space, RAM 20M, 128M 20M, 128M 

Table 1.3.1.  Hardware & Software Requirements. 

1.3.2.  Compatible Sequence Files 
Acceptable Nucleic Acid Sequence File Formats = Text (ASCII), EMBL, 
GenBank, Entrez Flat Files and files from most sequence analysis programs 
capable of generating plain text files. 

1.3.3.  Monochrome Monitors 
OLIGO is designed to work on a color monitor.  Throughout this manual, you may 
find references to particular on-screen colors used to identify information.  If you 
are working on a monochrome screen, you will not see clearly these color 
distinctions; however, the functions work the same. 
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1.4.  Files Present With the OLIGO Program 
Following is a list of the OLIGO files, stored by default in the OLIGO Folder. 

1.4.1.  Oligo 7 Software 
Oligo 7 interface is written in Java, and the search/analyze engine is written in 
native codes for PC/Windows and Macintosh OSX. 

1.4.2.  Supporting Files 
By default, all files for the OLIGO 7 are located in the OLIGO folder, installed in 
the Applications folder.  These files include: 
 
OLIGO 7 - Application Icon - the OLIGO application 
universal primers.odb - example of an oligonucleotide database file 
FreqSeq folder - collection of repetitive sequences 
Frequencies folder - tables containing oligonucleotide frequencies assembled 

from GenBank 
Tables folder - files containing restriction enzymes information and codon usage 

tables 
Test sequences – DNA and protein sample files 
 

1.4.3.  Frequencies Folder 
These files are in the Frequencies folder.  They are used to create the 
"Sequence Frequency" window, and in "Eliminate Frequent Oligos" sub-search 
for PCR primers.  The list of oligonucleotide frequency table files, generated from 
Gen Bank is given below.  You may create your own frequency file (see p. 96): 
 
GBBCTBAC.FR6 - Frequency of 6-mers from Bacillus subtilis  sequences. 
GBBCTESC.FR6 - Frequency of 6-mers from Escherichia coli  sequences. 
GBINVCAE.FR6 - Frequency of 6-mers from Caenorhabditis sp.  sequences. 
GBINVCAE.FR7 - Frequency of 7-mers from Caenorhabditis sp.  sequences. 
GBINVDRO.FR6 - Frequency of 6-mers from Drosophila  sp. sequences. 
GBMAMBOS.FR6 - Frequency of 6-mers from Bos  sp. (cow) sequences. 
GBMAMORY.FR6 - Freq. of 6-mers from Oryctolagus sp. (rabbit) sequences. 
GBPHG.FR6 - Frequency of 6-mers from bacteriophage sequences. 
GBPLNARA.FR6 - Frequency of 6-mers from Arabidopsis sp.  sequences. 
GBPLNCHL.FR6 - Frequency of 6-mers from chloroplasts sequences. 
GBPLNORY.FR6 - Frequency of 6-mers from Oryza sp. (oat) sequences. 
GBPLNSAC.FR6 - Freq. of 6-mers from Saccharomyces cerevisiae  sequences. 
GBPLNSAC.FR7 - Freq. of 7-mers from Saccharomyces cerevisiae  sequences. 
GBPLNZEA.FR6 - Frequency of 6-mers from Zea sp . (corn) sequences. 
GBPRI.FR6 - Frequency of 6-mers from Primate sequences. 
GBPRI.FR7 - Frequency of 7-mers from Primate sequences. 
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GBPRIHOM.FR6 - Frequency of 6-mers from Homo sapiens (human) 
sequences. 

GBPRIHOM.FR7 - Frequency of 7-mers from Homo sapiens (human) 
sequences. 

GBROD.FR6 - Frequency of 6-mers from Rodents sequences. 
GBROD.FR7 - Frequency of 7-mers from Rodents sequences. 
GBRODMUS.FR6 - Frequency of 6-mers from Mus sp. (mouse) sequences. 
GBRODRAT.FR6 - Frequency of 6-mers from Rattus sp.  sequences. 

1.4.4.  FreqSeq Folder 
These are organism-specific repetitive sequence files included in the OLIGO 
program.  They are used to check against potential primers. 
DROSFR.LST - A list of drosophila repetitive sequences 
DROSFR.SEQ - Drosophila repetitive sequences 
HUMANFR.LST - A list of human repetitive sequences 
HUMANFR.SEQ - Human repetitive sequences 
MOUSEFR.LST - A list of mouse repetitive sequences 
MOUSEFR.SEQ - Mouse repetitive sequences 
RATFR.LST - A list of rat repetitive sequences 
RATFR.SEQ - Rat repetitive sequences 
WHEATFR.LST - A list of wheat repetitive sequences 
WHEATFR.SEQ - Wheat repetitive sequences 
YEASTFR.LST - A list of yeast repetitive sequences 
YEASTFR.SEQ - Yeast repetitive sequences 

1.4.5.  Tables Folder 
The Tables Folder includes the following files:  
4.ENZ - A restriction enzyme site database, of sites containing least 4 -cutters 
5&UP.ENZ - A restriction enzyme site database, of sites containing at least five 

non-degenerate cutters 
7&UP.ENZ - A restriction enzyme site database, of sites containing at least 7 -

cutters 
Codon Usage Tables - A codon usage table, an editable text file 
NICE6&UP.ENZ - A restriction enzyme site database, of six-base and greater 

non-degenerate cutters 
rebase.enz – comprehensive restriction enzyme database from NEB 
transcription factors.txt – a file that may replace *.enz files to search for 

transcription factor recognition sites while using the search for restriction 
enzymes option 

type II commercial.enz – available on the market restriction enzymes; another file 
containing enzyme recognition sites 

1.4.6.  Test Sequences Folder 
BRCA2 gene.seq – one of the human breast cancer genes, ACCESSION 

AY436640, an 85469 nt.-long sequence with several annotated features 
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[organism name] eIF-4E.seq – collection of protein synthesis factor 4E 
sequences for testing consensus primers searches; 14 files 

Human eIF-4E.ami – protein sequence sample file 
M13MP18.seq – bacteriophage sequence sample file 

1.4.7.  Files Present Outside the Oligo Folder 
In the personal folder Oligo sets up Oligo Settings folder containing: 
• Parameters, a file containing recently used search parameters, 
• Preferences, a file containing user settings, accessible through the Preferences 

menu, 
• RecentFiles, a file containing recent files opened with Oligo 
• Windows, a file containing information on the window sizes and positions, 
• FileSets Folder containing file sets used for certain types of searches (unique, 

consensus and batch). 
There may be other "Oligo7.*" files present on your computer, but they are not 

created by Oligo, only by the operating system itself. 

1.5.  New Features and Enhancements 
Oligo 7 has been re-written from scratch, to make it fully compatible with ever-
changing operating systems.  Most of the source code is written in Java, and 
processor-intensive sections were written for specific hardware to maximize 
speed of calculations.  Compared to the version 6, OLIGO 7 has several 
changes.  The major enhancements are listed below. 

1.5.1.  New interface. 
Starting up the program shows only one but more informative window.  The Tm 
graph shows the entire sequence.  Position of up to 4 (previously 2) oligos is 
graphically displayed.  This window also displays primers Tm, PCR product, 
strong loops in DNA (RNA) template, potential loops in oligos, palindromes, 
features read from annotations, and other data. 

1.5.2.  New thermodynamic parameters 
Oligo 7 implements unified nearest-neighbor thermodynamics assembled by 
John SantaLucia (1, 2). Values for single mismatches and dangling ends are 
incorporated. This complicates expression of the melting temperature values: 
Oligo reports standard melting temperatures (without mismatches & dangling 
ends) as tm and with mismatches and dangling ends as Tm. 

1.5.3.  More primer/probe options. 
Introduced the ability to select 4 oligos for analysis. Oligo 6 only handled 2.  This 
was done to enable searches for TaqMan Probes and nested primer sets. Oligo 
also can search automatically for molecular beacons and siRNA.  A series of 
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user-editable design constraints have been added, so you may search for oligos 
with certain bases or sequences built in. 

1.5.4.  New search criteria and the entire search algorithm. 
Oligo 7 is no longer constraint to a fixed length of a probe/primer during a single 
search.  You may now select a range of lengths for your primers.  The number of 
sub-searches was increased, so you may restrict not only 3’-stability but also 5’-
end stability to aid in siRNA selection.  In addition, a search for strong hairpin 
loops in the template was added.  This does not include primer design by itself 
but with this search you may avoid hard to amplify regions.  The sequence 
constraints option lets you find primers with certain bases at the 3’ and 5’-ends.  
There is also an option to restrict the number of guanosines in your primers that 
greatly enhances possibility of multiplexing. 

1.5.5.  The quality of oligos and pairs are scored in a single number 
Many Oligo users requested this option because it is trivial to find the best primer 
that way.  Unfortunately, different applications require different approach and 
emphasis on different parameters or features of a primer/probe.  This led to a 
fairly complex and user-customizable scoring system.  In most cases, however, it 
is not essential to modify the definitions. 

1.5.6.  Enhancements to the search for primers & probes protocol 
The primer and probe search protocol allows the user to "lock" every parameters 
such as, Tm range or 3' stability ⊗G settings, so that the automatically change 
stringency setting, which incrementally relaxes each parameter, is more 
controlled during a search.  In addition, the user can choose to balance PCR 
Primers according to the priming efficiency number rather than Tm which has 
been shown to provide better amplification results.  The priming efficiency 
algorithm has been slightly modified. 

1.5.7.  Automatic OLIGO updating 
In the Help Menu, the item “Check for Update” has been added.  This enables 
automatic installation of new versions from the MBI’s server.  In all previous 
versions this was a manual cumbersome process. 

1.5.8.  Open reading frame 
This new analysis window provides information on all ORF, and gives basic 
information on translated proteins, including molecular weight and pKa. 

1.5.9.  Homology analysis 
Besides the false priming sites check you may also view homologous sites. 
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1.5.10.  Batch processing 
Now searches for primers and probes can be performed on large number of 
sequence files at a time. Results of this type of search is automatically stored in a 
results text file. 

1.5.11.  Database functionality 
Has been greatly improved. The main change is a possibility of fully automatic 
multiplexing. Besides single oligos storage the Database can store also primer 
sets. You may also check oligos for dimerization directly from the Database 
menu. 

1.5.12.  Improved features 
All previously existing windows have been re-designed.  They have more 
pleasing graphics and usually show more information than in Oligo 6.  Some 
windows have greater functionality.  For example, you may read consensus 
sequences from the list of primers (Analyze-Selected Oligonucleotides window) 
or read the info on four, instead of two, primers from the PCR window.  

1.5.13.  Dropped features 
PrimeForm option that was designed in Oligo 6 to help making primer orders to 
commercial facilities has been abandoned due to lack of customer’s interest. 

1.5.14.  Change to the Manual 
Oligo Tutorial has been removed from the main text of the Manual and it is a 
separate document.  It is an open source of protocols.  You are invited to send us 
new protocols or instructions not yet covered in the Tutorial by e-mail to 
mbisupport@oligo.net.  New protocols would be incorporated in the text of the 
tutorial with proper acknowledgements. 
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2.  Getting Started 

This section covers the basics on getting started with OLIGO. 

2.1.  Basic System Elements & Symbols 
The OLIGO program presumes you are familiar with the basic functions of 
Macintosh OS or Windows interface.  If you are unfamiliar with it, please refer to 
your System manual.  If you need a brief refresher of System elements, review 
this section. 

2.1.1.  Mouse Pointer/Cursor 
In OLIGO, the mouse pointer or cursor is either a cross-hair, a vertical bar, or an 
arrow. 
When you are on the main menu bar, the hand becomes a pointer, or arrow.  
Position this arrow/marker directly on the object you want to select or activate. 

2.1.2.  Close Box 
The close box is located in the upper-left corner (Mac, ) or upper-right corner 
(Win, ) of most OLIGO windows, next to the title bar.  When you click on this 
box, you close the window. 

2.1.3.  Title Bar 
The title bar displays the name of the window.  The non-active window title bar is 
dimmed.  You can choose different types of window arrangements from the 
Window menu.  You can move most windows by clicking on and dragging the 
title bar. 

2.1.4.  Menu Bar 
The menu bar is located at the top of the screen.  It lists the functions available in 
the application.  To access a function, click and drag down with the mouse to 
select a particular suboption or click once quickly, so that the menu will remain 
open when you move the cursor. 

2.1.5.  Scroll Bars 
The scroll bars are the long gray or blue strips along the bottom (horizontal scroll 
bar) and/or side (vertical scroll bar) of a window.  They contain both scroll arrows 
and a scroll box.  Only some windows contain them. 
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You can move through a window or document by clicking and dragging the scroll 
box along the bar, clicking directly on the bar, or clicking on the arrows at either 
end of the bar. 

2.1.6.  Zoom / Minimize Box 
This is the button in the upper-right corner of most of the windows.  Click on the 

green button  (Mac) or icon  (PC) to change the window size or click 

 or   to minimize.   

2.1.7.  Size Box 
To resize a window, point to the right bottom window corner (Mac) or any window 
corner (Win) and drag the cursor.  You can resize the window horizontally and 
vertically. 

2.2.  Installing the OLIGO Software 

2.2.1.  Installation form the Internet 
Download the zipped Oligo package, Oligo7Mac_Installer.zip (Macintosh), or 
Oligo7Win_Installer.zip (Windows) to your hard drive.  Some systems unpack the 
files automatically, and some require manual unzipping.  Double click on the zip 
file to unpack the contents.   
Double click on the Oligo7Mac_Setup installer package (Mac; sometimes you 
see the ".pkg" at the end of the name), or on the Oligo7Win_Setup (PC; 
sometimes you see the ".exe" at the end of the name) to start the installation 
process, and follow the on-screen instructions.  In Macintosh, Oligo is installed in 
Oligo sub-folder in the Applications folder.  In PC, the default folder is C:\Program 
Files\Oligo 7.  Start Oligo 7, fill out the registration form and register it, as 
described in Chapter 2.3. 

2.2.2.  Installing OLIGO from a Compact Disk 
To load the OLIGO program to your hard drive: 
1. Insert the OLIGO 7 Disk into computer's CD drive. 
2.  Mac: double click on Oligo7Mac_Setup.pkg installer package, and follow the 

instructions displayed on screen.   
  PC: Double click on the Oligo7Win_Setup.exe icon displayed in the CD drive 
window.  Follow the on screen instructions.  You would be asked for the folder 
name and location of the Oligo 7 application. 

3.  Once the installation is complete, double click on the Oligo 7 icon to start it 
and register your program license.  Alternatively you can start Oligo by 
choosing "Start" from the desktop, followed by "Programs".  Please follow the 
instructions given in Chapter 2.3, below.   
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2.2.3.  Troubleshooting the Installation 
If installation fails, check to see if one of the following conditions is apply. 

Computer Configuration 
Make sure your system meets the requirements listed in Section 1.4 - Hardware 
and Software Configurations.  If not, you may need to upgrade your system to run 
the OLIGO program. 

Virus Detection Software 
Sometimes virus detection software can interfere with installation programs.  If 
you have virus detection software that affects the installation, temporarily remove 
or disable it and try installing the OLIGO program again.  Refer to the manual for 
your particular software package for more information on this. 

Disk Compression Software 
If you are using disk compression software and have a small amount of available 
disk space, it could interfere with installation.  Try to make more space available 
on your hard drive or disable the compression software before attempting to 
reinstall the OLIGO program. 

Installer Doesn’t Work 
Oligo software can be installed only if you have administrator privilages to install 
new software.  If you cannot save files to the Program Files or Applications 
Folder you need to log out and log-in with the account that has administrator 
privileages or ask your IT manager to install Oligo for you. 

2.3.  Registering OLIGO 
In order to protect your copy of the OLIGO program and provide you with prompt 
technical support, we need you to register as an OLIGO user with your distributor 
prior to accessing OLIGO or seeking technical support.   
The registration form takes a few minutes to complete and you should receive 
your access code within an hour after contacting your distributor during normal 
business hours. 
Because each installation creates a unique workstation code, you will need to 
register each computer separately.   

2.3.1.  The License Registration 
To register your OLIGO software on each computer, follow these steps: 
1. Double-click on the OLIGO icon to call up the registration procedures. 
2. Once the "Customer Registration" window appears, complete each field.  Use 

either the mouse or <Tab> to move to each field.  This window must be 
completed for each workstation you are registering (See Figure 2.3.1.1.)  
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Your e-mail address must be entered to make the “Register” button active.  
The Fax number should be entered to get the “Print” button active (if you have 
no access to the Internet).  Leave the Access Code field blank. 

 
Figure 2.3.1.1.  The OLIGO Customer Registration window. 

Note:  Your software license number is on the OLIGO CD, User Manual or/and in 
the e-mail conformation of the purchase. 

3. When you enter the license number the “Register” button should become 
active.  If you’re connected to the Internet, click the “Register” button.  The 
registration e-mail is sent to MBI automatically, and upon its completion the 
window should display the message “Registration form successfully sent”.  If 
you perform the registration during the MBI's normal operation hours (Monday 
through Friday, 8 a.m. to 4 p.m. Mountain Time), expct the returning Access 
Code within an hour.  Otherwise, you may Exit the Oligo and start it again at 
later time, when you’d receive the Access Code.  Click the “OK” button to exit. 

3a.  If you’re not connected to the Internet, or your network does not permit e-
mails directly from Oligo, please print out the Registration Form by clicking 
the Print button, and fax it to MBI dialing +1 719 684 7989, or press the Save 
button, the saved file attach to your e-mail, and send it to us. 

4. When you receive the Access Code from MBI, go back to the registration 
window by bringing it to the front or by re-starting Oligo, enter it to the “Access 
Code” box, and click the “Confirm Code” button.  The registration process is 
complete. 
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To register your second and following computers, you need to complete the 
same registration process each time. 
 
Note: If you ever need to re-load OLIGO, write this message to the Comments 

field. 

2.3.2.  Multi-user and Network License Registration 
Each OLIGO owner under a multi-user license or IT manager under a network 
license must register by following the instructions described in chapter 2.3.1. 

2.4.  The OLIGO Main Menu 
 

At first, the main menu of OLIGO displays only the menu bar at the top of the 
screen until you load a sequence file or enter one using the File - New command.  
Once you load or enter a file, the OLIGO Sequence screen appears. 
To call up menu items on any of OLIGO's screens, pull down the menu using the 
mouse.  You may also use the shortcut keys.  The shortcut keys are displayed to 
the right of the command it represents in the menu. 
As you use the OLIGO program, there are some features that are available at a 
given time and others that are not.  OLIGO uses the standard System convention 
of "graying out" items that cannot be accessed on that particular screen or at that 
particular time.  For information on when a menu item or option is available, refer 
to the individual item descriptions in this manual. 

2.4.1.  Main Menu - Oligo 
The Application Name menu (Oligo7), located between the Apple and File 
menus, displayed only in the Mac, contains the following items: About Oligo, 
Preferences, Services, Hide Oligo, Hide Others, Show All, and Quit Oligo. Most 
of these items are identical in other applications. 

2.4.2.  Main Menu - File 
The File menu includes options that relate to opening existing sequence files, 
creating new sequence files, working with oligonucleotide databases, saving 
data, printing, and exiting.  In most cases, you will need to have a file open to 
perform functions listed under this and other menus. 

2.4.3.  Main Menu - Edit 
You must have a sequence file loaded to use the Edit menu options.  In most 
cases, OLIGO will prompt you to save your changes after editing.   
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2.4.4.  Main Menu - Analyze 
The Analyze menu contains the program options you select to analyze a single 
oligonucleotide, oligo groups, oligo lists, PCR, and other information pertaining to 
specific oligonucleotides and their uses. 

2.4.5.  Main Menu - Search 
The Search menu provides multi-functional automated searches for primers and 
probes, palindromes, subsequences, restriction sites and more. 

2.4.6.  Main Menu - Select 
On the Select menu you may select primers and probes as well as the Current 
Oligo position on the active sequence.  All these could be also done by mouse 
clicking in the Sequence window. 

2.4.7.  Main Menu - Change 
The Change menu allows you to change oligo length, a DNA active sequence to 
an RNA active sequence (or RNA to DNA), search ranges and parameters, 
reading frame in the Sequence window, reverse translation method and the 
codon table. 

2.4.8.  Main Menu - View 
The View menu lets you control Toolbar and Status Bar display in the Windows 
version. 

2.4.9.  Main Menu - Window 
The Window menu in Windows version lets you arrange the windows and bring to 
front any opened window.   

2.4.10.  Main Menu - Help 
This provides access to Help Topics and check our server for the OLIGO 
updates. 

2.5.  The OLIGO Default Window 
When a sequence file is opened, Oligo displays only one window by default, 
called the “Sequence”. You may choose to open more windows from the 
Preferences menu. 



 

 22 

 
Figure 2.5.  The OLIGO Sequence window. 

This window is the core window of the OLIGO program.  It includes the elements, 
functions, and capabilities described below. 

2.5.1.  Information Boxes 
At the top there are three information boxes. The one on the left shows the 
sequence length, in nucleotide number, current reading frame (translated protein 
is on the bottom part of this window – more reading frames are displayed in the 
Open Reading Frames window), Current Oligo length, for which you see the Tm 
graph below, and its 5’-end position number along with its Tm in standard 
conditions (100nM DNA in 1M salt).  In the lower left corner of this box there is a 
small info icon, , and clicking on it will open Analyze-Key Info- Current Oligo 
window, containing basic information about the shaded sequence fragment. 
The central box displays information on four selected oligos: Forward/Reverse 
Primers, and Upper/Lower Oligos, as well as the length of a PCR product when 
the Primers are selected.   

 



 23 

Figure 2.5.1.  The OLIGO Sequence window: the Central Box after the search for TaqMan probes 
and selecting a triplet. Lower Oligo is the probe in this example. 

This box has also info and a square icons ( ).  By clicking on the square 
icon you are selecting corresponding Primer/Probe.  After the selection, the icons 
change their appearance ( ) and you may also invoke the corresponding 
Key Info windows the same way as for the Current Oligo.  Clicking the non-
dimmed info icon in the PCR Product row will open the Analyze-PCR window. 
The box on the right displays all features (annotations) of the sequence. 

  
Figure 2.5.2.  The OLIGO Sequence window: the Features Box 

To browse the list use the vertical scroll bars, if necessary.  By clicking at any 
feature, the graphical representation (light blue bar) of this particular feature is 
highlighted and displayed in the Sequence window in two locations: zoomed out 
(center) and zoomed in (at the bottom of the window). Feature in bold letters is a 
selected feature from the Edit-Feature menu that is functional in Search Ranges 
(you may search for primers only in this feature, if you like). 
Note: if you select a feature Oligo will be able to save the sequence with this 

feature selected. 

2.5.2.  The Zoom-out Area 
Graphical representation of the sequence is displayed below the information 
boxes in two areas.  The top one is the zoom-out area, that shows the graph 
representing melting temperatures of all the oligos (of the Current Oligo length) in 
the entire sequence file, graphical representation of the positions of selected 
oligos, strong hairpin loops in the template, (weak) hairpin loops in all oligos of 
the Current Oligo length, palindromes, results of search for a string, and a 
selected feature as depicted on Fig. 2.5.2. The Tm graph area shaded in yellow 
is the zoom-in area, displayed at the bottom part of the Sequence window. 
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Figure 2.5.2.  The OLIGO Sequence window: zoom-out area. 

Each blue, one pixel wide, vertical block of the Tm graph represents the Tm of an 
oligonucleotide, or an average of several oligos if the screen has less pixels than 
the number of bases in the sequence.  The Tm is calculated for an oligonucleotide 
length that is set in the Current Oligo Length command from the Change menu - 
the default is a 21-mer.  

2.5.3.  The Zoom-in Area 
The zoom-in area is located at the bottom of the window and starts from the 
boxes showing the cursor position and corresponding tm of an oligonucleotide at 
that position.   
Note: Not always the tm is displayed (tm being a standard or ”raw” melting 

temperature calculation – without consideration for dangling ends) in this 
window.  The display type is the same as in the Melting Temperature Graph 
window. All 8 different values may be displayed there, including actual Tm 
(with dangling ends and mismatches), ⊗G, degeneracy etc. 

 Figure 2.5.3.  The OLIGO Sequence window: zoom-in area. 

From the scale bar down is the zoom-in area. Below the scale bar are the rows 
for Forward Primer, Upper Oligo, original sequence as saved in the file, its 
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complement, Lower Oligo and the Reverse Primer.  Below these there is the 
protein sequence translated from the DNA/RNA active sequence in the selected 
reading frame (set in Change - Reading Frame, Tm window sub-menu or from 
the ORF window), followed by the sequence secondary structure and features in 
the same order as in the zoomed-out area, as shown on the figure 2.5.3. 
Sequences of the selected oligos are normally displayed in upper case letters, 
and in lower case when they mismatch the active sequence.  

2.5.4.  Keyboard Support 
Besides changing positions with the mouse, the following keys on your keyboard 
are active in the Sequence window: 
• Right Arrow move the Current Oligo one position forward 
• Left Arrow  move the Current Oligo one position backward 
• Up Arrow  move the Current Oligo 3 positions forward 
• Down Arrow move the Current Oligo 3 positions backward 
• Page Up  move the Current Oligo one screen forward 
• Page Down move the Current Oligo one screen backward 
• Space Bar center the Current Oligo on the window 
The menu short cut keys, described below, are also available. 
 

2.6.  OLIGO Short Cut Keys 
You can use OLIGO keyboard interface.  Here is a listing of available accelerator 
keys in the OLIGO program and where these keys may be used. 
 

2.6.1.  File Menu 
The following keys are available from the File menu: 
 Command PC-Windows Macintosh 
 New Sequence 

New Database! 
Open! 
Close!(document) 
Close!Window 
Print! 
Quit (Oligo)! 
Save - Data  
Save - Sequence 

Ctrl-N 
Ctrl-!-N 
Ctrl-O 
Ctrl-!-W 
Ctrl-W 
Ctrl-P 
Ctrl-Q 
Ctrl-!-S! 
Ctrl-S 

"-N! 
"-!-N! 
"-O! 
"-!-W! 
"-W 
"-P! 
"-Q! 
"-!-S! 
"-S 

 
 
! = Shift 
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2.6.2.  Select Menu 
The following keys are available from the Select menu: 
 Command PC-Windows Macintosh 
 Forward Primer! 

Reverse Primer! 
Upper Oligo! 
Lower Oligo! 
New Current Oligo Position 

Ctrl-U 
Ctrl-L 
Ctrl-!-U 
Ctrl-!-L! 
Ctrl-K 

"-U! 
"-L! 
"-!-U! 
"-!-L! 
"-K 

 

2.6.3.  Change Menu 
The following key is available from the Change menu: 
 Command PC-Windows Macintosh 
 Current Oligo Length Ctrl-D "-D 

 

2.6.4.  Edit Submenu - Database 
The following keys are available: 
 Command PC-Windows Macintosh 
 Cut! 

Copy! 
Paste! 
Undo! 
Select All 

Ctrl-X! 
Ctrl-C! 
Ctrl-V! 
Ctrl-Z! 
Ctrl-A 

"-X! 
"-C! 
"-V! 
"-Z! 
"-A 

 

2.6.5.  Edit Submenu - Edit 
The following keys are available only from the Edit windows: 
 Command PC-Windows Macintosh 
 Cut! 

Copy! 
Paste! 
Undo! 
Select All! 
Accept! 
Accept & Close 

Ctrl-X 
Ctrl-C 
Ctrl-V 
Ctrl-Z 
Ctrl-A 
<Enter> 
<!-Enter> 

"-X 
"-C 
"-V 
"-Z 
"-A 
<return> 
<enter> 

 

2.6.6.  Edit Submenu - Search 
The following keys are available only from the Edit windows: 
 Command PC-Windows Macintosh 
 Find! 

Find Next 
Ctrl-F 
Ctrl-G 

"-F! 
"-G 
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2.7.  Help 
MBI provides live help line during standard hours of operation, Monday through 
Friday between 8 a.m. and 4 p.m. Mountain Time (UTC-7).  If you send Oligo 
registration within this time, expect receiving back your access code within one to 
two hours, sometimes less and occasionally more.  Most issues can be resolved 
by e-mail to mbisupport@oligo.net. 
Oligo provides Help menu, containing mostly the text of this Manual.  If your 
computer is connected to the Internet, you may use this menu to check for the 
free Oligo updates. 
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3.  The OLIGO File Menu 

The File menu is used to: 
• Create new sequence files and databases 
• Open DNA, RNA, protein sequence and database files 
• Import saved search results to the opened sequence 
• Save and print 
• Reset data and parameters 
• Open recently closed sequence/database files 
• Check for and download newer OLIGO versions from the web 
Note  You must open an existing file or create a new file before you can access 

most of the options from the Edit, Search, Select, and Analyze menus on the 
main menu bar. 

 
Figure 3.0.  The OLIGO File menu. 

3.1.  File - New Sequence 
The File - New Sequence command opens the "New Sequence" window and 
activates the text editor for keyboard entry.  Once a new active sequence is 
entered, you may accept it by choosing Accept & Close from the Accept/Discard 
menu, and this way making it available to all other OLIGO functions.  In the "New 
Sequence" Window, most of the options in the Edit menu are available.  These 
options are explained in Chapter 4 - The OLIGO Edit Menu. 
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3.2.  File - New Database 
The File - New Database window allows you to create and save new databases 
for storing oligonucleotide data.  It is also a powerful analysis and multiplex 
search tool. 
There are various format database files now compatible with OLIGO.  It could be 
a list of primer sequences, each in a new line (no descriptions), it could be the 
FASTA format (23) or its modification, as used by the AutoDimer, an on line 
software from National Institute of Standards and Technology (24).  All previous 
versions of OLIGO databases are compatible with OLIGO 7. 

3.2.1.  (New) Database - Menu Items 

 
Figure 3.2.1.  The File menu with active Oligonucleotide Database window. 

When the Database window is active the main File menu is essentially the same 
as the standard File menu, but some options are different.  The Close function 
closes only the currently active database.  The Save function has less options, 
and Revert to Previous Database brings back the database previously saved, so 
that the all edit operations made after the save are removed.  The OLIGO 
Database functions and menus are described in Chapter 10. 

3.3.  File - Open 
The File - Open command selects, by default, a nucleic acid sequence file from 
disk.  By default, all types of files are displayed in the "File Open" dialog box, 
however, you may view only single type files by selecting the type from "File 
Format" pull-down menu.  Besides Nucleic Acid sequence files you may display 
protein sequence files or Oligonucleotide Databases.  OLIGO opens different 
types of files, itemized above and in the Fig. 3.3, so if you are not familiar with 
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OLIGO file names and their extensions the File Format option will help you not 
make a mistake when opening an intended file. 

 
Figure 3.3.  The File - Open dialog box with All Files set to open.  

3.3.1.  File - Open - Nucleic Acid 
This option selects DNA or RNA sequence files from your computer disk.  
Sequence files that have acceptable file formats may originate from several 
sources including GenBank, EMBL, and other database files.  Text files 
generated and saved without formatting in a word processing program, files 
generated from most DNA sequence analysis programs and sequence files 
created in OLIGO, are also acceptable files. 
Note:  Sequence files from other software applications that do not open using this 

function may not be text files or may contain incompatible characters.  
Sequences interrupted with periods, semicolons, greater than and less than 
symbols, or some hidden word processing characters cannot be loaded.   

Here’s how to deal with a file that will not open and you suspect has incompatible 
characters: 
1. Remove the characters using any standard word processing package and 

save the file as plain text, preferably with a different file name, so you can go 
back to the original. 

2. Open your sequence file by the software that created it, and check its save 
options.  Choose the plain text format (could be the GenBank format). 

Choose any of the nucleic acid sequence files in the "File Open" dialog box by 
double clicking on the sequence file name, or by highlighting it with a single click 
and then clicking the "Open" button.  The name of the selected sequence file is 
displayed in the top left corner of every window. 
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If the sequence is long (default is 250k bp) Oligo would try to open only a portion 
of it. You may change this default size as described on p. 40 (chapter 3.13.2). 

3.3.2.  File - Open - Protein 
Protein sequences of various text formats can be opened using this option.  The 
sequence is automatically reverse-translated into DNA (it is important that the 
rev. translation method you wish to use is chosen using the Change-Rev. 
Translate Method before the protein sequence is loaded).  Once the protein 
sequence is translated into DNA, OLIGO functions are the same as with any 
native nucleic acid sequence file.  Default Oligo extension for protein files is .ami. 

3.3.3.  File - Open - Oligonucleotide Database 
You may store, import, export, edit, analyze, and manage oligonucleotides 
generated by OLIGO in one or more user-created oligonucleotide databases.  
The File - Open - Database command opens a previously saved database file.  
The "Oligonucleotide Database" window permits you to download, analyze and 
save oligos and records associated with them.  All functions of the database are 
described in detail in File- New Database chapter.  This command opens OLIGO 
database as a separate document, and not as a sequence-related document. 
OLIGO accepts various text format databases.  The formats are shown in the 
four figures below: 
 

 
Figure 3.3.3.1.  OLIGO 6 database format.  Nonprintable characters are shown as arrows (tabs) 
and dots (spaces). 

 
Figure 3.3.3.2.  The plain format file.  Each oligo sequence is in one line. 

 
Figure 3.3.3.3.  AutoDimer (software) format file.  Each entry takes two lines.  The top one is the 
description and the second is the primer sequence. 
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Figure 3.3.3.4.  OLIGO 7 database format.  Nonprintable characters are shown as arrows (tabs), 

dots (spaces) and  symbols (new line). 

3.3.4.  File - Open – OLIGO Search Result 
This command opens previously saved by OLIGO Search Results (to save use 
File – Save – OLIGO Search Result…)  Positions of the saved primers and 
probes can be displayed in two Analyze windows: Selected Oligonucleotides and 
Primer Pairs/Probes. 

3.3.5.  File - Open – Saved Work File 
This command opens Oligo with the same contents as the Saved Work file was 
saved in the past. You would need to close all the sequence and database files 
currently opened in order to proceed with this option. 

3.3.6.  File - Open – All Files 
This command makes all the files available for opening.  It’s up to you to specify 
the kind of a file that is to be opened, that is, a nucleic acid (.seq, but could be 
.txt), protein (.ami), database (.odb, but could be .txt), search results (.sre) or 
saved work file (.wrk). 

3.4.  File - Open Recent 
The File - Open Recent command gives access to the recently opened files in 
OLIGO.   

3.5.  File - Close and File – Close Window 
The File - Close [file name] command closes all windows associated with one 
document, currently analyzed sequence or a database. The File – Close Window 
closes only a single, top window. 

3.6.  File - Save 
The File - Save commands save a variety of data to disk.  When the active 
document is a sequence, you may save the items displayed on the left of Fig. 
3.6.1, and when the active document is the OLIGO database, you may save 
what’s shown on the right. 
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Figure 3.6.1  The File - Save options. 

3.6.1.  File - Save - Data 
The Save-Data command can save data from any or all analysis windows of the 
currently opened document.  The File - Print/Save Options command calls up a 
dialog box where you can specify what window information is saved.  Each 
subsequent window saved is appended to an open data text file.  After saving, 
you can open this file and edit or print its contents with any word processor, but 
not with OLIGO.  To save window graphics, copy the window contents to the 
Clipboard by pressing <Alt-Print Screen> (PC) or "!4 key (Mac).  Than save 
the Clipboard picture into a document opened with graphics-compatible 
application. 

3.6.2.  File - Save - Data As… 
The Save-Data As command saves any open window or set of windows to a file 
with a new name that you are prompted to enter.  The saving contents is exactly 
the same as if using the Save- Data command. 

3.6.3.  File - Save - Sequence  
The Save-Sequence command saves the active nucleic acid sequence to your 
computer disk.  You may use this function whenever you enter a new sequence 
via the File-New command or when you alter a sequence using the Edit function.  
The file is of a simple text format, and besides the sequence it contains also the 
features list. 

3.6.4.  File - Save - Sequence As… 
The Save-Sequence As command saves the active sequence under a new 
name.  Using this command, you may modify a sequence and save it without 
altering the original file. 
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3.6.5   File - Save - Primer (Oligo)…  
The Save-Forward Primer, Save-Reverse Primer, Save-Upper Oligo and Save-
Lower Oligo commands save simple text files to your computer disk containing 
only the base symbols of the selected primer or oligo (usually a probe) of the 
active sequence.  If you intend to use the primer sequences for other purposes 
than direct transfer to a DNA synthesizer, it is more convenient to save the 
primers to an OLIGO oligonucleotide database. 

3.6.6.  File - Save - Search Results…  
The Save-Search Results command saves the most recent results of search in a 
file to your computer disk.  It saves the contents of two windows: Selected 
Oligonucleotides and Primer Pairs/Probes in a special format files, recognizable 
by OLIGO, so you may restore contents of these windows at later time. 
 

3.6.7.  File - Save - Database  
This option is visible only when the Database window is active.  The Save-
Database command saves the current database to an open oligonucleotide 
database file.  This option is displayed instead of Save-Sequence when any 
database window is activated. 

3.6.8.  File - Save – Work…  
You may save position of all the windows, search results and all the current state 
of Oligo memory into a “Work.wrk” file.  In order to open automatically this type of 
a file at the Oligo start-up you need to change the Preferences 4-th tab data (see 
page 42). 

3.6.9.  File - Save - Database As 
This option is visible only when the Database window is active.  The Save-
Database As command saves the current database to a new database file, under 
a new file name you enter.  This option is displayed instead of Save-Sequence 
As when any database window is activated. 

3.7.  File - Revert to Previous Sequence (Database) 
The File -Revert to Previous Sequence/Database command changes the active 
sequence with its annotations or the database (whichever window is active) back 
to their unaltered state, previously saved on your computer disk.  This operation 
cannot be undone, so if you’ve done meaningful changes to those files, better 
save them (using Sequence as… or Database as…) under a different name. 



 37 

3.8.  File - Print… 
The File - Print command generates a printout of an open window or group of 
windows as specified in the Print/Save Options dialog box. 
To print window graphics, copy the window contents to the Clipboard by pressing 
<Alt-Print Screen> (PC) or "!4 key (Mac).  Than print the Clipboard picture 
directly or paste the Clipboard contents into a document opened with another 
application and print from it. 

3.9.  File - Print Preview 
The File - Print Preview command displays the contents of the actual print-out.  
Use this option when you’re not sure what is going to be printed. 

3.10.  File - Print Setup 
The File - Print Setup command calls up the Page Setup dialog box where you 
can change printer and paper size.  Using this dialog box, you can also select the 
paper orientation and the print scale (size). 

3.11.  File - Print/Save Options 
This option allows customization of what is going to be printed or saved with the 
Print and Save Data (and Data as…) commands.  For printing any window 
contents you don’t need to have these analysis windows open.  Only check the 
appropriate boxes in this dialog window and this will select the contents to be 
printed or saved.  

 
Figure 3.11.1.  The Print/Save Options window Analyze 1. 

Default setting is to print or save only the Current Oligo window, the most 
recently used. When Print/Save option is set to “Selected” you would get a print-
out of all selected in the Analyze and Search Data windows. In the example 
above, only the Key Info window contents would be printed, along with what’s not 
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shown but checked in the other three Print/Save options windows. Note that 
there are letters C,F,R,U,L,M 
on the top ot the window (see 
Fig. 3.11.1). These refer to 
windows describing Current 
Oligo, Forward and Reverse 
Primers, Upper and Lower 
Oligo and Mixed oligos, 
respectively, explained also at 
the window’s bottom. The 
Analyze 2 window gives control 
to the other windows printing, 
see Fig. 3.11.2. 

Figure 3.11.2 - The Print/Save Options window Analyze 2. 

The Search Data Print/Save 
window allows to save specific 
information from various Search 
windows (Fig. 3.11.3). 
 
Figure 3.11.3 - The Print/Save Options 
window Search Data. 

Printing format of the Databases 
can be controlled with the fourth 
Print/Save Options window, 
shown on the following Figure. 
 
Figure 3.11.4 - The Print/Save 
Options of the Database. 

You may save various sets of 
the Database –the oligo 
sequences, oligo sets, and 
multiplexed oligos. Besides, the 
individual entries or sets can be 
saved as plain listings or in Full 
Analysis format. 
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3.12.  File - Reset 
There are two levels of reset in the OLIGO program. 

3.12.1.  Reset - Data 
The Data command resets all user-generated results, calculations, and 
accumulated data generated since opening the active sequence.  This erases all 
search data, closes relevant windows, erases any selected primers, and resets 
the temperature for ⊗G calculations to 25°.  It does not, however, change search 
parameters and other program parameters, except the search ranges. 

3.12.2.  Reset - Original Defaults 
The Original Defaults command changes all search and non-search parameters 
back to the original program defaults.  It does not reset data or close windows. 

3.13.  File – Exit and the Application Menu 
The File - Quit OLIGO (Mac) or File - Exit (Win) command quits the OLIGO 
program.   
In the Mac OS X interface, the Quit Oligo item is in the "Application" menu. 

 
Figure 3.13.0.  The Application Menu in Mac OS X. 

In Mac OS X a new menu is added by the operating system, that is called the 
Application menu.  It contains items that existed in other menus of OS 9 and 
earlier.  About Oligo has been moved from the Apple menu, Preferences from the 
Change menu, Services (new system-added item, not functional in Oligo), 
interface options: Hide Oligo, Hide Others, and Show All, and the last item - Quit 
Oligo7. 
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3.13.1.  Application Menu - About Oligo 
This window displays credits, MBI address and phone number, and most 
importantly, the Oligo version number. 

 

3.13.2.  Application Menu - Preferences 
When OLIGO is started up for the first time, the "OLIGO Settings" folder is 
created in your computer’s personal folder.  This file contains several OLIGO 
parameters.  When OLIGO is started again, the OLIGO Settings are checked 
before the windows appear.  In Windows systems, Preferences are in the Edit 
menu. 

This Parameters section allows you to 
apply the search parameters settings to 
either the active sequence file or to all 
open sequence files.  The Windows 
version has additional button allowing 
changing to the pdf file viewer 
application (Mac OSX takes care of this 
feature, so this button is not needed).  
When the sequence file is large, Oligo 
may be loading it for a long time.  
Therefore, by default, Oligo loads into 
computer memory only up to 250,000 
nucleotides.  This value can be changed 
within the "Parameters" tab of the 
Preferences window, as shown below. 

 Figure 3.13.2.1.  The Preferences dialog, Parameters tab, Windows version. 

If the sequence file is longer than this number Oligo opens a dialog window 
before loading the sequence and asks to choose the relevant fragment for 
analysis as depicted on Fig. 3.13.2.2.  This window shows the sequence 
features, so you can easier decide on your fragment choice.  Enter the sequence 
positions to be loaded to Oligo, and do not exceed the "Analyze entire sequences 
up to xyz K bp" number. 

Fig. 3.13.1.  About Oligo window. 
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Figure 3.13.2.2.  Choose Sequence Fragment 
dialog window. 

The Windows dialog, shown on Fig. 
3.13.2.3, permits you to save size and 
position of selected OLIGO windows.  
When the "Save size and position" 
box is checked, the positions and 
sizes of all windows are recorded 
during program exit, and recalled in 
subsequent OLIGO sessions.  Default 
window(s) that are displayed at the 
program start up may be changed 

using the "Add/Remove" button or by using the Remove and Select/Deselect 
buttons, after highlighting the listed window name.  This window is the same in 
Mac and PC systems. 

Figure 3.13.2.3.  The Preferences dialog, 
Windows tab. 

The next option, the Update, shows 
the server address from which Oligo7 
update may be downloaded.  Please 
do not change this path unless MBI 
would inform you about any changes 
needed.  When you uncheck the box 
"Automatically check for updates" 
Oligo will not self-update 
automatically. You will still be able, 
however, to update it manually. 

Figure 3.13.2.4.  The Preferences dialog, 
Update tab. 

In the Windows version there is 
additional "Restore file associations to 
Oligo 7" button.  It is useful when 
you'd have Oligo 6 on your computer 
and if you'd happen to start this old 
version after Oligo 7 installation.  
Oligo 6 would automatically make 
sequence and database files belong 
to itself, so that Oligo 7 would not 
recognize the icons any more.  By 
clicking this button Oligo 6 databases 
and sequences would be opening 
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again with Oligo 7 automatically.  
 
The fourth Preferences tab is Startup/Quit.  

Figure 3.13.2.5. The Preferences dialog, 
Startup/Quit tab. 

By default, when you quit Oligo and re-
start it, you will need to open or edit a 
new sequence. This parameter lets you 
open Oligo with all the windows and 
searches you had before quitting the 
application.  This is a similar feature 
that was implemented in Oligo 6, but 
the old SavedWork files are not 
compatible with new versions of Oligo.  
If you need to permanently save your 
search results and oligo sets, please 
save the database or search results 

using the File menu.  Saved Work file can also be saved independently (through 
File-Save-Work…), but be adviced that future Oligo versions may not be able to 
open it. 
 

3.13.3.  Application Menu - Other Items 
Services option displays other applications, but it is not functional in Oligo. 
Hide Oligo hides all Oligo windows, and Hide Others hides all non-Oligo 
applications windows.  Show All brings all the hidden windows to the desktop. 
Quit Oligo (Mac) or Exit Oligo (Windows) quits Oligo application.  These items 
are located in the Windows Files menu and Macintosh’s Application menu. 



 43 

4 The OLIGO Edit Menu 

4.1  Edit - (Sequence, Primers, Oligos)    44 
4.1.1.   Edit Window Menu- Accept/Discard   44 
4.1.2.   Edit Window Menu - Edit     45 
4.1.3.   Edit Window Menu - Search    51 
4.1.4.   Edit Window Menu - Change    51 
4.1.5.   Edit Window Menu - Reverse Translate   53 
4.2   Edit - Restore       54 
4.3   Edit - Features       54 
4.4  Edit - Preferences       55 



 

 44 

4.  The OLIGO Edit Menu 

The Edit menu on the main menu bar allows you to change nucleic acid 
sequences and add/delete sequence features.  

 
Figure 4.0.  The Edit menu. 

The entire menu is shown on Fig. 4.0. 

4.1.  Edit - (Sequence, Primers, Oligos) 
This section describes editing the entire sequence, forward and reverse primers, 
and upper and Lower Oligos.  There are two kinds Edit (sequence) windows.  For 
editing primers or probes, the default is the mutagenesis window, and for editing 
the entire sequence the default is the full screen edit window.  You may edit 
entire sequence, as well as single oligos in either window.  Each Edit window 
contains its own menu.  You select the mode in which you wish to edit from the 
Edit window - Edit menu. 
Below is the description of the Edit window menu. 

4.1.1.  Edit Window Menu- Accept/Discard 
The Accept/Discard menu is where you decide the disposition of your changes to 
the edited sequence. 
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Figure 4.1.1.  The Edit window - Accept/Discard menu. 
 

4.1.1.1.  Accept/Discard - Accept 
The Accept command saves editing changes in computer memory, without 
closing the window.  Sequences may be saved to disk only by using one of the 
save commands from the File menu.  The short cut key is <Enter> (PC) or 
<return> (Mac).  The Accept action refreshes all windows associated with this 
sequence. 

4.1.1.2.  Accept/Discard - Accept & Close 
The Accept & Close command accepts new changes to the sequence and closes 
from the "Edit" window.  The new primer or sequence is saved only in RAM at 
this point.  Sequences may be saved to disk by using only one of the save 
sequence commands from the File menu.  The short cut key is <Shift-Enter> 
(PC) or <enter> (Mac). 

4.1.1.3.  Accept/Discard - Discard & Close 
The Discard & Close command discards any changes to the edited primer or 
sequence and closes the edit window. 

4.1.1.4.  Accept/Discard - Revert to Previous Sequence 
This command reverts the edited sequence to the original state, that was prior to 
the editing.   

4.1.2.  Edit Window Menu - Edit 
All operations under the Edit command are performed on the base immediately 
to the left of the cursor.  More than one base can be selected for editing by 
highlighting them as a group using the click and drag technique with the mouse.  
When at least three characters are displayed in the "Edit" window, all codon 
probabilities for a given amino acid (and a given organism) may be observed by 
positioning the cursor on any portion of the sequence or protein. 
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The edit functions in the "Edit" window are accessible from the Edit menu or from 
the icons listed here.  Most of these functions are not accessible until at least one 
base has been entered and highlighted.  These edit functions are standard 
Windows/Macintosh functions and perform in the same manner in the OLIGO 
program as they do in other Windows/Macintosh applications. 

 
Figure 4.1.2.  The Edit window - Edit menu. 

4.1.2.1.  Edit - Undo/Redo 

  Clicking on these icons (“Undo” is on the left) reverses the last 
editing action, including Clear, if it is selected immediately after that command.  
You may also select these actions from the window Edit menu or use a short cut 
"Z (Mac) keys combination.  In PC replace the " key with <Ctrl>. 

4.1.2.2.  Edit - Cut 

  Clicking on this icon removes any highlighted portion of text from the 
screen and places it in the Clipboard.  You may also select these actions from 
the window Edit menu or use a short cut "X (Mac) keys combination. 

4.1.2.3.  Edit - Copy 

  Clicking on this icon places a copy of any highlighted text to the Clipboard 
where it can be pasted to the active cursor position.  You may also use a short 
cut "C (Mac) or Ctrl-C (PC) keys combination. 
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4.1.2.4.  Edit - Paste 

  Clicking on this icon inserts all Clipboard contents at the current cursor 
position.  It is also possible to paste a sequence that has been copied from 
another application.  You may also use a short cut "V (Mac) or Ctrl-V (PC) keys 
combination. 

4.1.2.5.  Edit - Clear or Edit - Delete 

 Clicking on this icon deletes any highlighted text.  This text can be 
retrieved with the "Undo" function if "Undo" is selected immediately after the 
Clear command. 

4.1.2.6.  Edit - Select All 
The Select All command highlights the entire sequence for cutting, copying, or 
clearing. 

4.1.2.7.  Edit - Merge Sequence With 
The Merge Sequence with command merges the sequence from different 
locations, or from a sequence file to the edited sequence. 
To load a protein sequence, open an empty edit window using File - New.  Then 
position the cursor on the "protein edit line" (lower) while editing in the 
mutagenesis edit mode, or choose Protein from the Edit submenu.  Then load 
the protein file using Merge Sequence with and selecting File. 
Merge Sequence With - Current Oligo 
The Merge Sequence with - Current Oligo merges the Current Oligo with the 
edited sequence at the current cursor position. 
Merge Sequence With - a Primer or Probe 
This option merges the selected oligonucleotide sequence with the edited 
sequence at the current cursor position. 
Merge Sequence With - Database 
The Merge Sequence with - Database merges the highlighted database single 
record into the active sequence at the cursor position. 
Merge Sequence With - File 
The Merge Sequence with - File merges a sequence file with the edited 
sequence at the cursor position.  When the Upper or Reverse Primer is merged 
with a file, the total length of the combined sequences cannot be longer than 200 
nt. 
This option calls up the "Merge From File" window where the desired DNA, RNA, 
or protein file is selected. 



 

 48 

4.1.2.8.  Edit - Group By 
The Group By command changes the base grouping number in the "Full-Screen 
Edit" window to either three, five, or ten contiguous bases, or "off" - displaying a 
string that is not interrupted by spaces. 

4.1.2.9.  Edit - Overwrite/Insert 
The Overwrite/Insert command toggles between the two editing modes.  In the 
"Overwrite" mode, typed characters replace the old.  In the "Insert" mode, newly 
typed characters are inserted at the cursor position. 

4.1.2.10.  Edit - Sound On/Off 
The Sound On/Sound Off command activates/ deactivates sequence read-out. 

4.1.2.11.  Edit - Read back On/Off 
The Read back command "reads back" the key presses you make while entering 
a new sequence.   

4.1.2.12.  Edit - Full Screen Edit 
The Full Screen Edit window displays an oligo or the entire sequence.  Either 
nucleic acid or protein sequences can be edited here.   
 

 
Figure 4.2.12.1.  Full Screen Edit window. 

The Toolbar functions are listed in Fig. 4.2.12.2.  Besides the Toolbar 
information, the full screen edit window displays: 
 
• The sequence file name (top left) 
• The edited sequence with the first nucleotide in each line numbered 
• Contents of the Clipboard 
• The keyboard insert mode 
• The type of the edited sequence (DNA, RNA, Protein) 
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Figure 4.2.12.2.  Functions of the Edit windows Toolbar. 

4.1.2.13.  Edit - Mutagenesis 
The Mutagenesis window displays a single line of 50-100+ bases at a time for 
viewing or editing, depending on the width of the "Edit" window.  You can switch 
from a nucleic acid sequence to a protein sequence in this edit mode by re-
positioning the cursor.  This window also displays the most stable hairpin, codon 
probabilities, and several other characteristics of the displayed sequence. 
Besides what displayed on the Toolbar, single line edit information includes: 
• Sequence Length 
• Active Reading Frame 
• Degeneracy 
• tm (low case indicates that the nearest neighbor method does not consider the 

dangling ends with the template) 
• ⊗G 
• Loop Tm 

• Loop ⊗G 
• Reverse Translation Method 
• Codon Frequency for a selected organism (the sum of all 64 codons is equal 

to 1,000) 
• Nucleotide sequence with position numbers 
• Translated Protein Sequence 
• The strongest hairpin of the above displayed sequence 
• Contents and size of the Clipboard - the sequence that can be inserted with 

the "Paste" command 
• Keyboard type mode (insert or overwrite) 
• Sequence type 
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Figure 4.2.13.1.  Mutagenesis Edit window. 

The various colors of residues in the amino acid sequence represent the codon 
frequencies of each residue according to the codon table selected in the Change 
submenu.  The following six colors designate the relative codon frequencies in 
OLIGO: 
Black - Most frequent codon for the selected organism 
Blue - Second most frequent codon for the selected organism 
Green - Third most frequent codon for the selected organism 
Pink - Fourth most frequent codon for the selected organism 
Red - Fifth most frequent codon for the selected organism 
Yellow - The least frequent Leu, Arg, or Ser codon for the selected organism 

4.1.2.14.  Edit - Nucleic Acid/Protein Toggle 
In the "Full Screen Edit" window, the Nucleic Acid command changes the editing 
sequence type.  You may either edit a nucleic acid sequence or translated 
protein from it. 
As a protein sequence is edited its adjoining nucleic acid sequence is modified 
according to the current reverse translation method; however, this is not 
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displayed in the protein sequence editor in the "Full Screen Edit" window, but 
only in the Mutagenesis window. 

4.1.3.  Edit Window Menu - Search 

 
Figure 4.1.3.  The Edit window - Search menu. 

4.1.3.1.  Search - Find and Find Next 
The Find command searches for a sequence string, entered from the keyboard, 
in the entire edited sequence.   
The first occurrence of the sequence is highlighted.  Use the Find Next command 
to search for the next occurrence. 

4.1.3.2.  Search - Go to… 
The Go to command moves the insert bar to the Current Oligo position or 
prompts you for a new position number in the active sequence and moves the 
insert bar to the position you enter. 

4.1.4.  Edit Window Menu - Change 

 
Figure 4.1.4.  The Edit window - Change menu. 

4.1.4.1.  Change - Strands 
The Strands command creates and displays the complementary strand of the 
edited sequence, instead of the original. 

4.1.4.2.  Change - DNA to RNA 
The DNA to RNA command changes a DNA sequence to RNA and vice versa.  
The menu display toggles back and forth between DNA and RNA. 
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4.1.4.3.  Change - Reading Frame 
The Reading Frame command changes the current to the first, second, or third 
translation reading frame. 

4.1.4.4.  Change - Rev. Translate Method 
Lathe  
The Lathe method is based on the most probable codons in human mRNA (14). 
The human codon table is used. 
Inosine  
When the Inosine method is selected, an inosine (universal substitute nucleotide) 
is inserted at the third base position in certain degenerate codons (11). 
Degenerate  
This method gives all possible oligonucleotide combinations using the standard 
biochemical symbols for degenerate codons  - N, Y, R, etc.; see Appendix D, 
Table 7 (12). 
Codon Table 
This back translation method creates a non-degenerate guess-mer sequence 
from the most frequent codons for a selected species.  This is the default reverse 
translation method used in OLIGO. 
OLIGO includes these codon tables: 
 
 • Arabidopsis 

• Bacillus 
• Barley 
• Caenorhabditis elegans 
• Chicken 
• Clostridium 
• Cow 
• Distyostelium discoideum 
• Drosophila 
• E. coli 
• HIV 
• Human 
• Influenza virus A 
• Mouse 
• Neurospora crossa 
• Pea 
• Pig 
• Plasmodium 

• Pseudomonas 
• Rabbit 
• Rat 
• Rhizobium 
• Rice chloroplast 
• Salmonella typhimurium 
• Soybean 
• Staphylococcus 
• Streptomyces 
• Tobacco 
• Tomato 
• Trout 
• Vaccinia virus 
• Wheat 
• Wheat chloroplast 
• Xenopus laevis 
• Yeast (S. cerevisiae) 
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4.1.4.5.  Change - Codon Table  
The Codon Table command selects the codon frequency table for a given 
organism.  To add a new codon frequency table to the list, modify the codon 
table file "Codon Usage Tables." 
There are four lines in each codon table file: 
1. The name of the organism 
2. The codon frequencies for that organism as described in Nucleic Acid 

Research  (Ref. 18.) 
3. The codons listed in order of frequency in the organism 
4. The amino acids 
A time-saving way to add a new user-specified codon table is to copy the last 
codon table in a file, and then change the organism name and codon 
frequencies.  The recent codon tables can be found web: search for Codon 
Usage Database. 
Note  When you change the codon table, the reverse translation method 

automatically sets to “Codon Table”. 

 

4.1.5.  Edit Window Menu - Reverse Translate 
 

 
Figure 4.1.5  The Edit - Rev. Translate menu. 

Note  Reverse translation is automatic when you load or enter any protein (by the 
last method set). 

4.1.5.1.  Reverse Translate - Entire Sequence 
The Entire Sequence command reverse translates the entire current protein 
sequence into DNA/RNA according to the active reverse translation method. 

4.1.5.2.  Reverse Translate - Selected Block 
The Selected Block command reverse translates only the selected (highlighted) 
block of amino acids into DNA/RNA, according to the active reverse translation 
method. 
 



 

 54 

4.2.  Edit - Restore 
These commands restore the Upper or Lower Oligo and Forward or Reverse 
Primer that may have been overwritten using one of the following program 
functions: 
• Selecting either a Primer or a Probe from the Select menu or from the 

Sequence window 
• Editing them in any of the Edit windows 
• Conducting an automatic search 
 

4.3.  Edit - Features 
This window allows adding, deleting and changing sequence features, usually 
associated with GenBank sequences as annotations.  The features are not only 
graphically displayed in the Sequence window but are the integral part of the 
searches, as they may serve as the search ranges.  When you save a sequence 
with OLIGO, those features will be saved as well, in a simple text-format file.  
This format is specific to OLIGO only, but sequence file saved by this software 
may be opened by any word processor at later time. 

 
Figure 4.3.  The Edit – Features window. 

Each feature takes one row in this window.  There are four columns in this table: 
the check box column, “#” - the feature number, name of the feature and the 
position number(s) this feature is located on the sequence.  If the list is long, a 
scroll bar appears on the right of the table.  Below this list a set of four icons and 
the Accept button is located.  When a box or boxes are checked and <Accept>-
ed, you may be able to search for primers only on those selected regions. 
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Click on the  icon to enter a new feature.  The insertion bar will automatically 
move beyond the last feature, OLIGO will create automatically the new # and will 
prompt you to enter the new feature name next to it:  

 
The feature name could be anything. Move to the Location field by pressing the 
Tab key or simply click on the Location area in the same row.  Enter a single 
number, or if it is a continuous region, two numbers separated by two dots 
(100..282) or if it is a non-continuous entity, such as introns, write it in this format: 
[ join(100..150, 230..355, 2451..3781) ], (omit the square brackets).  When you’re 
done, click on the <Accept> button and you may close the window. 
When you click on a feature, the entire row will be highlighted and on the bottom 
of the window you will see graphical representation where the feature is located 
on the sequence.  The same graph, the zoomed graph, as well the list of features 
you will find also on the Sequence window. 

4.4.  Edit - Preferences 
This option is described in Chapter 3.13.2. as it is located in the Edit menu only 
in Windows systems. 
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5.  The OLIGO Analyze Menu 

The Analyze menu allows you to perform analyses of oligonucleotide primers and 
probes, the active sequence(s), PCR products, and primer specific experimental 
conditions. 

 
Figure 5.0.  The Analyze menu. 

5.1.  Analyze - Key Info 

5.1.1.  Key Info - Current Oligo 
This option calls up the "Current Oligo" window that displays the Current Oligo 
specifications in two columns.  The left column is for the positive strand, and the 
right is for the negative, in the following order: 
 
• The sequence of the Current Oligo, displayed from the 5' to the 3' end. 
• The Current Oligo length. 
• The 5' position of the Current Oligo positive strand and the 3' position of its 

negative strand complement. 
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• The Current Oligo's Tm (dangling ends included) and tm (dangling ends 
excluded) calculated by the nearest neighbor method using the salt and 
nucleic acid concentrations displayed in the "Non-Search Parameters" dialog 
box (Change menu). 

• The ⊗G (free energy) calculated using temperature displayed in the "Non-
Search Parameters" dialog box (Change menu).  The ⊗G value is for 
dangling ends included and ⊗g – excluded. 

• The ⊗S (entropy).  The ⊗S value is for dangling ends included, and ⊗s – 
excluded. 

• The ⊗H (enthalpy).  The ⊗H value is for dangling ends included, and ⊗h – 
excluded. 

• The 3’⊗G -free energy of the 3’-terminal pentamer. 
• The degeneracy number for the Current Oligo 
• The Priming Efficiency number (P.E. #; for the explanation see section 5.5). 
• The extinction coefficient properties of the positive strand Current Oligo, 

expressed in nmol/O.D. at 260 nm and in µg/O.D. at 260 nm. 
 

  
Figure 5.1.1.  The Current Oligo window. 

When analyzing Current Oligos on the active sequence, it may be helpful to get 
instant data updates from the "Current Oligo" window as you change position.  
"Current Oligo" window data saved in a file also include the salt and nucleic acid 
concentrations used to calculate Current Oligo Tm. 

5.1.2.  Key Info - Selected Primers, Probes 
These windows display the following calculations and specifications of the 
selected oligonucleotides: 
• The names of the oligonucleotides assigned by OLIGO. 
• The sequences of the Forward and Reverse Primers or Upper and Lower 

Oligos, displayed from the 5' to the 3'-end. 
• The length of the Upper and Reverse Primers. 
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Figure 5.1.2.  The Selected Primers window. 

• The 5' position of the Upper & Forward oligos and the 3' position of the Lower 
& Reverse oligos. 

• The oligo's Tm (dangling ends included) and tm (dangling ends and 
mismatches excluded) calculated by the nearest neighbor method using the 
salt and nucleic acid concentrations displayed in the "Non-Search 
Parameters" dialog box (Change menu).  If there is a mismatch between a 
given oligo and the main sequence, the Tm is with the mismatch. 

• The ⊗G (free energy) calculated using temperature displayed in the "Non-
Search Parameters" dialog box (Change menu).  The ⊗G value is for 
dangling ends and mismatches included and ⊗g – excluded. 

• The ⊗S (entropy).  The ⊗S value is for dangling ends included, and ⊗s – 
excluded.  Mismatches are considered. 

• The ⊗H (enthalpy).  The ⊗H value is for dangling ends included, and ⊗h – 
excluded. 

• The 3’⊗G -free energy of the 3’-terminal pentamer.  Mismatches are 
considered. 

• The degeneracy number for the oligo 
• The Priming Efficiency numbers.  The first number is as if there would be a 

perfect match with the main sequence, and the value after the slash is the 
actual P.E. number. 

• The extinction coefficient properties of the oligo, expressed in nmol/O.D. at 
260 nm and in µg/O.D. at 260 nm. 

 

5.2.  Analyze - Duplex Formation 
The Analyze - Duplex Formation command calls up the "Duplex Formation" 
windows that display potential duplexes in the oligonucleotides.  Potential dimers 
between all the pair combinations may also be displayed.   



 61 

⊗G and hairpin loop Tm values are calculated and displayed in association with 
each duplex (dimer or hairpin).  If the Tm is not displayed for a given hairpin, then 
it is not likely that it can form (Tm>0). 
Note  The minimum number of contiguous bases required for the display of a 

potential dimer structure in this formation is two.  If fewer than two 
contiguous bases match, a "no dimer formation" message appears. 

5.2.1.  Duplex Formation - Forward and Reverse Primer, Upper and 
Lower Oligo 

The information shown in this window includes: 
• The most stable 3' terminal dimer alignment of the primer or probe. 
• The most stable primer dimer alignment overall. 
• The most stable hairpin structure in the primer or probe, if any. 
• The stability values of the most stable uninterrupted duplex (shown in colors) 

in each alignment, and of the hairpin structure, expressed in kcal/mol; Tm of 
the hairpin is displayed when it is greater than 0° 

5.2.2.  Duplex Formation - Current Oligo 

 
Figure 5.2.2.  The Current Oligo Duplexes window. 

The "Current Oligo" window displays: 
• The most stable 3' terminal dimer alignment of the current positive strand 

oligo 
• The most stable 3' terminal dimer alignment of the current negative strand 

oligo 
• The most stable dimer alignment overall in the current positive strand oligo 
• The most stable hairpin structure in the positive strand of the Current Oligo 
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• The stability values of the most stable duplex (shown in red) in each 
alignment, and of the hairpin structure, expressed in kcal/mol; Tm of the 
hairpin is displayed when it is greater than 0°. 

5.2.3.  Duplex Formation - Mixed Oligos 
This window displays all possible alignments between the all selected oligos, up 
to 4 pairs: Forward & Reverse Primers, Upper & Lower Oligos.  Each pair is 
aligned in 3-ways: 
1, 2 The most stable dimer alignment pairing the 3'-terminus of one of the 

oligos to any segment of the other and vice versa; 
3 The most stable dimer structure overall between the two oligos. 
The stability values of the most stable uninterrupted duplex in each alignment, 

expressed in kcal/mol. 

 
Figure 5.2.3.  The Mixed Oligos Duplexes window. 
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5.3.  Analyze - Hairpin Formation 
The Analyze - Hairpin Formation windows display potential hairpin loop 
structures in the Forward, Reverse Primers, Upper, Lower or Current Oligo.  The 
hairpin stems are displayed in descending order of stability, expressed in hairpin 
loop ⊗G and the Tm values.  These values are approximate since the 
thermodynamic data on hairpin loops (as opposed on the duplexes), especially 
on the large ones are not well established.  An example of this kind of window is 
shown below. 

 
Figure 5.3.  The Hairpin Formation – Current Oligo window.   

5.4.  Analyze - Composition and Tm 
The Analyze - Composition and Tm windows display the base composition and 
melting temperatures of the selected Forward or Reverse Primer, Upper or Lower 
Oligo, Current Oligo, entire sequence, or PCR product at various conditions by 
various calculation methods, as displayed on Fig. 5.4.  Expression “Td” is the 
melting temperature calculated by  the nearest neighbor method for 100 nM 
oligos in 1M monovalent salt concentration between a given oligo and its 
complement, so that the dangling ends and mismatches don’t count.  The Tm for 
the nearest neighbor method is shown for the nucleic acid and salt conditions set 
in the Search Parameters window.  It is a ‘full’ calculation, that includes the 
dangling ends, however the mismatches are not considered.  If the “tm“ is 
displayed instead of the “Tm“ in certain Oligo windows, than the nearest neighbor 
method is used without consideration for the dangling ends.   
Besides the Tm values the Composition and Tm windows display: 
•  The A260/A280 absorption ratio 
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Note  The A260/A280 absorption data have been generated using a limited 
number of oligos. 

•  The molecular weight of the given oligo, both single stranded and double 
stranded 

 

 

 
Figure 5.4.  The Analyze - Composition and Tm windows. 

•  The number and percentage of each base in the oligo plus the number and 
percentages of A+T and of G+C in the sequence 
•  The melting temperature (%GC method) of the selected nucleic acid molecules 
with their complements at various salt concentrations (expressed both as mM 
and as multiples of the SSC buffer) in 0%, 10%, and 50% formamide 
•  A calculation of melting temperatures (nearest neighbor method) for the short 
oligos only, with up to five mismatches (note Tm was replaced by tm: no dangling 
ends considered). 
 

5.5.  Analyze - False Priming Sites 
The Analyze - False Priming Sites windows display potential false priming sites 
for the Forward or Reverse Primer or Upper or Lower Oligo in both the sense and 
antisense strands of the active sequence. 
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Figure 5.5.  An example of a False Priming Sites window with M13MP18.seq loaded and 
6310R19 primer analyzed (itʼs an old commercial m13 reverse primer).  The site with P.E. of 244 
points is the real false priming site as confirmed experimentally (20). 

 
The False Priming Sites search performs the following: 
•  A search for potential sites using a homology algorithm similar to FASTN (22) 
•  A calculation of the priming efficiency number of potential sites found in the 

search 
 
Priming Efficiency Calculations.  The priming efficiency number (P.E. #) is a 
formulation unique to the OLIGO program (a proprietary algorithm) that quantifies 
the likelihood that a given oligonucleotide will prime at a given site on the 
template.  It has been determined that matching PCR primers by their P.E. # 
gives better results than matching the primers by their Tms.  This is especially 
important in designing multiplex PCR experiments.  The priming efficiency 
considers: 
• The stability (⊗G) of primer-template duplexes and their distance from the 3'-

end 
• Bulge loops and mismatches and their distance from the 3'-end 
• The overall primer length 
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A priming efficiency number (P.E. #) of above 200 for a given site may result in 
priming during PCR or cycle sequencing conditions.  A P.E. # of 170 is the 
approximate lower limit for priming (or false priming) when using SEQUENASE®.   
 

5.6.  Analyze - Homology 
The Analyze - Homology windows display the best homology alignments for the 
Forward or Reverse Primer or Upper or Lower Oligo in both the sense and 
antisense strands of the active sequence. 

 
Figure 5.6.  An example of a Homology window.  The same m13mp18 primer is analyzed to 
show the difference between the false priming sites algorithm. 

The homology search is using the Lipman and Pearson’s FASTN algorithm (23). 

5.7.  Analyze - Selected Oligonucleotides 
The Analyze - Selected Oligonucleotides window displays a table listing all 
oligonucleotide selections from the most recent search.  Choose the kind of 
oligos to display (Forward Primers, Upper Oligos, etc.) with the button at the 
upper left corner of the window.  The table shows all the oligos found in the last 
search, but if the check box “Hide unpaired oligos”, is checked, the table shows 
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only the oligos that match with other oligos in the table that create sets.  The sets 
are created during the search for PCR primer pairs or the TaqMan probes. 

 
Figure 5.7.  The Selected Oligos window showing consensus primers. 

Although PCR primer search data can be displayed using this option, the window 
is primarily for displaying sequencing primer and hybridization probe search data.  
Accordingly, the data table lists Tm of the oligo, the 3'-terminal pentamer ⊗G 
(specificity), and GC clamp ⊗G stability (the most stable pentamer in the oligo) 
associated with each oligonucleotide starting at (Forward, Upper) or ending with 
(Reverse, Lower) the displayed position.   
If you’ve searched for consensus primers or probes, you may pull down the 
window separator to reveal all sequence alignments and the consensus 
sequence. 
At the default setting, the window sorts oligonucleotides by descending score, 
ascending position and descending length.  You may also sort the table by Tm, 3' 
⊗G, or GC clamp by clicking on the sort button above that column.  You may 
implement secondary, tertiary sorts and so on..  Simply hold down the <option> 
key (Mac) or <Ctrl> key (Win) and click on the name of the row.  The primary sort 
field button will be labeled "1", and the secondary "2", tertiary "3" etc. 
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As you click on different positions in the table, the Current Oligo position is 
updated accordingly.  Double click on a displayed number selects this oligo as a 
relevant primer or probe. 

5.8.  Analyze - Oligonucleotide Sets 
The Analyze - Oligonucleotide Sets window contains a table of primer pairs data 
from the most recent PCR primer, TaqMan, Molecular Beacons or nested primers 
search.  The following information is included in the table: 
• The primer/probe set number 
• The primers and probe positions on the + and - strand active sequences 
• The PCR product score 
• The length of the PCR product the pair would generate 
• The calculated optimal annealing temperature recommended for PCR using 

this primer pair 
• The percent GC content of the PCR product generated by this pair 
By default, primer pairs are displayed by the score in descending order (primary 
sort: see the order of sorting, below the column names, on Fig. 5.7).  Sorting the 
primer pairs by optimal annealing temperature (Ta), product length, or %GC 
content (all in ascending order) is performed by clicking on the column name.  
Multiple sorts by clicking on the same and holding the Option key (Mac) or Ctrl 
key (PC). 
By clicking on any of the listed primer pairs & probes rows in the table, you select 
the listed sets.  Double clicking on a pair also calls up the PCR window that 
displays a graphic of the PCR product's location on the active sequence, along 
with other data for running PCR with the selected primer pair.  The Sequence 
window is also updated at the same time. 
Note  The "Primer Pairs" window is not accessible unless a relevant search is 

performed first.  

 
Figure 5.8.  The Primer Pairs window.  By pressing the option key, <!> (Mac) or the <Ctrl> key 
(Win) and clicking a column name simultaneously you can perform secondary sorts. 
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5.9.  Analyze - PCR 
The Analyze - PCR window displays various data for PCR based on a user-
selected PCR primer pair.  The primer pair must be selected before this window 
can be called up. 

Optimal annealing temperature for PCR TaOPT and the maximum annealing 
temperature (Tamax) are given.  For your initial experiment, use TaOPT, since it 
usually gives the highest yield.  The Tamax may be rather used for diagnostic 
purposes because PCR is more specific in these conditions. 

 
Figure 5.9.  The Analyze - PCR window. 

The following is provided relative to the prospective PCR product: 
• Length in base pairs 
• Tm (GC% method) 
• GC content 
• score for PCR 
Note:  scores for the Set are given in the top-right part of the window.  See also 

the button "F/R Product" and "U/L Product" - these control what type of 
product is displayed, either Forward/Reverse Primer product or Upper/Lower 
Oligo product. 
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For the primers & probes the following information is given: 
• 5'-end position number for the Forward Primer and Upper Oligo and 3'-end 

position number for the Reverse Primer & Lower Oligo 
• Length in nucleotides 
•  Tm is given at concentrations specified in the lower portion of the window - 

these values are interactive and can be defined by you.  
Note  The primer and salt concentrations in this window are independent from 

the global salt and nucleic acid conditions specified in the Search 
Parameters.   

• Priming efficiency numbers (format: [real P.E. with mismatches if present / 
theoretical P.E. without mismatches, even if present] ) 

PCR primers may be balanced by using their P.E. # or by their Tms.  Excellent 
results have been obtained for multiplex PCR (10 pairs) when all the primers 
were within a 450-500 P.E. # range.   
• The score (the higher the score, the more suitable primer). 
And below the table you’ll find: 
• Tm difference between the product and the less stable primer. 
Avoid a primer-product difference of more than 29° since this may produce too 
much competition between template-template and primer-template annealing. 
• Tm difference between the primers 
Avoid designing primers with a high Tm difference whenever possible.  When the 
selected primers have disparate Tms (greater than 10°), the more stable primer 
does not work optimally because the annealing temperature has to be reduced to 
compensate for the less stable primer.  Removing nucleotides from the 5' end of 
the more stable primer in order to match Tms does not decrease PCR efficiency.  
On the other hand, increasing the length of the less stable primer to match the Tm 
of the more stable primer will typically improve PCR.   
The Comments box on the bottom-right indicates possible problems that may 
arise from using  selected oligos as PCR primers. 

5.10.  Analyze - LCR 
LCR (Ligase Chain Reaction) is a diagnostic technique designed to confirm the 
sequence in a target DNA sample (25).  The LCR function designs two pairs of 
complementary LCR primers for a wild-type DNA sample, and optionally, an 
additional pair to detect a point mutation. 
To use the LCR feature in OLIGO: 
1. Load the sequence file containing the target oligo sequence. 
2. Locate the site of the potential point mutation, and position the 5'-end of the 

Current Oligo at that position. 
3. Choose LCR from the Analyze menu. 
4. Click on "Select" to automatically select the four probes. 



 71 

 The two sets of probe pairs overlap by one base, creating 5' recessed ends.  
The mutation-specific probes have an approximate Tm of 65°C, while the 
common probes have an approximate Tm of 70°C.  OLIGO automatically adds 
a non-complementary tail to mutagenic probes so you can distinguish them 
from the wild-type probes. 

5. Click on one or more of the remaining three buttons to select the appropriate 
mutation. 

 The melting temperature of the probes detecting a mutated DNA listed in this 
window is calculated only for the template-matching portion of the probe.  The 
length of the non-complementary tail has no affect on Tm calculations. 

 

 
Figure 5.10.  The LCR window.   

 
To modify the probes (the "fill-in" LCR variation): 
1. Load the probes to an OLIGO database using the LCR Oligos command from 

the database Import menu. 
2. Edit the probes using Modify command from the database Edit menu. 
Note  Changing salt and nucleic acid concentrations in the "Search Parameters" 

dialog box affects the size of the selected probes. 

5.11.  Analyze - Tm Graph 
The Melting Temperature Graph command opens the "Melting Temperature" 
window.   
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Figure 5.11.1.  The  Melting Temperature window, dot style, using Zoom 1 option.  The Current 
Oligo length was set to 25 nt. 

The Melting Temperature window shows a stability or degeneracy  graph of the 
displayed on the bottom of the window sequence segment, calculated using the 
nearest neighbor method (if stability is displayed).  Each point or bar on the 
graph represents the Tm or ⊗G of an oligonucleotide, the 5'-terminus of which is 
located at the position listed on the top right of the window (cursor position).  The 
Tm is calculated for oligonucleotide length that is set in the "Current Oligo Length" 
option from the Change menu - the default is a 21-mer.  The currently set oligo 
length is displayed on the window tool bar.  The Current Oligo sequence is in red, 
and its Tm is represented by a small red ball. 
The "Melting Temperature" window toolbox, displayed at the top portion of the 

window below the sequence file name,  allow the window 
customization.  To the right of the toolbox the sequence length and the length of 
Current Oligo is displayed, and on far right the two boxes display the position and 
Tm of an oligo starting at this position of the cursor (vertical gray bar). 
The first icon is the zoom in, and the second, zoom out.  Use them to decrease 
or increase magnification of the graph.  Only the fully zoomed-in window displays 
the actual sequence. 
By default, the Melting Temperature window displays the tm plot of every 21-mer 
of the active sequence.  However, there are three display modes of Tms, 3 of ⊗G 
values, and one of %GC composition and degeneracy.  You can change the 

display from the Graph  window by clicking the Graph  icon.  The display 
options are described below. 
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Figure 5.11.2.  The Graph options of the Melting Temperature window. 

The default display is the melting temperature without consideration for dangling 
ends, marked tm throughout the entire OLIGO.  The Tm(+) shows the melting 
temperature of forward half of the Current Oligo-size oligos, and the Tm(-) of its 
complement.  For both Tm values appropriate dangling ends correction are given.  
The analogous set is for the ⊗G values, where ⊗g symbolizes the free energy 
value without the dangling ends.  Selecting “GC%” will show the GC/AT ratio in 
the Current Oligo-length fragments, and if the sequence is degenerate, you may 
select the degeneracy plot, also the window for calculation of the degeneracy is 
of the size of the Current Oligo length. 
 
There are two display styles available for this window: "bars" and "dots" that may 

be switched by clicking the Options  icon at the top of the window.  The full 
Options menu of the Melting Temperature window is displayed below. 

 
Figure 5.11.3.  The  Melting Temperature window Options menu. 

The other two items of this menu are: 
• Hide/Show Mean Value.  When the “show” option is selected, a dotted line is 

displayed in the "Melting Temperature" window.  The line represents the 
mean Tm, ⊗G, %GC or degeneracy of all the oligonucleotides of the selected 
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length in the active sequence.  This mean value is shown as the center line 
on the Tm plot.   

• Hide/Show Threshold Values.  The other two lines represent the upper and 
lower Tm threshold settings currently controlling the "Oligonucleotides Within 
Selected Stability Limits" sub-search which is used by the PCR primer, 
sequencing primer, and hybridization probe searches. 

5.12.  Analyze - Internal Stability 
These windows plot the ⊗G of pentamers (internal stability) of the active 
sequence (Current Oligo), and all individual primers and probes.  There are two 
display styles available for this window: "bar" and "dot" that may be switched 

using the Options  icon. 
Each base of the Current Oligo pentamer is represented by a red ball or a deep-
green bar, while the rest of the sequence pentamers are represented by green 
balls or light green bars.  The colors are uniform for the other Internal Stability 
windows that show short oligos.  The cursor position number displayed at the top 
right shows the pentamer number in a given oligo or the position number of the 
sequence (Current Oligo window).  Besides this cursor position you can read 
also the ⊗G value of the pointed-on pentamer (the cursor points at its 5’-end).  
This window can be used to check whether a given oligo has GC clamps, or 
other variabilities in its stability.  An oligo with a slightly unstable 3'-end, but with 
higher stability along the remainder of its length, is likely to be an efficient and 
specific primer, assuming that other design characteristics are optimized. 
 

 
Figure 5.12.  The Internal Stability - Current Oligo window. 

The Internal Stability window has the same toolbar (except that the Graph icon is 
missing) as the Melting Temperature window that serve the same functions. 
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5.13.  Analyze - Sequence Frequency 
 

 
Figure 5.13.  The Frequencies window, bar style display.   

This window shows the relative frequency of nucleic acid subsequences (6- or 7-
mers) throughout the entire loaded sequence.  Oligonucleotides with 3'-ends 
common in a specific database (subset of GenBank) have a greater likelihood of 
false priming.  The tables of frequencies (located in the Frequencies folder) are 
user-selected and contain normalized frequencies of GenBank sub-sequences 
(6- or 7-mers).  The header of each frequency file describes in detail how each 
table was created.  For example, the first 20 lines of GBPRIHUM.FR6 are shown 
below. 

 
  GBPRI.SEQ          Genetic Sequence Data Bank 
                         15 April 1997 
               NCBI-GenBank Flat File Release 100.0 
                        Primate Sequences 
   68547 loci,  90213435 bases, from   68547 reported sequences 
Organism: Homo 
Frequency of 6-mers from 57478 records greater than 99 nt. (tot. 86452438 nt.) 
 expressed as HITS x 1000 x 4096 (=Table size) / K.  The average frequency 
 for a given 6-mer is 1000.  K, the number of analyzed 6-mers is 85736235. 
 
     1   AAAAAA   10020 
     2   AAAAAC     2138 
     3   AAAAAG     2857 
     4   AAAAAT     4055 
     5   AAAACA     2699 
     6   AAAACC     1536 
     7   AAAACG        395 
     8   AAAACT     1812 
     9   AAAAGA     2945 
    10   AAAAGC     1529 
 

In this particular example, the frequency number for the sequence AAAACG is 
395, meaning that this particular hexamer is found 8268 times 
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(395x85736235/4096,000) in human sequences from GenBank, release 100.  By 
choosing oligos with infrequent 3'-ends, in a given database, you are decreasing 
the likelihood of selecting a primer that primes on many sites in a complex 
substrate, such as genomic DNA.  In other words using oligos with low frequency 
numbers decreases chance of unspecific PCR.  No significant difference in PCR 
performance was found when primers were selected from a 7-mer frequency 
table or a 6-mer frequency table.  A frequency of 1000 is the average hexamer 
(or heptamer) frequency for a given database.  These data tables are also used 
in the "Eliminate Frequent Oligos" sub-search for primers. 
The toolbar of this window contains the following items: 
The two first icons are for zooming-in or out the sequence frequency display, the 
Options  icon allows for changing the window style from dots to bars and vice 
versa, provides show/hide the sub-search threshold value, and allows to change 
sequence frequency data from the Frequencies folder. 
 

5.14.  Analyze - Open Reading Frames 
 

 

Figure 5.14.1.  The Open Reading Frames window.  The graphic part on the top is zoomed-in to 
better show the amino acid composition in colors. 
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Figure 5.14.2.  The Open Reading Frames window.  A fragment of the same window as shown on 
Fig. 5.14.1 but with a different color coding is shown. 

This window displays all open reading frames of the loaded sequence.  They are 
displayed graphically on the top and as text on the bottom part of the window.  
The toolbar is located just below the sequence file name and contains the 
following elements: 
• The zoom in and out slide bar to accurately control the size of the graphic 

display. 
• The Options  icon allowing for changing meaning of the colors.  By default, 

the codon frequencies are displayed in various colors, but you may change 
this to amino acid type, where acidic amino acids are labeled in red, basic in 
blue, hydrophobic and aromatic in brown (except the tryptophane and 
methionine), nucleophilic (small) in black, cysteine in yellow and proline in 
green. 

• The minimum size of an open reading frame that this window displays can be 
changed by typing the number on the “Min. ORF Size” box.  Typing a larger 
number will eliminate short ORFs from the display, thus somewhat cleaning 
up the window. 

• The cursor position is displayed at the right.  The bottom window indicates 
this position by a vertical grey line. 

ORFs are displayed graphically below the tool bar.  The yellowish rectangle 
dividing the positive and negative strand ORFs has a green box representing the 
range of the lower portion of the window with amino acid symbols and the DNA 
sequence.  The extent of the zoomed graph show also the nucleotide numbers of 
the most to the right and to the left nucleotides represented in the graph area. 
If you click on any of the ORF, displayed graphically or by the letters (the given 
ORF block is underlined in bright green) the ORF Statistics table will show its 
reading frame number, positions on the DNA sequence, size of the protein in the 
number of amino acids and molecular weight, as well as the mean pKa value, 
that often approximates its isoelectric point. 
To the right of the ORF Statistics table there is a table explaining the meaning of 
colors used to present ORFs in the graphic style (above) as well as in the letter 
style in the zoomed area below. 
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In the zoomed area at the bottom of the window you can see the DNA sequence 
in the middle, above it - its translation of the positive strand, and below the 
translation of its negative strand in all reading frames.  The amino- and carboxy- 
termini of the proteins are labeled on the sides.  The scale on the top indicates 
the nucleotide position of the sequence. 
You may move the sequence around in this window not only by clicking the 
mouse pointer but also by the keyboard, the same way as in the Sequence 
window, described in Chapter 2.5.4, using the arrows, PgUp & Down and space 
bar keys. 
Note: If you move around the Current Oligo in the ORF window all other relevant 

windows update automatically, including the choice of ORF displayed in the 
Sequence window. The amino acid color codings is also updated in the 
Sequence Window. 

 

5.15.  Analyze - Restriction Enzyme Sites 
This Analyze window is available after the Search for the Restriction Sites, that is 
described in the Search menu section.  There are two parts of this window that 
display results of the search in two formats, the top is the graphical and the 
bottom is the table listing. 
The graphical part consists of three columns. The first two are the same as in the 
table listing below: the number of an enzyme in the restriction enzyme file that 
was used to perform the search and the enzyme name.  The third column shows 
at the top the nucleotide position scale of the entire sequence file, and below the 
recognition sites as vertical blue lines spanning from top to bottom of each row 
representing the space for a given restriction enzyme. 
The list, besides the number and the enzyme name has 3 more columns, 
depending on the window width, displaying the actual recognition site, the 
number of sites in the entire active sequence file, and the recognition sites 
positions (in black).  The position sites are interrupted by the fragment sizes, 
displayed in green.  Below the table there is listing of enzymes that do not cut the 
sequence. 
At the window bottom the two search parameters are displayed: the type of 
sequence (linear or circular), and the file name of the restriction enzyme 
database used in the search. 
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Figure 5.15.  The Restriction Enzyme Sites window. 

5.16.  Analyze - Restriction Enzyme Sites in Protein 
 
This Analyze window is available after the Search for the Restriction Sites in 
Protein, that is described in the Search menu section.  The window looks almost 
exactly the same as in the option described above, with the same features 
displayed.  The bottom window shows the search range and the type of enzyme 
cuts that have been considered: blunt ends, 3’ or 5’-overhangs or other (odd). 
This search can be performed only on the positive strand sequence in any of the 
3 reading frames.  It is helpful to use Open Reading Frames window, select the 
ORF of interest from there and read the exact search range that needs to be 
performed. 
This is the analysis of a protein, so the actual nucleotide sequence has little to do 
with it.  The sites in the potential DNA sequence are calculated only from reverse 
translated protein using the degenerate method, and the window displays all 
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possible restriction sites that could be used in the DNA sequence without 
changing the protein sequence. Example of the window is shown below. 

 
Figure 5.16.  The Restriction Enzyme Sites in Protein window. 

Besides the enzymes listed in the table, you cannot enter your own enzyme for 
the searches.  OLIGO has 79 restriction enzymes that can be selected for the 
search.  All are six-base cutters or longer, and none recognize degenerate 
bases.   
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5.17.  Analyze - Hybridization Time 
 

 
Figure 5.17.  The Hybridization Time window. 

The Analyze - Hybridization Time command calculates oligonucleotide 
hybridization time for various user-selected lengths and  concentrations in the 
"Hybridization Time" dialog box.  OLIGO uses the following formula for 
calculation of the time required to reach half of the equilibrium (after this value 
half of all possible duplexes should be already formed): 
 

t1/2 = N * ln2 / 3.5 * 105 * ℘L * CN 

Where N is the total number of base pairs in a non-repeating sequence 
(molecular complexity), L is the oligonucleotide length (in nt), and CN is the 
oligonucleotide concentration (mol nucleotides/liter).   
For simplicity, N = L; therefore,  
 

 t1/2 = ℘L * ln2 / 3.5 * 105 * C 
Where C is oligonucleotide concentration (moles/liter).  (Ref. 15.) 
When a new length or concentration value is entered, the new hybridization time 
is displayed. 
Note  Because of high secondary structure potential and the presence of 

sequence repeats, hybridization times for long DNA fragments is usually 
underestimated by this formula.  The hybridization time for standard length 
primers should be reasonably accurate. 

The “T” value displayed in this window is 5 times the t1/2, that is sufficient to reach 
about 90% equilibrium. 
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5.18.  Analyze - Concentrations 
 

 
Figure 5.18.  The  Concentrations window. 

The Analyze - Concentrations command calls up the "Concentrations" window 
and calculates concentration, volume, absorption, and molecular weight 
conversions for the following sequences from the OLIGO program: 
• Current Oligo, positive strand 
• Current Oligo, negative strand 
• Entire sequence (active sequence) 
• Forward Primer 
• Reverse Primer  
• PCR product 
• Upper Oligo 
• Lower Oligo 
There are two calculation modes in the "Concentrations" window: 
• Constant Concentration, where the concentration of a nucleic acid  sample in 

solution is held constant while allowing the other values to vary 
• Constant Volume, where the total solution volume of a nucleic acid sample is 

held constant while allowing other values to be recalculated 
The right side of the "Concentrations" window provides five data entry boxes 
where $g, OD, nmole, $L and $M values may be entered.  Once a new value is 
entered in a given data box, you can click the mouse in any other box and initiate 
a recalculation of all other boxes, except the volume or concentration box, 
whichever was set constant. 
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Note  The right column of this window should read:  "X micrograms of DNA/RNA 
or Y optical density (O.D.) units or Z nanomoles in K microliters makes a N 
micromolar DNA/RNA solution." 

 

5.19.  Analyze - All Checked 
 
The Analyze - All Checked command ("X in Mac, Ctrl-X in PC) opens all the 
windows checked in the File-Print/Save option.  If all those windows are already 
opened, this option closes them.  This toggle works even when the printing of just 
only the "Current" window is selected in the "Print/Save" dialog. 
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6.  The OLIGO Search Menu 

The Search menu includes OLIGO's searches: the search for primers and 
probes, the search for sequence strings, and the search for restriction sites in 
DNA and protein sequence files. The search for palindromes that used to be in 
Oligo 6 is now automatic and the results are displayed in the Sequence window.  
There is also automatic search for hairpin loops in the template and the results of 
this search is automatically displayed in the Sequence window as well, and they 
are also accessible through the Show Selected Bases menu option. 

 

 
Figure 6.0.  The Search menu. 

 

6.1.  Search - Primers and Probes  
The Search for Primers and Probes allows you to search for optimized PCR 
primer pairs, sequencing and nested primers, TaqMan probes, molecular 
beacons, hybridization probes or even siRNA probes in the active nucleic acid 
sequence.  Each of these searches consist of several simple procedures, listed 
in the “Subsearches” window.  If you click the Subsearches button you will see all 
available subsearches OLIGO may perform. You may manually check/uncheck 
each button to activate or deactivate that sub-search option.   
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Figure 6.1.  The Search for Primers and Probes windows. 

The Ranges and Parameters dialogs may be accessed by clicking on the 
respective buttons in the "Search for Primers and Probes" windows.  These 
options are also available from the Change menu.  You can change the search 
parameter values individually or globally using the "Parameters" button.  You 
may specify the search ranges using the “Ranges” button, and change all 
parameters to defaults at a given stringency level (except the ranges) using the 
“Defaults” button.  
 

6.1.1.  Available Search Modes 
Search in + or - Strand. You can search in the positive strand, negative strand, or 
both – just check or uncheck the appropriate boxes. 
Search Mode.  The "Search Mode" is controlled by the "Select" and "Verify" 
buttons.  The "Select" search mode is standard for all composite searches and 
subsearches, wherein all the oligonucleotides in the sequence, within a given 
search range, are tested.  In the "Verify" search mode all oligos previously found 
by the search are verified whether they still pass all the tests.  This could be 
useful after a search at lower stringency followed by increasing the search 
stringency parameter(s).  Oligos that fail to pass through the various subsearch 
filters are removed, leaving only oligos that passed those two subsequent 
searches. 
When the “Complex Substrate” box is checked, two additional subsearches are 
performed: the "Highly Specific Oligos" subsearch, that eliminates primers with 
excessively stable 3'-ends, and the "Eliminate Frequent Oligos" subsearch, that 
eliminates primers having 3'-ends which occur more frequently in a given 
database of sequences.  If the substrate for your PCR or sequencing reaction is 
not complex (i.e. plasmid) checking this box is not typically necessary. 
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6.1.2.  Composite Search Options 

PCR Primers 
This option generates optimal PCR primer pairs from a nucleic acid template.  
Compatible primer pairs can be selected across the entire active sequence, or 
they can be selected from specific regions on the file by setting search ranges.  
Setting search ranges also speeds up this and other OLIGO searches.  The 
stringency of the search can be controlled using the search stringency settings 
(global) and/or individual parameter settings in the "Parameters" window.  The 
following sub-searches are used to find the PCR primers: 
• Eliminate Ambiguous Bases; by default, selects non-degenerate primers 
• Duplex-free Oligonucleotides; selects primers free of 3’-end and internal dimers 
• Highly Specific Oligonucleotides (3’-end Stability); selects moderately stable 3’-

ends 
• Oligonucleotides with GC Clamp; selects oligos with high internal stability 

regions 
• Oligonucleotides within Selected Tm Limits; selects oligos with certain Tm 

range 
• Hairpin-free Oligonucleotides  
• Eliminate Mono- and Di-Nucleotide Repeats; selects oligos without internal 

repeats 
• Detect Sequence Repeats; selects oligos without other repeats than the above 

option 
• Eliminate Frequent Oligonucleotides; primers with most common in GenBank 

3’-ends (6- or 7-mers) are eliminated 
• Omit High Secondary Structure Regions in the Template; certain sequence 

areas will not be amplified due to high secondary structure 
• Check Primers/Probe Sequence Constraints; no constraints by the default but 

you may ask OLIGO not to choose primers that start with a specific base, for 
example 

• Restrict the number of G Bases; good for further multiplexing and overall non-
dimerization 

• Eliminate False Priming Oligonucleotides 
The sub-search can be extended on other files by the 
• Continue Above Search in Other File(s), thus eliminating primers that could also 

prime from the other sequences, and the “opposite” search could also be 
performed by checking the 

• Consensus Primers 
and selecting the sequences on which the primers must prime as well.  The 
subsearches can also be customized by adding or deleting them from the 
standard settings or changing the search parameters. 
 
The Search for Compatible Primer Pairs proceeds as follows: 
• Search for optimized positive strand primers for PCR 
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• Search for optimized negative strand primers for PCR 
• Match cross-compatible primers as potential primer pairs by checking the 3’-

dimer formation between them and balance their Tm or priming efficiency. 
 
The primer pairs generated in this search have these characteristics (the 
characteristics depends on the chosen search stringency): 
 
• Free of 3' dimers and hairpins 
• With Tms (or priming efficiencies) within restricted ranges 
• Containing GC Clamp (improves annealing efficiency) 
• Have 3'-ends with low false priming homology on the active file and other 

selected files 
• Free of homooligomers and dinucleotide repeats 
• Free of ambiguous bases 
• The primers may have incorporated sequence constraints: specific bases at 

their ends and limited number of guanidine nucleotides. 
• The amplicon is free of strong hairpins 
 

PCR Primers: Compatible with the Forward Primer  
This option searches the negative strand for optimal Reverse Primers that are 
compatible with a pre-selected Forward Primer.  The Forward Primer may be 
selected from the active sequence or entered with the keyboard (see the Edit 
menu). 
Note  You must have selected a Forward Primer for this option to be available. 

When you choose this option with the default subsearches, OLIGO selects 
negative strand primers that are 
• free of dimers with the Forward Primer 
and have the same characteristics as the primers found in the Search for 
Compatible Primer Pairs, listed above. 
At the bottom of the window there is a pull-down menu allowing to choose which 
windows should be automatically displayed after a successful search.  It could be 
the selected oligos, primers pairs/probes or both windows – default “All Results” 
setting.  
When the consensus primer sub-search is selected, OLIGO checks the priming 
efficiency number, not the homology. 

PCR Primers: Compatible with the Reverse Primer 
This option searches the positive strand for optimal Forward Primers that are 
compatible with a pre-selected Reverse Primer.  The Reverse Primer may be 
selected from the active sequence or entered with the keyboard in the Edit menu. 
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The search proceeds analogously to the search for PCR primers compatible with 
the Forward Primer. 

TaqMan Probes & PCR Pairs 
This option searches for and selects optimal PCR primer pairs and compatible 
with them TaqMan probes.  This search proceeds as the "Search for Compatible 
Primer Pairs" except that not two but three oligos are selected.  One of them is 
the TaqMan probe, and as a default, its melting temperature is 5° higher than 
that of the primers.  All three oligonucleotides are compatible with each other, 
that is, they do not form dimers at their 3'-ends.  By default, OLIGO will choose 
the probes that lack G residues at the two last 5’-terminal bases.  This could be 
changed in the Sequence Constraints window of Search Parameters. 
This search may be initiated with an already pre-selected either probe or a primer 
pair, and proceeds as the "Search for PCR Primers". The primers have to be 
compatible with the TaqMan probe, and as a default, their melting temperature is 
about 5° lower than that of the probe.  The newly found primer pairs or a probe 
are stored in memory as sets of three oligos, two primers and the probe. 

Molecular Beacons & PCR Pairs 
This option searches for and selects optimal PCR primer pairs and Molecular 
Beacon probes.  This is essentially the same search as for PCR primer pairs, but 
to the 3’ and 5’- ends of the probe two complementary hexamers, not 
complementary to the probe sequence, are added (default is 
CGTCAC/GTGACG).  The sequence of the complementary tails can be entered 
in the Sequence Constraints window of Search Parameters.  OLIGO searches for 
the probes that the other complementarities within the probes play no or minimal 
role on the overall hairpin loop stability.  Also, the secondary structure of the 
amplicon is minimized, that means, the search removes DNA regions that form 
stronger hairpin loops from consideration. 

Nested Primers 
This option searches PCR primer pairs as described above, and additionally 
selects the nested primer pairs (within the first, larger amplicon).  The nested 
primers are compatible (multiplexed) with the external pair of primers, so there is 
no dimer formation between any of the 4 primers.  The nested primers are 
selected and called “Oligos”, as sometimes these nested oligonucleotides may 
be utilized rather as probes than primers. 

Sequencing Primers 
The "Sequencing Primers" search option searches for and selects optimal 
sequencing primers in either or both strands of the active sequence.  The OLIGO 
program automatically adjusts and/or deactivates search parameters in order to 
emphasize those characteristics most desirable in a sequencing primer. 
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When a standard search for sequencing primers is conducted using the 
programs default settings, the following sub-searches are used to find the 
sequencing primers: 
• Eliminate Ambiguous Bases; by default, selects non-degenerate primers 
• Duplex-free Oligonucleotides; selects primers free of 3’-end and internal dimers 
• Highly Specific Oligonucleotides (3’-end Stability); selects moderately stable 3’-

ends 
• Oligonucleotides with GC Clamp; selects oligos with high internal stability 

regions 
• Oligonucleotides within Selected Tm Limits; selects oligos with certain Tm 

range 
• Hairpin-free Oligonucleotides  
• Eliminate Mono- and Di-Nucleotide Repeats; selects oligos without internal 

repeats 
• Detect Sequence Repeats; selects oligos without other repeats than the above 

option 
• Eliminate False Priming Oligonucleotides 
 
To run the search for sequencing primers from the "Search for Primers and 

Probes" dialog box: 
1. Select Primers and Probes from the Search menu. 
2. Click on the "Sequencing Primers" button. 
3. Click in either or both boxes at the top of the window to select "+ Strand 

Search," "- Strand Search," or both. 
4. Click on the "Search Ranges" button to check your search ranges.  The 

default is to check the entire sequence. 
5. Establish your subsearches by clicking on the subsearch boxes you want 

(optional). 
6. Click on the "Parameters" button to check your search stringency and other 

search parameters (optional). 
For most searches, a high stringency setting is recommended, since the program 
automatically relaxes settings if no oligos are selected at higher settings.  
However, the "Automatically change stringency" box must be checked for OLIGO 
to relax the settings. 
Note  Turn off the "Automatically change stringency" box (Search Parameters 

dialog) when you manually set search parameters.  You may lock certain 
parameters by clicking at the "lock" button.  When the parameter is unlocked, 
it may be changed automatically during the search.  Stringencies are 
automatically changed in a "smart" way, such that a parameter that causes 
most oligos to be removed is relaxed first.  When too many oligos are 
selected OLIGO may automatically increase the search stringency. 

 
 
 



 

 92 

7. Return to the "Search for Primers and Probes" dialog box and click "OK" to 
start the search. 

During the search, the "Search Status" window displays the progress of each 
subsearch in each strand, and the number of oligonucleotides accepted and 
rejected. 
8. At the conclusion of the search, you may check stringency settings using 

"Search-Primers & Probes Search" Data option.  To review the selected 
sequencing primers, click on the "Selected Oligos" button at the bottom of the 
window to call up the "Selected Oligos" window. 

9. After selecting the sequencing primers, you can download them to the 
database or otherwise save the relevant window data as “Results” – a simple 
text file. 

Hybridization Probes 
The "Hybridization Probes" search option searches for and selects optimal 
hybridization probes in either or both strands of the active sequence.  When 
OLIGO conducts the hybridization probe search, it uses the following: 
• Eliminate Ambiguous Bases; by default, selects non-degenerate primers 
• Oligonucleotides with GC Clamp; selects oligos with high internal stability 

regions 
• Oligonucleotides within Selected Tm Limits; selects oligos with certain Tm range 
• Hairpin-free Oligonucleotides  
• Eliminate Mono- and Di-Nucleotide Repeats; selects oligos without internal 

repeats 
• Detect Sequence Repeats; selects oligos without other repeats than the above 

option 
• Eliminate Homologous Probes; those that may anneal to more sites on the 

DNA. 
For consensus probes, it checks the homology, not the priming efficiency. 
The default stability Tm setting is high for the hybridization probe search.  The 
stability maximum is not limited and the stability minimum decreases along with 
the stringency settings. 

SiRNA Probes 
This search finds RNA oligonucleotides that have certain pentamer stability ratios 
between 3’ and 5’-ends and the internal 12-nucleotide segment of the probe, 
essentially as described by Khvorova et al (22), and are relatively hairpin-free.  
This search is available only when the main sequence is RNA.  If you’re working 
on a DNA file, use Change - DNA to RNA option before attempting this search.  
The following sub-searches are used to find the siRNA 19-mers: 
• Eliminate Ambiguous Bases; by default, selects non-degenerate primers 
• Duplex-free Oligonucleotides; selects primers free of significant dimers 
• Highly Specific Oligonucleotides (3’-end Stability); selects moderately stable 3’-

ends 
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• 5’-end Stability 
• siRNA Internal Stability 
• Hairpin-free Oligonucleotides  
• Eliminate Mono- and Di-Nucleotide Repeats; selects oligos without internal 

repeats 
• Detect Sequence Repeats; selects oligos without other repeats than the above 

option 

6.1.3.  Primers/Probes Subsearches 
In the “Subsearches” portion of the "Search for Primers and Probes" window 
there are 17 subsearches that are activated in various combinations in OLIGO's 
composite searches for primers and probes.  By clicking on any subsearch box, 
however, you can add or subtract the subsearch from any composite 
primer/probe search.  The subsearches filter oligonucleotides according to 
search parameter values.  These search parameters are automatically set by the 
OLIGO program to values that depend on the specific search selected and the 
search stringency setting.  These can be overwritten by values you enter. 
Search parameters and search stringency settings are on the "Parameters" 
window called up by clicking on the "Parameters" button. 

6.1.3.1.  Eliminate Ambiguous Bases Subsearch 
This simple search selects sequence regions of lower of equal degeneracy as set 
in the “Parameters” window:   
• Max. Degeneracy 
The default is 1, so that no ambiguous bases at all can be found in a selected 
primer or probe. 

6.1.3.2.  Duplex-free Oligonucleotides Subsearch 
The "Duplex-free Oligonucleotides" subsearch is included in the default 
composite PCR searches and sequencing primers searches.  It is not included in 
the default search for hybridization probes.  
This subsearch checks the designated search ranges of the active sequence for 
duplex-free oligos, applying the following search parameters: 
• Acceptable 3' dimer ⊗G 
• Strongest Dimer Overall ⊗G 
Oligos can be rejected, first, on the basis of an excessively stable 3' dimer 
involving the 3' terminus.  This stability is determined by ⊗G measurement.  
Second, oligos that form stronger internal dimers are rejected. 
This subsearch checks oligonucleotides for for self-dimerizing and, in the case of 
PCR primers, cross-compatibility between positive strand and negative strand 
primers.  "Cross-compatibility" in the OLIGO program refers to the lack of 3' 
dimers between two primers. 
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6.1.3.3.  Highly Specific Oligonucleotides Subsearch 
The "Highly Specific Oligos (3'-end Stability)” subsearch checks the 3'-ends of 
potential primers, selecting only oligos with two 3'-terminal pentamers (six bases) 
that fall within the defined terminal stability ranges.  The default setting selects for 
oligos with moderately unstable 3'-ends, as these oligos will typically be specific - 
not false prime - yet still prime efficiently on the intended target.  This subsearch 
is designed to decrease false priming potential in genomic samples, or samples 
containing unknown sequences.  The search parameter name responsible for 
this subsearch is: 
• 3'-terminal Stability Range 
Oligonucleotides with less stable 3'-ends are more specific because a longer 
stretch of homologous 3' nucleotides are required to false prime than are oligos 
with very stable 3'-ends.  Thus, there are statistically fewer sites where an oligo 
with an less stable 3'-end can false prime.  A very low stability at a primer’s 3’-
end, however, makes it less efficient; the optimal 3’-end pentamer stability is 
approximately -7.5 kcal/mol. 
The current stability ranges set for this parameter are displayed in the "Internal 
Stability" window as grayed area between the two dotted lines. 

6.1.3.4.  5’-end Stability Subsearch 
This subsearch selects oligonucleotides that contain a certain stability range at 
its 5’-end (pentamer), defined by parameter: 
• 5'-terminal Stability Range 
It is automatically included only in the “siRNA Probes” search, but you may add 
this sub-search to any other composite search to better control oligo 
characteristics. 

6.1.3.5.  siRNA Internal Stability Subsearch 
As the name suggests, this subsearch is automatically active only when siRNA 
Probes search is selected.  The parameter that controls this subsearch is called 
• Internal 12-mer Stability (siRNA). 

6.1.3.6.  Oligonucleotides With GC Clamp Subsearch 
The "Oligonucleotides With GC Clamp" subsearch selects for oligonucleotides 
that contain a stable segment of nucleotides anywhere along its length.  Note 
that OLIGO selects also for less stable 3'-ends to improve specificity (oligos with 
3'-terminal GC clamps may not be optimal). 
To form a stronger bond with the intended target and offset the reduction of 
priming efficiency because of an unstable 3'-end, the program selects for stable 
segments over the rest of the oligo. The selection filter for this search is 
controlled by the  
• Min. GC Clamp Stability 
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 setting in the "Search Parameters" window. 

6.1.3.7.  Oligonucleotides Within Selected Tm Limits Subsearch 
This subsearch selects oligonucleotides with Tms that fall within the default 
values set by OLIGO or values you have entered in the "Search Parameters" 
window: 
• Primer Tm Range. 
OLIGO settings are based on the premise that optimal PCR primers should have 
moderate Tms and optimal sequencing primers and hybridization probes should 
have high Tms. 
The program sets the following default stability values for the various 
primer/probe searches when the search stringency is set to "Very high." 
 
PCR Primer Pairs, 
TaqMan & Beacons Searches 

Between the 40th percentile to the 75th 
percentile of the range between the lowest and 
the highest Tm oligos 

Sequencing Primer Searches Between the 50th percentile and the 100th 
percentile 

Hybridization Probes Between the 90th percentile and the 100th 
percentile 

 
When the search stringency setting is reduced, these default ranges are 
progressively broadened.  The actual upper and lower stability (Tm) thresholds 
are displayed as a grayish block between dotted lines on the Tm window graph.  

6.1.3.8.  Hairpin-free Oligonucleotides Subsearch 
The "Hairpin-free Oligonucleotides" subsearch selects hairpin-free 
oligonucleotides from the active sequence.  It is active in the default configuration 
for all the primer/probe automated searches.   
This subsearch is controlled by the  
• Min. Acceptable Loop ⊗G 
setting in the "More Parameters" window. 

6.1.3.9.  Eliminate Mono- and Di-Nucleotide Repeats Subsearch 
This subsearch checks for oligos with strings of the same nucleotide (AAAAA, for 
example), or strings of dinucleotide repeats (CGCGCGCG, for example) and 
eliminates these from the selection process.  Oligos with nucleotide repeats may 
not align correctly on the intended target, causing subsequent deletions or 
insertions.  Also, such sequences frequently occur, and thus, are more likely to 
false prime.  There are two search parameters controlling this subsearch: 
• Max # of Mono-Nucleotide Repeats 
• Max # of Di-Nucleotide Repeats 
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Oligonucleotides with more repeats than these parameters are eliminated. 

6.1.3.10.  Detect Sequence Repeats Subsearch 
This subsearch checks for any repetitive strings, longer than 2 nt.  Longer 
repetitive stretches contribute in false priming.  This subsearch is focusing on 
relatively short repeats that false priming sites search may miss.  The search 
parameter is called 
• Max Length of Repeated Sequence, 
and the default is 5 nt. 

6.1.3.11.  Eliminate Frequent Oligonucleotides Subsearch 
This subsearch eliminates oligonucleotides having too common 3'-ends (the last 
6, 7 or 8 nucleotides) which occur in a subset of GenBank for the species you are 
working on. The user-selected frequency tables (located in the Frequencies 
folder) contain normalized frequencies of either 6- (.FR6) or 7-mers (.FR7) of 
GenBank sequences.  The header of each frequency file describes in detail how 
each table was created.  The sequence frequency is a relative number and does 
not represent absolute number of hits in a given database.  It is normalized such 
that frequency of 1000 is the average frequency for a given 6- or 7-mer.  
Sequences below this number are less frequent.  The actual formula is the 
following: # of Hits x 1000 x 4096 (=Table size) / number of analyzed 6-mers in a 
database.  The search parameter controlling this function called 
• Frequency Threshold 
Oligos with 3’-ends above this threshold are rejected.  By choosing oligos of 
which 3'-ends are infrequent in a given database you are decreasing chances of 
selecting a primer that primes in several sites on a complex substrate, such as 
genomic DNA, or in other words, you are decreasing chances of unspecific PCR. 
You may create your own frequency tables, including .FR8 (for 8-mers) files by 
using Sequence Frequency Calculator, available with appropriate instructions 
from the http://oligo.net/downloads.html page. 

6.1.3.12.  Omit High Secondary Structure Regions in the Template 
Subsearch 

This subsearch checks for hairpins the entire potential PCR template and rejects 
those sequence regions from amplification that contain strong secondary 
structure.  There are two search parameters controlling this subsearch: 
• Template Loop ⊗G Threshold   • Template Loop Window Size 
The hairpin loops are detected only within the specified sequence length, called 
here the Window Size.  These parameters are in the "More Parameters" window. 

6.1.3.13.  Check Primers/Probe Sequence Constraints 
This new option allows for selecting primers that contain or do not contain certain 
bases at their ends.  For example, in the TaqMan probe search the default 
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sequence starts with “HH” at the 5’-end, that means – no “G”s are allowed.  You 
can add or change the constraints in the Parameters – Sequence Constraints 
window.  There are 3 options (oligos) to use – you may place the constraints on 
the 3’ and/or 5’ ends of: 
• Forward Primer 
• Reverse Primer 
• TaqMan Probe 
The search will find the primers with pre-defined sequences, and not add new 
template-unmatching sequences to them. 
Note: the 4th sequence that can be controlled in the Sequence Constraints 

window is 
• Molecular Beacon Probe 
but the sequence typed there is artificial, and will not match the template (main 
sequence). 

6.1.3.14.  Restrict the Number of G Bases Subsearch 
This subsearch selects oligonucleotides with limited number of guanosine 
nucleotides.  Primers and probes will not have more G bases than the value 
specified in Parameters window by: 
• Max. # of G Bases in a Primer/Probe 
This is very important if the selected oligos are going to be multiplexed – it 
significantly improves chances of finding compatible (not dimer-forming) oligos.  
Another reason to avoid several G bases in your primer is that this nucleotide 
gives usually most problems in synthesis, therefore increasing chances for lower 
quality oligos. 

6.1.3.15.  Eliminate False Priming Oligonucleotides and Eliminate 
Homologous Probes Subsearches 

The "Eliminate False Priming Oligonucleotides" subsearch selects 
oligonucleotides that have no false priming sites on the active sequence.  This 
subsearch uses a proprietary algorithm that measures the stability of a false 
priming site regardless of mismatches.  The stability of a false priming site is 
expressed in a "priming efficiency" number. 
The priming efficiency is calculated with a complex algorithm that considers the 
⊗G of duplexes, mismatches, and/or bulge loop size, and the distance of these 
elements from the 3' end.  Priming is more likely when this value is above 200 
points. 
The selection filter for this subsearch is controlled by the  
• Max. Acceptable False Priming Efficiency 
setting in the Parameters window and “Perform the False Priming Sites & 
Homology Search”  
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• Within the search ranges only 
• The entire sequence 
in the Ranges window.  
The Eliminate Homologous Probes subsearch is virtually the same but instead of 
priming efficiency, a simple homology is checked.  This subsearch is active when 
the search for Hybridization Probes is chosen. 
 

6.1.3.16.  Continue Above Search In Other File(s) Subsearch 
This subsearch continues false priming sites search in other files, specified by 
the user.  It uses the same algorithm as the "Eliminate False Priming 
Oligonucleotides" subsearch, except that it searches in files other than the active 
sequence file.  This may be helpful if you want to find a primer that distinguishes 
closely related sequences. 
Click on the subsearch box to call up the "Selected Files" dialog box.  The dialog 
box lists the directory of sequence files stored in the OLIGO folder and provides 
access to other drives and folders where you may have your sequence files. 
To add files to the list to search: 
1. Click on the “Add” button in the Select Files window. 
2. Click on the file name you want to add to the search. You may need to 

change the folder first. 
3. Click on the "Add" button. 
 You can add as many files as you want to check.  The files are going to be 

checked sequentially for false priming sites. 
4. When you are finished selecting files, click the "Done" button to return to the 

"Search for Primers and Probes" dialog box. 
To remove files from the list: 
1. Click on the file name you want to remove from the list. 
2. Click on the "Remove" button. 
Note  If you are conducting searches for PCR and sequencing primers that are to 

be used in genomic or other complex DNA samples, this subsearch has a 
special "FREQSEQ" folder (frequently occurring or repetitive sequences in 
various organisms), where files may be called up to filter out oligos in the 
active file containing repetitive sequence. 

Click on the "FREQSEQ" folder to call up the individual organism files. 
The "FREQSEQ" folder includes sequence files for human DNA, Drosophila, 
mouse, rat, wheat, and yeast.  If you are working with other organisms, you can 
create your own frequent or repetitive sequence file(s) by extracting them from 
GenBank. 
Once the files are selected and the search is started, OLIGO rejects any 
oligonucleotide sequence that would false prime on any target in a repetitive 
sequence file. 
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This subsearch is controlled by the same search parameters as the Eliminate 
False Priming Oligonucleotides subsearch. 

6.1.3.17.  Consensus Primers (Probes) 
When you click in this box you may select other file(s), homologous to the active 
sequence, to find primers common to all files.  Consensus primers are those 
which prime at least with the 
• Min. Consensus Priming Efficiency or 
• Min. Consensus Homology (probes) 
a variables set in the Parameters window.  Clicking this check box calls up the 
"Select Files" dialog from which you may select homologous sequence files for 
consensus primer design in an analogous way as it’s in the Continue Above 
Search In Other File(s) subsearch.  With this method unique, non-degenerate 
primers or probes will be found that prime or hybridize to all selected sequences.  
These primers (probes) may have mismatches, but their P.E. or homology to the 
other selected sequences will be above or equal to those two parameters listed 
above. 

6.1.4.  Search for Primers and Probes - Ranges 
The search ranges window allows you to limit searches to specific segments of 
the active sequence, as opposed to the entire active sequence (default).  PCR 
product length limits may also be set in this window, in addition to the positive 
and negative strand search range limits for primer and probe selection. 
The setting of search ranges are most frequently used to shorten search times 
and/or when a researcher has limited targets to which he can design primers.  
Setting search ranges can also be used to limit the total number of primer pairs 
selected in a given PCR primer search since the computer's memory limits the 
total number of selected primer pairs. 
This window also allows to choose primers/probes/PCR products every x bases, 
greatly reducing search times when you want to uniformly cover a large 
sequence with primers or probes.  When the sequence has features listed and 
one of them is a list of all the exons, you may narrow your searches for probes or 
primers to only the exon sequences. 
All the searches for false priming sites may be broadened to the entire sequence 
using this window.  Full description of the Search Ranges dialog can be found in 
the Change, section 8.3. 
 

6.1.5.  Search for Primers and Probes - Parameters 
The search parameters are the numerical thresholds and windows that control 
the selection of the filters used in OLIGO searches.  In this dialog box, most 
parameters may be adjusted from default values.  In addition, six discrete 
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settings are available in the dialog box for global control of search stringency.  
With this window you may also define the scoring system for primers & probes. 
For more information on "Parameters," including detailed descriptions of the 
functions in the "Search Parameters" window, see Chapter 8.4. 

6.2.  Search - for Sequence String 
The Search for Sequence String command searches the positive or negative 
strand of the active sequence for a sequence string of nucleotides that you 
select. 
The position data of the strings can be found in the Selected Bases window and 
are represented graphically in the Sequence window as a yellow bar.  A search 
in the positive strand marks the 5'-terminal bases of any sequence strings found, 
and a search in the negative strand marks the 3'-terminal bases.   

 
Figure 6.2.  The Search in the [+] Strand dialog box. 

Sequence strings that include ambiguous bases can be used in this search 
option.  A search for AGN, for example, marks the positions of every AGA, AGC, 
AGG, and AGT string in the active sequence. 
When you select Search for Sequence String, choose from the submenu a 
search in either the positive or negative strand. 
After selecting the positive strand, the "String Search in [+] Strand" dialog box 
appears.  After selecting the negative strand, the "String Search in [-] Strand" 
dialog box appears.   
You may also define any number of mismatches in the string of interest by typing 
any number greater than 0 (default) in the “Allow n mismatches” box. 
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6.3.  Search - for Restriction Sites 
 
The Restriction Sites function searches a nucleic acid active sequence for 
restriction enzyme recognition sites and displays the resulting data in a table of 
positions and fragment sizes, and/or on a position map.  The nucleic acid 
sequence can be treated as circular or linear DNA.  When circular, the first and 
last fragments on the active sequence from a given enzyme cut are treated as 
one. 
When you access this option, the "Search for Restriction Sites" dialog box 
appears where you set search range, circular/linear, and the desired Enzyme 
Database. 

 

Figure 6.3.  The Search for Restriction Enzymes dialog box.  The Start and End search positions 
are dimmed when the "Sequence" button is ON. 

If you would like to update the restriction enzyme database, you may download 
OLIGO-compatible REBASE files from the New England Biolabs site 
(http://rebase.neb.com/) or search Google for “Rebase” and choose format 
similar to the one given with the OLIGO package (Type II formats are OK).  The 
most common enzymes file used by OLIGO is NICE6&UP.ENZ.  In this file only 
non-degenerate sites larger than 5nt are listed.  You may open it with any word 
processor and change the list.  The format is quite simple and it is easy to follow. 

Search 
To set the search: 
1. Click on the "Entire" button or the "Portion" button.   
2. If you select "Portion," enter the start and end position for the search range. 
3. If your sequence is linear, click on the "linear" button.  If it is circular, click on 

"circular." 

wr
Text
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Circular or Linear 
The "Circular/Linear" button option selects for the correct calculation of the 
restriction fragment sizes upstream of the first restriction cut and downstream of 
the last cut on the active sequence.  If "circular" is selected, these distal 
fragments are considered as one contiguous fragment in the fragment table.  If 
"linear" is selected, they are considered two separate fragments. 
After clicking on the Search button the search process starts and the results are 
displayed on the Analyze- Restriction Enzyme Sites window, see Chapter 5 for 
the details. 

6.4.  Search - Restriction Sites in Protein 
This function searches the amino acid sequence currently displayed on the 
Melting Temperature window for potential restriction sites.  The protein sequence 
is reverse translated using the degenerate method yielding all possible oligo 
sequence combinations before the sequence is searched.  The search 
parameters and output are the same as for the restriction sites search. 
OLIGO has 79 restriction enzymes that can be selected for the search.  All are 
six-base cutters or longer, and none have degenerate bases.  In the table 
displayed after the search, under the "Site" field, protein sites that are recognized 
during the search are listed.  OLIGO uses its own symbols for various 
degenerate amino acids, see Appendix E - Degenerate Amino Acid Symbols.  
Standard amino acid symbols are listed in Appendix E - Non-degenerate Amino 
Acid Symbols. 

6.5.  Search - Sequence Files 
This function lets you choose sequence files for automatic (batch) processing.  
When you start a search for Primers & Probes those files will be searched and 
the results stored in a file specified by you (default name is BatchResults.txt).  
There is no separate Analysis window display to show the search results from 
multiple files. 
The search protocol starts from displaying the empty Batch Processing window.  
First, you’d need to click the Select Files button and select the sequence files, 
see Fig. 6.5.1.  When you’re done with selection you may save the set of files 
under its own name, and use this set in subsequent batch searches.  The dialog 
box allows for the removal of files from a given set and also removal of the entire 
sets. 



 103 

 
Figure 6.5.1.  Select Files for batch searches window. 

After accepting the sequence files by clicking the “OK” button, you will get back 
the Batch Processing window, as shown on Fig. 6.5.2: 

  
Figure 6.5.2.  Batch Processing window. 

At this point you may need to select the search method (PCR primers, 
sequencing primers, probes etc.), change the search parameters and search 
ranges in the same fashion as doing standard non-batch searches.  When this is 
done, click the Search button. The last thing before the actual search starts is to 
name the search results file form this dialog: 
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Figure 6.5.3.  Save Search Results window. 

This dialog also allows for saving the search results in a simple or in a full 
analysis formats.  By pressing the “Save” button the batch search process starts.  
Oligo automatically saves the “BatchResults.log” (same name as the search 
results .txt file, only a different extension) – a text file containing information when 
the proces started and ended and how many results were saved. 
The batch processing does not open any results tables or analyze windows or 
save any files other than that described above.  You need to use your favorite 
word processor to open those search results files. 

6.6.  Search – Show Selected Bases 
It opens a table that displays all selected bases. 

  
Figure 6.6.  Selected Bases window. 

The Loops column shows all nucleotide positions that form stable loops in the 
template (marked dark red on the Sequence window), the Stems column display 
positions of weak stems in oligos of Current Oligo size (marked light red on the 
Sequence window), the Palindromes column show all nucleotide positions 
involved in palindromes not shorter than 6 bp.  The last column, Strings, displays 
only the first nucleotide position of the searched string.  By clicking on any 
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number on this table you move the Current Oligo to this particular position 
number (watch the Sequence window). 

6.7.  Search - Primers and Probes Search Data 
The Primers and Probes Search Data window shows the search settings and raw 
data for the most recent Primers & Probes search conducted.  This data window 
reports all subsearches that took place and the Search Parameters settings that 
were used.  Along with the list of subsearches it reports the number of accepted 
oligos that passed a given subsearch routine.  This window is especially useful 
when searching for consensus primers or probes: it is easy to spot non-
homologous sequence files and eliminate them from consideration in the next 
search (see Fig. 6.7).  This window does not report the search parameters that 
were not used in the last search, despite that they were displayed in the 
Parameters window. 

 
Figure 6.7.  The Primers and Probes Search Data window.  A search for consensus primers was 
conducted.  From this table, you can see that the subsearch for consensus probes removed 172 
primers, and it is easy to spot that “Chicken eIF- 4E.seq” was the least compatible sequence, that 
caused removal of 159 primers (only 6 forward and reverse primers were found). 
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7.  The OLIGO Select Menu 

From the Select menu you can select Forward and Reverse Primers, Upper & 
Lower Oligos, and a New Current Oligo Position. 

 
Figure 7.0.  The OLIGO Select menu (Mac).  In Windows the same items are displayed, but the 
short-cut keys are different: 

7.1.  Select - Forward Primer 
The Forward Primer command from the Select menu selects the positive strand 
Current Oligo as the Forward Primer.  Once selected, the Forward Primer is 
displayed in red on the "Sequence" window, two lines above the Current Oligo 
and followed by a "primer extension" triangles pointing toward the 3'-end of the 
sequence.  The Forward Primer is displayed in upper case letters, except for 
nucleotides mismatched to the active sequence, which are displayed in lower 
case letters. 
You can also select the Forward Primer by clicking on the square icon in the 
middle info box of the Sequence window, or enter and/or modify it via the 
keyboard (see the Edit menu).  The short cut key: Mac: <"U>, Win: <Ctrl-U>. 

7.2.  Select - Reverse Primer 
The Reverse Primer command from the Select menu selects the negative strand 
Current Oligo as the Reverse Primer.  Once selected, the Reverse Primer is 
displayed in blue on the "Melting Temperature" window, two lines below the 
Current Oligo and followed by a "primer extension" triangles pointing toward the 
5'-end of the sequence.  The Reverse Primer is displayed in upper case letters, 
except for nucleotides mismatched to the active sequence, which are displayed 
in lower case letters. 
You can also select the Reverse Primer with the short cut key: Mac: <"L>, Win: 
<Ctrl-L>. 
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7.3.  Select – Upper Oligo 
The Upper Oligo command from the Select menu selects the positive strand 
Current Oligo as the Upper Oligo.  Once selected, the Upper Oligo is displayed in 
light red on the Sequence window, one line above the Current Oligo and followed 
by a "primer extension" triangles pointing toward the 3'-end of the sequence.  
The Upper Oligo is displayed in upper case letters, except for nucleotides 
mismatched to the active sequence, which are displayed in lower case letters. 
You can also select the Upper Oligo by clicking on the square icon in the middle 
info box of the Sequence window, or enter and/or modify it via the keyboard (see 
the Edit menu).  The short cut key: Mac: <Shift"U>, Win: <Shift-Ctrl-U>. 

7.4.  Select – Lower Oligo 
The Lower Oligo command from the Select menu selects the negative strand 
Current Oligo as the Lower Oligo.  Once selected, the Lower Oligo is displayed in 
light blue on the Sequence window, one line below the Current Oligo and 
followed by a "primer extension" triangles pointing toward the 5'-end of the 
sequence.  The Reverse Primer is displayed in upper case letters, except for 
nucleotides mismatched to the active sequence, which are displayed in lower 
case letters. 
You can also select the Lower Oligo by clicking on the square icon in the middle 
info box of the Sequence window, or enter and/or modify it via the keyboard (see 
the Edit menu).  The short cut key: Mac: <Shift"L>, Win: <Shift-Ctrl-L>. 

7.5.  Select - New Current Oligo Position  
The New Current Oligo Position command calls up the "Current Oligo Position" 
dialog box where you can choose a new Current Oligo by entering a new 5' 
position number oligo (upper strand).  After entering a new position, click "OK." 
The Current Oligo position also can be changed by using one of the following 
methods: 
1.  Move the scroll bar on the bottom of Sequence, melting Temperature, Internal 
Stability, Frequencies, and Open Reading Frames windows to position the graph 
approximately where you want to move in the sequence.  Using the mouse, point 
the cursor to the position you want and click.  OLIGO automatically shifts the 
graph on both windows and displays updated information.  Besides changing 
positions with the mouse, the following keys on your keyboard are active in the 
mentioned above windows: 
• Right Arrow move the Current Oligo one position forward 
• Left Arrow  move the Current Oligo one position backward 
• Up Arrow  move the Current Oligo 3 positions forward 
• Down Arrow move the Current Oligo 3 positions backward 
• Page Up  move the Current Oligo one screen forward 
• Page Down move the Current Oligo one screen backward 



 

 110 

•  Use  short cut key: Mac: <"K>, Win: <Ctrl-K>. 
•  Click on any row in the Analyze- Selected Oligonucleotides table. 
•  Click on any row in the Search- Selected Bases table. 
When browsing the active sequence for a New Current Oligo Position, it is helpful 
to first call up Current Oligo from the Analyze-Key Info menu, or relevant analysis 
windows.   

 
Figure 7.5.  The Current Oligo Position window. 
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8.  The OLIGO Change Menu 

The Change menu is used to change various parameters in the OLIGO program.  
These include changing the oligonucleotide length to be searched or analyzed, 
DNA active sequences to RNA and vice versa, search ranges and parameters, 
parameters used to calculate Tm and ⊗G (non-search parameters), and 
parameters involving OLIGO displays. 

 
Figure 8.0.  The OLIGO Change menu (Mac).  In the Windows version the short cut <"D> key is 
replaced by <Ctrl-D>. 

8.1.  Change - Current Oligo Length 

 
Figure 8.1.  The Change-Current Oligo Length dialog box. 

The Current Oligo Length command allows you to change the Current Oligo 
length for analysis in the program.  To change it, enter a new oligonucleotide 
length within the allowable range of 2 to 5000 (if the file size permits) and click 
"OK."  The Current Oligo is displayed graphically in the Sequence, Melting 
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Temperature, Frequencies, Open Reading Frames and Internal Stability 
windows.  The Current Oligo length is listed in most Analysis windows. 
If an oligonucleotide is saved as the Forward or Reverse Primer or Upper or 
Lower Oligo, their lengths are not changed following the change in the Current 
Oligo length setting.  Therefore, oligonucleotides of different lengths can be 
searched for and analyzed. 
Note:  Several analysis features are inactive when the oligo length is set above 

200 bases. 

8.2.  Change - DNA to RNA 
The DNA to RNA command changes the active sequence from a DNA sequence 
to RNA and vice versa.  All calculations, including molecular weight, melting 
temperatures, and absorbtion values are changed accordingly.  When the 
sequence is RNA, G-U pairings are displayed.   
Note:  This option changes the active sequence only in memory.  There is no 

effect on the sequence file unless it is saved after the change using the Save 
Sequence command from the File menu. 

DNA/RNA hybrid Tms are calculated either as DNA/DNA or RNA/RNA in the 
"Composition & Tm" window. 

8.3.  Change - Search Ranges 
Using the "Search Ranges" dialog box, you can set the range of searches to be 
run on the active sequence and the length of PCR products to be selected for in 
the various PCR searches.  In the default configuration, searches are conducted 
over the entire length of the active sequence.  However, you can set any 
beginning and/or ending nucleotide position, in either or both strands, to limit the 
searches.  Note that where a search is actually conducted (positive strand, 
negative strand, or both) it is controlled by the check boxes at the top of the 
Search for Primers and Probes window.  The PCR product range setting limits 
the primer pairs selected to those that generate the correct product size.  The 
default is 150 bp to the end of the active sequence, but shorter product sizes can 
be set.  The minimum is the minimum Forward Primer length plus the minimum 
Reverse Primer length plus 1. 
The PCR product length may not always be compatible with search range.  In 
such cases, the search range is the primary selection criteria.  For example, if the 
positive strand primer search range is 1-100, the negative strand is 200-300, and 
PCR product length is 150-1,000, then possible product lengths are limited to 
150-300 nt. 
Note:  Narrowing search ranges can speed up searches considerably, and 

eliminate unwanted data from search results.  Also, low stringency settings 
typically yield many selected primer pairs.  This may make further analysis 
difficult. 
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Figure 8.3.  The Change - Search Ranges window. 

When a feature is marked (use the “Check Region(s)” button to mark it) you will 
be able to search for oligos only in the marked feature or features.  In such case 
the search ranges are dimmed, as seen on Fig. 8.3. 
The PCR product length fields establish the PCR product length by entering the 
upper and lower size limits of the desired product.  Make sure that your search 
ranges on the positive and negative strand can accommodate the PCR Product 
Length you want. 
Note:  If you search for primers compatible with the Forward Primer whose 

position is close to the 3'-end, the search may not find any compatible 
primers, even if the search range is the whole active sequence. 

The minimum allowable length is the combined lengths of the smallest Forward 
and Reverse Primers plus 1. 
This window lets you choose sequencing primers and hybridization probes that 
would be spread out throughout the search ranges in one every selected number 
of nucleotides. 
You may also choose to search only for non-overlapping primers and probes.  In 
this case all overlapping primers with lower scores than the best primer are 
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removed, despite that saved primers in other sequence regions would have lower 
scores than the removed ones. 
Similarly, when running a search for PCR pairs, you may restrict primer sets that 
would make multiple products in one sequence region from showing up. 
Another option is to cover the entire search area with either overlapping products 
or non-overlapping products with defined maximum size of gaps. 
When all 3 boxes are checked, “No overlapping primers”, “No multiple products” 
and “Cover the entire search area with: Overlapping products”, expect only small 
regions duplicated with no primers that would overlap. 
The last feature of this dialog concerns with how the searches for false priming 
sites or homology should be performed.  You may choose either to search for the 
sites in the entire sequence, regardless of the search ranges, or search only 
within the search ranges. 

Defaults and other buttons 
The Defaults button re-sets all the parameters displayed in this window to default 
settings.  Clicking the OK button accepts the changes, and Cancel does not - 
both buttons close this window. 

8.4.  Change - Search Parameters 
The Search Parameters windows are accessed by clicking on the "Parameters" 
button in the "Search for Primers and Probes" window or choosing the “Search 
Parameters…” item from the Change menu.   
The Search Parameters are laid out in four separate windows.  The first one 
provides access to global stringency settings and to some of the subsearch 
defaults.  The second window contains the remaining subsearch parameters and 
the third Sequence Constraints.  From the 4th window you may change the primer 
scoring system, as this OLIGO version assigns a one number score to each 
primer or probe that is selected.  The score makes the primer selection easier, 
especially if there are many oligos to choose from - instead of looking at several 
parameters individually you may sort the results by this number and see the top 
scoring oligos instantly.   
Note:  certain applications require different scoring systems as some parameters 

are more important than others, used for standard sequencing purposes, for 
example.  You may rely on this scoring system only if searching for “generic” 
primers or probes.  If your oligos are to be used in specialized assays where 
the other factors count more than in standard settings, then you’d either don’t 
need to pay attention to the actual scores or re-define the scoring system.  
This is the only reason why this feature was not implemented in earlier 
OLIGO versions. 

The Parameters settings are essential because the search outcome depends on 
them.  It is therefore very important to fully understand the meaning of each 
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default value before you attempt to improve it.  A powerful method of changing 
the search outcome is to change the scoring system.  Another simple way to 
influence the search results is to remove or add non-default subsearches in the 
Search for Primers and Probes windows.   
At the bottom of the window you will find the currently set Search Method, the 
parameters are for.  This is important as the default parameters are different for 
different types of searches.  Changing the search method in the Search for 
Primers & Probes window causes re-setting the parameters to their default 
values. 

8.4.1.  Search Parameters - Global Settings 
The Search Parameters include global and individual search stringency settings, 
sequence constraints and scoring windows.  The Search Parameters option can 
be accessed from the Change menu or from the Search menu via the Search for 
Primers and Probes window. 

 
Figure 8.4.1.  The Search Parameters: global and individual parameters settings. 

8.4.1.1.  Search Stringency  
The Search Stringency option provides you with the ability to change globally all 
search parameters in discrete increments preset in the OLIGO program using a 
single operation.  Using this option, you can make "expert" decisions about your 
oligonucleotide selection process without knowing the optimal setting of the 
various search parameters. 
OLIGO has pre-determined settings for the six search stringency options for each 
search type:  the search for PCR primers, including search for TaqMan probes 
and molecular beacons, for sequencing primers, hybridization and siRNA probes.  
They are: Very High, High, Moderate, Fair, Low, Very Low.  Each stringency has 



 117 

its own parameters settings.  Primers and probes are useful even when selected 
at the lowest stringency setting. 
Note:  A search stringency you enter may be automatically lowered by OLIGO if 

no oligonucleotides (or primer pairs) are found that meet or exceed the 
search stringency when the "Automatically change stringency" box is 
checked.  Your search stringency setting is then gradually reduced by the 
program. 

8.4.1.2.  Automatically Change Stringency 
The "Automatically Change Stringency" option - when active - enables the 
OLIGO program to automatically reduce the selected search stringency setting to 
the next lower stringency level if no primers, primer pairs, or probes pass through 
all the selection filters of the search.  Initially, OLIGO changes only those 
parameters which eliminate most potential primers.  When primers are found this 
way the stringency setting is called "Customized". 
If no primers are found, the message "No matches found" appears.  At this time it 
is a good idea to review the Primers & Probes Search Data (Search menu) to 
determine what sub-search eliminated most oligos, and then perform one of the 
following: 
•  Broaden the search range settings 
•  Select a different region of the active sequence to search 
•  Deactivate one or more of the subsearches 
•  Change specific search parameters that eliminate most oligos. 
The Automatically Change Stringency option can be disabled for any individual 
search parameter by using the search parameter locking feature.  Clicking the 
lock icon adjacent to a given search parameter, keeps that value unchanged 
throughout the search.  This gives you more control over the search process in 
oligonucleotide selection. 
The Automatically Change Stringency option ensures maximum optimization of 
oligos or oligo pairs for a given set of search ranges on a given active sequence.  
When this option is active, the program proceeds until primers or probes are 
selected at the highest possible stringency for a given search condition. 

8.4.1.3.  Inverse PCR  
When the Inverse PCR box is checked, OLIGO selects primers in the opposite 
direction - Forward Primers downstream, Reverse Primers upstream - permitting 
PCR searches to be useful for circular templates.  The PCR window displays the 
inverse PCR product and predicts experimental conditions. 

8.4.1.4.  Penalize for Tm / P.E. Discrepancy 
This changes the scoring for primer pairs selection.  OLIGO adjusts the primer 
/probe sizes automatically, within the selected ranges, and this re-sizing 
minimizes the Tm or priming efficiency discrepancies, whichever button is 
selected (is colored and has a black dot insight).  
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8.4.1.5.  Maximum Number of Selected Primer Pairs 
This field controls the max. number of selected PCR primer pairs.  If the search 
finds more pairs it stops and asks whether to proceed with further search.  
Usually 3000 pairs (default) is sufficient. 

8.4.1.6.  Defaults Button 
This button changes all customized parameters to default settings for a given 
search stringency.   
Note:  When you change any given global stringency, all parameter settings for 

this stringency will become default (will be reset). 

8.4.1.7.  Cancel and OK Buttons 
These buttons either cancel all your changes or accept the changes and close 
the Search Parameters window.   

8.4.2.  Search Parameters - Search Parameters Options 
In addition to the global search stringency options this window gives access to 
control the parameters described below.  In all the windows you will find common 
objects that indicate parameters applicability.  If a small blue circle  is displayed 
by the side of a given parameter it means that this parameter is going to be used 
by the currently selected in the Search for Primers and Probes window search 
type.  The opened lock  means that a given parameter may be changed 
during the automatic stringency correction, and the closed lock  parameter will 
not be changed.  The status of the dark locks may be changed by clicking at 
them while the gray locks  indicate unchangeable parameters.  

8.4.2.1.  Oligonucleotide Length 
Using this option, you may select oligos from 5 to 255 nt - long for searches.  The 
length is not an absolute number but has the ranges.  For example, by choosing 
21 ± 3 nt OLIGO will search for primers 18-24 nt long.  Oligo automatically 
selects the length, however, when you choose a certain length you may have 
less choice of oligos of certain Tm.  Chart D1 (p. 174) may help you choose the 
right Tm/oligo length, depending on what GC% content you are looking for. 

8.4.2.2.  Acceptable 3' Dimer ⊗G 
The "Acceptable 3' Dimer ⊗G" option sets the stringency of the filter that selects 
or rejects oligos or oligo pairs on the basis of the stability of any 3' terminal dimer 
(hybridized to itself or to another oligo).  It controlls the “Duplex-free 
Oligonucleotides” sub-search. 
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8.4.2.3.  Strongest Dimer Overall ⊗G 
This option sets the stringency of a dimer filter that accepts or rejects oligos 
strictly on the basis of the strongest dimer ⊗G.  The dimer does not need to start 
at the 3'-terminus position.  It controlls the “Duplex-free Oligonucleotides” sub-
search. 

8.4.2.4.  3'-terminal Stability Range 
This option controls the 3’-end stability of primers.  The ⊗G value is for the last 
five nucleotides in the primer.  Oligos outside the displayed stability limits will be 
rejected by the “Highly Specific Oligonucleotides” sub-search. 

8.4.2.5.  5'-terminal Stability Range 
This option controls the 5’-end stability of siRNA probes.  The ⊗G value is for the 
first five nucleotides in the siRNA probe.  Oligos outside the displayed stability 
limits will be rejected by the “5’-end Stability” sub-search. 

8.4.2.6.  Internal 12-mer Stability (siRNA) 
This option controls the internal stability of siRNA probes.  The ⊗G value is for 
the twelve internal nucleotides, pos. 3 to 14, in the siRNA 19-mer probe.  Oligos 
outside the displayed stability limits will be rejected by the “siRNA Internal 
Stability” sub-search. 

8.4.2.7.  GC Clamp Stability 
The "GC Clamp Stability" search parameter sets the minimum stability of a GC 
clamp that must reside along each selected oligo's length, excepting the 3'-end.  
The free energy of pentamers is calculated across the entire oligo.  Used by the 
“Oligonucleotides with GC clamp” sub-search. 
This feature counterbalances the effects of unstable 3'-ends.  The net effect of 
the "3'-terminal Stability Range" and the "GC Clamp Stability" search parameters 
is oligonucleotides that are specific, yet prime efficiently on their intended targets. 

8.4.2.8.  Primer Tm Range 
OLIGO limits the primers selection to this melting temperature range.  Used by 
the “Oligonucleotides within Selected Tm Limits” sub-search. Oligo automatically 
selects the Tm range, however, when you choose a certain oligo length you may 
have less choice of oligos of certain defined Tm.  Chart D1 (p. 174) may help you 
choose the right Tm/oligo length, depending on what GC% content you are 
looking for. 
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8.4.2.9.  Tm of Probe - Tm of Primer 
Sets the acceptable temperature difference between the PCR primers and the 
TaqMan probe.  Used by the “Oligonucleotides within Selected Tm Limits” sub-
search. 

8.4.2.9.  Tm of Loop - Tm of Probe 
Sets the acceptable temperature difference between the molecular beacon 
probe’s Tm and a hairpin loop Tm in it.  Used by the “Oligonucleotides within 
Selected Tm Limits” sub-search. 

8.4.2.10.  Minimum Acceptable Loop ⊗G 
OLIGO eliminates oligonucleotides with hairpin loop stability values greater than 
or equal to this value.  Used by the “Hairpin-free Oligonucleotides” sub-search.   
Those regions are displayed on the Sequence window as bright red lines and 
listed in Selected Bases window (Search menu) in row B. 

8.4.2.11.  Max Acceptable False Priming Efficiency 
OLIGO eliminates primers that have a priming efficiency value (P.E. #) at the 
potential false priming site that is greater than or equal to the selected priming 
efficiency value.  Used by the “Elimiante False Priming Oligonucleotides” sub-
search. 
The priming efficiency value is calculated with a complex algorithm that considers 
the ⊗G of duplexes, mismatches, bulge loop sizes, and the distance of these 
elements from the 3'-end.  Priming is more likely when this value is over 220 
points. 

8.4.2.12.  Min Consensus Priming Efficiency 
When the "Consensus Primers" box is checked, OLIGO will search for primers 
common to all selected files.  Primers with a higher or equal priming efficiency 
number than this parameter will be accepted as consensus primers.  Used by the 
“Consensus Primers” sub-search. 

8.4.2.13.  Max Acceptable Homology 
OLIGO eliminates probes that have a homology value at the potential false 
hybridization site that is greater than or equal to this selected value.  This 
parameter plays a role only in the search for hybridization probes: “Eliminate 
Homologous Probes” sub-search. 

8.4.2.14.  Min Consensus Homology 
When the "Consensus Probes" box is checked, OLIGO will search for probes 
common to all selected files.  Hybridization probes with a higher or equal 
homology than this parameter will be accepted.  Used by the “Consensus 
Probes” sub-search. 
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8.4.2.15.  Max. # of Mono-Nucleotide Repeats 
Set the maximum number of sequence mono-nucleotide repeats.  Repeats can 
be a homooligomer, such as "GGG".  Used by the “Eliminate Mono- and Di-
Nucleotide Repeats” sub-search. 

8.4.2.16.  Max. # of Di-Nucleotide Repeats 
Set the maximum allowable number of di-nucleotide repeats in primers & probes.  
Repeats can be such as "ACACAC."  Potential oligonucleotides containing 
trinucleotide repeats and higher are not removed by this parameter.  Used by the 
“Eliminate Mono- and Di-Nucleotide Repeats” sub-search. 

8.4.2.17.  Max. Length of Repeated Sequence 
Set the maximum allowable length of sequence repeats longer than 2nt.  
Repeats may be not touching themselves, but minimum 2 need to exist in one 
oligo to be detected and eliminated.  Used by the “Detect Sequence Repeats” 
sub-search. 

8.4.2.18.  Max Degeneracy 
This option filters out potential primers and probes containing degeneracies.  The 
default degeneracy setting is "1," indicating that the oligo under consideration 
has only one unique sequence.  Any degeneracy threshold setting may be 
entered.  Used by the “Eliminate Ambiguous Bases” sub-search. 

8.4.2.19.  Frequency Threshold 
This variable is used by "Eliminate Frequent Oligonucleotides" sub-search.  If the 
frequency of all sub-sequences (6- or 7-mers) would be identical, than each 6-
mer sub-sequence would have frequency of 1000.  Sub-sequences less 
abundant than average have lower numbers than 1000.  More on this subject is 
described in Chapter 5.13. 

8.4.2.20.  Template Loop ΔG Threshold 
OLIGO checks the template for strong secondary structure.  If the primer 
extension would have to go through those structures, the entire PCR pair is 
rejected from results.  This applies to the template only, and not to the sequence 
of the actual primers.  Used by the “Omit High Secondary Structure Regions in 
the Template” sub-search.  Those regions are displayed on the Sequence 
window as dark red lines and listed in Selected Bases window (Search menu) in 
row A. 

8.4.2.21.  Template Loop Window Size 
The sub-search for hairpin loops in a template does not use Current Oligo length 
as the maximum size of the loop/stem structure.  Instead, it uses the value of this 
parameter.  This and the previous parameter are used by the “Omit High 
Secondary Structure Regions in the Template” sub-search. 
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8.4.2.22.  Max. # of G Bases in a Primer/Probe 
OLIGO will eliminate all primers or probes that have more than this number of 
guanosine residues if the “Restrict the Number of G Bases” sub-search is turned 
on.  This helps in finding primers or probes of a less secondary structure, 
especially when multiplexing is considered down the road. 
 

8.4.2.23.  Frequency Table 
In order to eliminate "Frequent Oligos", an oligonucleotide frequency table needs 
to be specified.  This table lists the frequencies of all oligonucleotide (6- or 7-
mers) combinations in various subsets of GenBank and is used by the 
"Frequency Threshold" parameter.  To choose a frequency table click on the 
"Change" button and select a table from the "Frequencies" folder. 

 

8.4.3.  Search Parameters - Sequence Constraints 
The Sequence Constraints search parameters window allows you to control 
sequence contents of the actual primers and probes.  You may type the actual 5’ 
or 

 

Figure 8.4.3.  The Search Parameters: Sequence Constraints and Scores windows. 

3’-terminal sequence (ambiguous bases are possible), and OLIGO will select 
primers only with those desired sequences.  The check boxes in the Sequence 
Constraints window indicate whether or not the particular constrain will be 
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applied in the search, despite the default setting indicated by the blue circle.  In 
the example on Fig. 8.4.3 the search for TaqMan probes was selected and 
despite the scheduled search for Forward and Reverse primer, the constraints 
will only be applied to the TaqMan Probe itself (lack of GG at its 5’-end) and not 
to the primers (no matter what would have been typed in the primer constraints 
boxes) because the check box is unchecked.  Only in the case of molecular 
beacons probe, the sequence shown in this window will be attached to the probe. 
 

8.4.4.  Search Parameters - Scores 
This section of search parameters consists of two windows.  The first one is 
displayed on fig. 8.4.3, and the second one, below.  The Oligonucleotide 
Selection window consists of 7 columns.  The first indicates whether this 
parameter will be used or not in the currently set Search Method, the second- the 
parameter name, the third is the maximum score a primer may receive if this 
parameter falls within the Range.  The fourth and fifth column describe that 
Range, and the sixth column is the unit name the Ranges are shown.  The last 
column shows the penalty per one Unit if a given oligo’s parameter falls outside 
the Range.  You can’t edit the dimmed (grey) values, but otherwise, you may 
change the numbers in the 3rd, 5th and 7th column.  This may have a profound 
effect on the score given oligo or the entire set receives.  Because each search 
may consist of a different number of sub-searches, the maximum score is not a 
simple sum of all scores but it is a weighed score that may reach maximum of 
1000 points, regardless of the number of subsearches. 

 
Figure 8.4.4.  The Pair/Set Selection Scores window. 
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The Pair/Set Selection Scores window has the “Max. Score” column missing 
because the pairs get their scores based on individual primers.  It is a weighed 
number, so the maximum score a pair or a set can get is 1000 points. 

8.5.  Change – GC% of the Unknown Fragment 
This option is active only when the Forward or Reverse Primer or Upper or Lower 
Oligo position is manually set beyond the sequence file.  In this case it is not 
possible to calculate the Tm of the product without manually entering the GC% of 
the unknown sequence fragment. 

8.6.  Change – Reading Frame 
This option controlls the translation result displayed in the Sequence window.  
You may display nucleic acid translation in all 6 reading frames. 

8.7.  Change - Rev. Translate Method 

8.7.1.  Reverse Translate - Lathe  
The Lathe method is based on the most probable codons in mammalian mRNA  
(14).  It gives more accurate codon prediction than the codon table method 
because it assigns codons in a broader context.  Usually larger GC clusters are 
not favourable.  This method yields sequences with less secondary structure.  

8.7.2.  Reverse Translate - Inosine  
When the Inosine method is selected, an inosine (universal substitute nucleotide) 
is inserted at the third base position in certain degenerate codons (11). 

8.7.3.  Reverse Translate - Degenerate  
This method gives all possible oligonucleotide combinations using the standard 
biochemical symbols for degenerate codons  - N, Y, R, etc.; see Appendix D, 
Table 7 (12).  Usually, degenerate primers perform poorly in PCR, so it is better 
to use “guess-mers” as even significant mismatches are tollerable, especially on 
the 5ʼ-ends of primers. 

8.7.4.  Reverse Translate - Codon Table 
This back translation method creates a non-degenerate “guess-mer” sequence 
from the most frequent codons for a given organism. 
OLIGO includes these codon tables: 
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 • Arabidopsis 
• Bacillus 
• Barley 
• Caenorhabditis elegans 
• Chicken 
• Clostridium 
• Cow 
• Distyostelium discoideum 
• Drosophila 
• E. coli 
• HIV 
• Human 
• Influenza virus A 
• Mouse 
• Neurospora crossa 
• Pea 
• Pig 
• Plasmodium 

• Pseudomonas 
• Rabbit 
• Rat 
• Rhizobium 
• Rice chloroplast 
• Salmonella typhimurium 
• Soybean 
• Staphylococcus 
• Streptomyces 
• Tobacco 
• Tomato 
• Trout 
• Vaccinia virus 
• Wheat 
• Wheat chloroplast 
• Xenopus laevis 
• Yeast (S. cerevisiae) 

 
You may modify or enter your own codon table by editing the Codon Usage 
Tables file - see the next Chapter. 

8.8.  Change - Codon Table 
The Codon Table command selects the codon frequency table for a given 
organism.  To add a new codon frequency table to the list, modify the codon 
table file "Codon Usage Tables" in the Tables folder. 
Note:  When you change the codon table, the reverse translation method 

automatically sets to “Codon Table”. 
There are four lines in each codon table file: 
1.  The name of the organism 
2.  The codon frequencies for that organism as described in Nucleic Acid 

Research (18) and updated on the web. 
3.  The codons listed in order of frequency in the organism 
4.  The amino acid symbols 
A time-saving way to add a new user-specified codon table is to open the "Codon 
Usage Tables" file with a word processor, copy the last codon table record, 
change the organism name and codon frequencies accordingly, and save the file.  
The new updates of codon usage tables can be found on the web site: 
http://www.kazusa.or.jp/codon/ 
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9 The OLIGO Window Menu 

9.1 Window Menu  128 
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9 The OLIGO Window Menu 

While working with OLIGO, many windows may be open at one time.  You can 
move each window manually, by clicking on and dragging its title bar, so that the 
main window may be seen.  However, some windows may remain obstructed.  
The Window menu options help you view all opened windows. 
There are different menu items for the Macintosh and Windows versions, so they 
need to be described separately. 
 

9.1.  Window Menu 
You can also use the Window menu to keep track of open windows and bring to 
front any previously opened with Oligo window. 
 

 
Figure 9.1 The OLIGO Window menu (Mac). 

9.1.1.  Window - Show One Document 
This option displays only windows for the currently analyzed sequence file.  You 
may have other open sequence files and this option allows you to choose 
windows belonging to one of these open sequence files.  In this case, a 
document is any Oligo file.  Default display is to show all opened documents. 

9.1.2.  Window - Document Switch List 
This option allows you to switch between Oligo documents.  It displays a list of 
open files and allows you to select the one you want to view. 

9.1.3.  Window - Cascade 
The Cascade command arranges all opened Oligo windows one over another 
such that for all covered windows only the title bars are visible.   
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9.1.4.  Window - Tile 
The Tile command arranges all opened Oligo windows such that all of them are 
visible and non-overlapping.  It is most useful when only a few windows are 
opened and each of them takes up a reasonable screen area. 

9.1.5.  Window - Sequence 
Sequence is only an example pointing to the default Oligo window.  This part of 
the menu lists all open Oligo windows.  Choosing any of them brings it to the 
front of the screen. 
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10 OLIGO Help 

Oligo Help menu has only two items, Help Topics and Check for Update. 
 

 
Fig. 10.0.  The Help Menu. 

10.1.  Help Topics 
This provides access to Help Topics window.  

10.2.  Check for Update 
This provides access to new updates found on MBI’s server. If a newer version of 
Oligo exists on the server, it would be downloaded to your computer 
automatically.  Follow the on-screen instructions to update the software. 
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11 OLIGO Database 
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11.2 (New) Database - Menu Items  138 
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11.  OLIGO Database 

The Database window allows you to create and save new databases for storing 
oligonucleotide and oligonucleotide sets data.  It is also a powerful analysis and 
multiplex search tool. 
There are various format database files now compatible with OLIGO.  It could be 
a list of primer sequences, each in a new line (no descriptions), it could be the 
FASTA format (23) or its modification, as used by the AutoDimer, an on line 
software from National Institute of Standards and Technology (24).  All previous 
versions of OLIGO databases are compatible with OLIGO 7. 
 

 
Figure 11.0.  The Oligonucleotide Database window after importing oligos from the last search 
and choosing “Analyze-Priming Efficiency and Tm- All Oligonucleotides option”. 

Primer sets generated by the OLIGO search may be imported to a single 
database from various sequence files.  The number of records is unlimited.  In 
the database, oligos and oligo sets may be analyzed for dimer and hairpin 
formation and displayed in similar windows as described in Analyze-Duplex 
Formation section.   
The database window is in a table format.  Each row represents one database 
record.  Each column gives the following information: the check/uncheck status, 
the sequential number of the record, its ID number, oligonucleotide sequence, 3’-
dimer data showing either the ΔG value of self-dimerization or the value between 
the most incompatible primer (after the manual multiplexing is performed), 
priming efficiency (P.E.) and the melting temperature of each oligo in four 
columns.  The first from left P.E. and Tm columns show the actual values, as if 
those oligos would have been “annealed” to the linked sequence file, with the 
dangling ends and mismatches considered.  The numbers in the second P.E. 
and Tm columns indicate what those values are when annealed to the perfectly 
matching complementary strand of the same length.  Because sometimes 
dangling ends increase duplex stability, the Tms in the first column may be higher 
than the perfect match with its complement (labeled as tm).  There are two more 
columns, not displayed by default – Reference and Comments, where you may 
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manually enter any relevant information about the oligo.  These columns could 
be introduced through the Database Options from the Change menu. 
The database provides for fully automatic multiplexing.  The multiplexing is 
performed on all oligos in the database, and OLIGO selects compatible groups.  
Within each single group all oligos are compatible with each other (show no 3’-
end dimer formation).  By clicking on the Select button all oligos within a given 
group are selected (highlighted) and become available for export to the linked 
with the database sequence, saving or analysis.  Below is the detailed 
description the database fields. 

11.1.  Database Fields 
The fields displayed with each oligonucleotide record are described here.  Each 
field can be sorted by clicking at the field name.  You may perform a secondary 
sort by pressing another field name while holding the <option> key (Mac) or 
<Ctrl> key (Win).  Immediately below the field name the digit shows the sort 
order number. 

# - Number 
This column displays the sequential number of each record in the database.  As 
oligo records are deleted, the number of later entries receive new higher 
numbers, and not the first available numbers.  To clean up the order, choose 
Renumber from the Edit menu.  The number of entries is not restricted. 

Date 
This field lists the dates when the records were created.  The date is 
automatically assigned by the program using the computer's clock/calendar.  You 
may change the date by double-clicking on the date or using the record editor 

window by clicking on Show/Hide  icon in the window toolbox and selecting 
the “Highlighted Record” item. 

ID Number 
The ID number is automatically created by OLIGO.  It is a composite of the file 
name from which the oligo was imported, its lowest nucleotide position on the 
file, the kind of oligo (F – Forward Primer, R - Reverse Primer, U – Upper Oligo, 
and , L – Lower Oligo), and its length in the number of nucleotides.  If the file is 
from GenBank, the accession number is displayed rather than the file name. 

Sequence 
This column lists the oligonucleotide sequences, from 5' to 3' end. 
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Ref. - Reference 
In order to see the Reference field you need to change the default database 

fields display by clicking on the  icon, that opens Database Options window, 
followed by clicking on the Display Options button.  This is a field in which you 
can enter your initials, a literature reference, and/or synthesis specifications or 
other short notes you want tied to the record.  You may re-size the column to 
view more characters by positioning the cursor on the line next to the letters 

“Ref.” ( ) and click and drag the cursor to the right.  You can also enter/view  

all of the fields when you click on Show/Hide  icon in the window toolbox and 
selecting the “Highlighted Record” item.  This action opens the database editor 
sub-window. 

Comments 
To see the Comments field you need to change the default database fields the 
same way as the Reference column described above.  This field is available for 
additional notes. 

3'-Dim. ⊗G (for the primers) or Homology (for the probes) 
This field displays the 3'-end dimer formation ⊗G value of the oligonucleotide record.  
Also, if the multiplex function in the database has been employed, the field reports 
cross-compatibility to the multiplexed oligo plus its ⊗G value. 

The ⊗G value of the 3' dimer formation is displayed on the left side of the field, while 
the oligo's dimer-forming propensity, either at the 3' end or overall, is displayed on the 
right side. The full list of codes than can be displayed in this column is:  
"SC" - Self-Compatible (not self-dimerizing or self-hybridizing), “C” – Compatible, “NC” 
– Non-Compatible, "D" - forming a dimer, “M” – Multiplexed oligo (compatible with all 
other marked as “C”).  In the Probe checking mode, "HH" is High self-Homology (a self 

- "sticky" probe).  See the Database Options (accessible by clicking on the  icon) 
for definitions.  A simple “Multiplex” command checks compatibility of only the selected 
primer against the remaining oligos in the database and marks the primers in the right 
column of the "3'-Dim. ΔG". 
In order to select a primer for multiplexing, it must first be free of self-dimerizing 
potential and if it's not the case, you may relax the Acceptable 3’- Dimer ⊗G threshold, 
set in the Database Options. 

The 3' ⊗G values displayed after the multiplexing reports the ⊗G of cross-dimerization 
between the multiplexed oligo ("M") and all other oligos.  In order to identify 3, 4, or 
more oligos from a database suitable for a multiplex assay, however, you must 
continue the multiplex operation by clicking on oligos displaying "C" and converting 
them to "M."  Once they display "M," they are cross-compatible to all other oligos 
marked "M."  After two or more multiplex oligos have been selected, the 3' ⊗G value 
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displayed for each oligo now reports the 3' cross-dimerization ⊗G between that oligo 
and the most stable of all the selected multiplexed oligos. 
Oligos can be removed from a given group of multiplex oligos by highlighting them and 
choosing Deselect Multiplex under Analyze from the database window menu.  Please 
note that a much more efficient method of multiplexing is available from the Analyze - 
Multiplex All menu, described below.  Using this menu multiplexes all oligos instantly, 
but the 3'-Dim ⊗G column remains unchanged, unlike using the manual multiplexing. 
When the multiplexing mode is set to "Probes: check homology" (Change Menu) than instead 
of "3'-Dim. ΔG" field you'd see "Homology".  It is actually a 'inverse' homology, so that an "A" is 
homologous to a "T", not an "A".  The listed number indicates how many bases would be able 
to hybridize with each other in a given probe.  For example, sequence AAAAAAAA is self-
compatible ("SC") with 0% homology and a palindrome AAAATTTT is 100% homologous ("HH" 
for high homology). After the multiplexing, the numbers by the "C" (compatible) letters are the 
inverse homology to the multiplexed oligo. A very high homology may cause priobes to stick to 
each other. 

P.E. / p.e.- Priming Efficiency 
This field reports Oligo priming efficiency number in two columns.  The number in the 
right column shows the P.E. of an oligo if annealed to its perfect complement, and the 
number in the left column (p.e.) is the result of Priming Efficiency and Tm analysis, 
performed against the entire, linked with the database, sequence.  Therefore, if there’s 
a mismatch, the real P.E. is lower than theoretical p.e., the value displayed in the right 
column.  By default, the P.E. column is empty until you check the priming efficiency 
manually using the Analyze menu.  The priming efficiency check tests database oligos 
against every potential priming site on the linked sequence - within the established 
search ranges - and reports the highest priming number on the most stable site for 
each oligo.  Priming efficiency checks of large oligo databases can be used to find 
previously synthesized primers that can be reused on other sequences, particularly for 
sequencing. 
Oligos may be exported from the database to the linked sequence where they will be 
automatically aligned with their most stable sites. 

Tm / tm - Melting Temperature 
This field reports the Tm of database oligos in two columns.  The right column reports 
the theoretical melting temperature of each oligonucleotide using the nearest neighbor 
method if the oligo is annealed to its complement (column marked as tm).  The Tm in 
the left column is the result of Tm analysis, performed against the entire, linked with the 
database sequence.  Therefore, if there’s a mismatch, the real Tm is lower than the 
value displayed in the right column.  This Tm is usually different than the tm because it 
considers the corresponding dangling ends in the sequence.  Depending on the 
sequence, the dangling ends may have destabilizing or stabilizing effects.  The nucleic 
acid and concentrations used to calculate the Tm can be found in the Database Options 
window or, if the “Use the linked sequence parameters” check box is checked, the 
concentrations may be changed in the Search Parameters of the linked sequence. 
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11.2.  (New) Database - Menu Items 
The menu items for the Database menu are described here.  The entire main 
menu changes when the Database window is active. 

11.2.1.  File 
The File menu is essentially the same as the standard File menu, but some 
options are different.  Close function closes the currently active database, and 
nothing else.  Function Save has less options, and Revert to Previous Database 
brings back the database previously saved, so that the all edit operations made 
after the save are discarded. 

11.2.2.  Edit 
The Edit  allows you to modify, delete, and view oligonucleotide records. 

 
Figure 11.2.2.1.  The Edit submenus. Mac interface. The only difference with PC is that instead of 
the short cut key " there is the “Ctrl”. 

It is important to understand, that the top 6 functions of this menu (above the 
horizontal separator line) deal with copying, pasting etc. of the entire records, 
and not individual fields or nucleotide symbols. 

Edit - Undo/Redo Modify 
The Undo Modify option enables you to undo the last edit action.  After changing 
a record, you may undo those changes by selecting Undo Modify.  Similarly, you 
can Undo any other edit function such as Cut or Clear.  After "undoing," you may 
go back one step and "redo" cutting or pasting. 
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Edit - Cut 
The Cut option copies the selected record to the Clipboard and deletes it from 
the database. 

Edit - Copy 
The Copy option copies the selected record to the Clipboard.  You may paste this 
record to another (or the same) database afterwards. 

Edit - Paste 
The Paste option copies a database record from the Clipboard to the opened 
database.  You need to use the Cut or Copy functions to activate this item (to fill 
in the Clipboard). 
Edit - Clear 
The Clear or Delete (in Windows) command deletes the selected record from 
your database.  You may use Undo - Clear to reverse this action. 

Edit - Select All 
This function selects/deselects all records for other edit functions.  To select a 
single record, click on it.  To select a group of continuous or non-continuous 
records, use a shift-click combination or a "-click (Mac), Ctrl-click (Win) 
combination. 

Edit - Selected Record 
This function allows you to change record in the database.  This opens the same 

format sub-window as by clicking on Show/Hide  icon in the window toolbox 
and selecting “Highlighted Record” item, to modify an existing record.  
You can change the date, add or change the ID number, and sequence in the 
record.  You can also add and edit references and comments that are tied to the 
record.  In addition, standard editing features - Cut, Copy, and Paste are 
available in the Edit - Add Record window, but only through the short cut keys 
(don’t use the menus).  When you’re done with the modifications, click the 
“Modify” button to accept the changes. 
Another way to modify database records is to double click at the modify-able 
fields and simply begin the typing.  When you’re done, click on any other record 
and your changes would be accepted. 

Edit - Selected Set 
This function allows you to change the associations between the records.  Place 
the cursor in a desired point, click and change or delete the number. 
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Edit - Renumber 
This function renumbers existing records in the database.  Useful after sorting or 
deleting some records, when the numbering is not sequential any more. 

Edit - Add Record 
This function allows you to add a new record to the database.  This opens the 

same format sub-window as by clicking on Show/Hide  icon in the window 
toolbox and selecting “Highlighted Record” item, to modify an existing record.  

 
Figure 11.2.2.2.  The "Add Record" sub-window. 

You can change the date, add the ID number, sequence and any other field in 
the record.  In addition, standard short cut keys - Cut, Copy, and Paste are 
available in the Edit - Add Record window.  When you’re done with the 
modifications, click the “Add” button to accept the changes. 

Edit - Add Set 
This function allows you to associate database records with each other, creating 
pairs, triplets and quadruplexes.  Just type into the empty boxes numbers of up 
to four records to associate them with each other.  When the association is 
made, all oligos may be exported to the linked sequence in one action.  Also, 
you’d be able to check the dimer formation between the associated oligos. 

Figure 11.2.2.3.  The "Add Set" sub-window. 

Edit - Renumber 
This function allows you to renumber existing records in the database.  Useful 
after sorting or deleting some records, when the numbering is not sequential any 
more. 
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11.2.3.  Link 
This feature will let you associate the database with any open sequence file.  
After the linking, export and import functions are available, as well as you get 
fully functional Priming Efficiency and Tm database features.  If only one 
sequence file is open there is no need for this manual linking - the database is 
linked to the sequence automatically. 

11.2.4.  Analyze 
The Database window has several analysis options showing certain features of 
the oligos stored in it.  

Analyze - Priming Efficiency and Tm 
The Analyze - Priming Efficiency and Tm option calculates the priming efficiency 
for the selected primer(s) or for all the  
 

 
Figure 11.2.4.1.  The "Analyze" Database submenu. 

oligonucleotides in the database.  Once the actual P.E. for the primer (checked 
against the linked sequence), and the highest theoretical P.E. values are 
calculated, they are displayed in the two columns.  The same is true for the Tm 
display.  This feature affects only the numbers displayed in the left columns that 
show the actual P.E. and Tm of given oligo when annealed to the linked 
sequence. 

Analyze - Multiplex 
The Analyze - Multiplex option checks the selected record against other 
database records for multiplex PCR experiments.  "M" appears in the "3'-Dim 
⊗G" right field to indicate that this oligo is compatible with all the "C"- marked 
oligos in the database.  When the multiplexing mode is set to "Probes: check 
homology" (Change Menu) than Oligo would check whether other probes won't 
be hybridizing with each other, based on overall homology. 
Following the multiplex check, primers with a "C" in the 3' column are cross-
compatible with all "M" - marked primers.  Primers with "NC" in this column 
following a multiplex check are not cross-compatible with all the oligos from the 
multiplex group.  The lowest ⊗G value of the most stable 3'-end dimer for all 
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multiplexed primers is given as well.  Note that the letter "C" (for Compatible) 
means that the 3'-terminal duplex is less stable than the value set in the 

"Database Options" window.  Open the Database Options by clicking on the  
icon. 

Analyze - Deselect Multiplex 
Multiplexed primers may be "un-multiplexed" by choosing the Analyze - Deselect 
Multiplex option.  This will deselect the primer that has been multiplexed last, 
regardless of which oligonucleotide record is highlighted. 

Analyze - Multiplex All 
The Multiplex All analysis checks all entries or sets in the database against all 
others and displays the results as compatible groups in the bottom of the 
Database window.  Each group may be displayed separately by clicking on the 
scroll bar above the list, and each oligo in the group may be highlighted by 
clicking on the “Select” button located also above the list.  Two modes of 
multiplexing individual oligos and the entire sets are available.  The “Minimize 
Reaction #” is perhaps the most useful option.  This method selects the smallest 
number of compatible groups where each primer or set appears only once in all 
the groups.  The option “Find All Groups” shows all possible groups, but each 
given primer or set may be repeated in several groups.  For multiplexing large 
databases the only practical is the “Minimize Reaction #” option.  This option may 
give different results depending on how the oligos are sorted. 

 
Figure 11.2.4.2.  The Database window showing one of the multiplexed groups of sets. 

By pressing the “Select” button you highlight all records within the displayed 
group, and "Export - Check Selected" checks all of them (see "Print/Save 
Options..." on what you can do with the selected oligos).  The displayed group 
can be changed by the scroll bar located immediately above the listed record 
numbers. 



 143 

Analyze - Duplex Formation 
Each oligo in the Database may be analyzed for duplexes.  This option works if 
at least one single record or primer pair/probe set is highlighted.  If more records 
are highlighted then only the top record is displayed in the Duplexes window.  
The main menu Analyze - Duplex Formation window is described in the Chapter 
5, the Oligo Analyze Menu. 

Analyze - Hairpin Formation 
Each oligo in the Database may be analyzed for hairpins.  This option works if at 
least one record is highlighted.  If more records are selected then the first from 
the top is displayed.  The Hairpin Formation window is described in the Chapter 
5, in the Oligo Analyze Menu. 

11.2.5.  Import 
Using the Import menu, you can add individual primers and probes, LCR oligos,  

 
Figure 11.2.5.  The Import menu. 
and selected primer/probe sets as records to your database.  To add a record, 
choose from the menu the appropriate oligo you want to add.  If you choose the 
Oligonucleotide Set, all oligos displayed in the Sequence window are imported as 
a set.  Use “All Oligonucleotide Sets” or “All Selected Oligonucleotides” to import 
all oligos found during the most recent search for Primers & Probes (those 
displayed in the Oligonucleotide Sets or Selected Oligonucleotides windows, 
respectively).  If you have designed and selected LCR oligos and have not 
closed that window, you may choose the LCR Oligos option from the Import 
menu to add the selected LCR oligos to the database. 

11.2.6.  Export 
Exports a single highlighted (selected) oligo or primer pair (triplet) to the linked 
sequence as probes or primers, and exports all checked  oligos or pairs to the 
Selected Oligonucleotides or Oligonucleotide Sets windows, associated with the 
linked sequence.  Those windows may be closed at the exporting time. 
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Figure 11.2.6.  The Export menu. 

Export - Single Selected as 
To transfer an oligonucleotide or a set of oligos from the database to the linked 
sequence select (highlight) the record by clicking on it or on the oligonucleotide 
set in the database window and export this oligo or the set as Forward or 
Reverse Primer, Upper or Lower Oligo, or Oligonucleotide Set.  When you go 
back to the Sequence window, you can work with these primers/probes in any of 
OLIGO's Analyze functions.  When several sequence files are opened, make 
sure that the intended sequence file is linked to the Database.  To un-select a 
single record Ctrl-click (PC) or "-click (Mac) on it. 

Export - Checked Oligonucleotides 
This transfers all the checked oligos (not necessarily highlighted) from the 
database to the Selected Oligonucleotides and Oligonucleotide Sets windows of 
the sequence linked to this database.  Make sure that you are exporting oligos 
that originated from the same sequence.  The selected oligonucleotides exported 
this way replace the latest search results, so you may further analyze the oligos 
by selecting them for further analysis from the Selected Oligonucleotides and 
Primer Pairs/Probes windows as Primers or Oligos (usually probes). 
Note: if you've modified a record in the Database, exporting it will not carry this 

modification because it only exports indexes (finds best matches in the 
sequence), not the actual oligos.  Exporting sets consisting of molecular 
beacons may alter the beacons by replacing their 5'-tails into sequences 
given in the "Sequence Constraints" "Search Parameters" window. 

Export – Check (Uncheck) Selected 
This checks all selected (highlighted) records.  If you see “Uncheck” instead (this 
happens when the top record is already checked), then all selected records are 
unchecked. 

Export – Uncheck All 
This unchecks all records, regardless of their selected status. 



 145 

11.2.7.  Change 
The Change Menu has two items: Options and Multiplexing Mode.   

Change - Options 

 
Figure 11.2.7.1.  The Database Options menus.  

The Options window consists of two parts.  The first part displays all parameters 
the database is using to calculate properties of listed oligos as shown on Fig. 
11.2.7.1.  Parameters such as salt and nucleic acid concentration have direct 
effect on the Tms of oligos displayed in the Database.  When the “Use the linked 
sequence parameters” box is checked, than search parameters from the linked 
sequence are used instead. 
The Display Options window is shown to the right of the Parameters window.  
This window controlls what fields should be displayed in the Database window.  
Columns “Select/Deselect” and “#” cannot be hidden, so they are greyed-out.   

Change - Multiplexing Mode 
There are two methods of multiplexing the Database records.  The first (default) 
is for primers multiplexing, that is, Oligo checks for the presence of 3'-dimers 
between the records.  The second is for multiplexing hybridization probes.  In this 
case Oligo checks whether the oligonucleotides in the database would not stick 
to each other, based on inverse homology.  For example, two probes GGGGC 
(40% homology to itself: 2 'sticky' bases in a 5nt. - long probe) and GGGGA (0% 
homology to itself) would be compatible, but GGGGC and ACCCC (0% 
homology to itself) are not compatible (80% homology to each other).   
The Homology field in the database displays the following letters, that stand for: 
SC - self compatible, D - forming a dimer, HH - high (self) homology, C - 
compatible (with multiplexed), M - multiplexed, NC - non-compatible.  All these 
qualifications depend on the Parameters settings of the Change - Options menu. 
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11.2.8.  View 
The View Menu has only two items: Toolbar and Status Bar.  You may hide or 
display those window elements.  These are functional only under Windows 
systems. 

11.2.9.  Window 
The Window Menu displays variable number of items, depending on the number 
of opened sequence files and windows.  The figure below shows all the items 
when two sequence files and one database is opened.  The active window is 
checked, and in this example it shows that the active sequence file is “BRCA2 
gene.txt”, and this sequence has two windows opened: the “Sequence” and 
“Current Oligo Duplexes”.  You may select any other window as active (push in 
front of the screen) by selecting the window name.  With this menu you may 
arrange the windows in Cascade or Tile fashion.  Choosing “Show One 
Document” item will hide all windows not associated with this document.  The 
document is either a single sequence or a database.  To show back all the 
documents, click also the first menu item, which will read “Show All Documents” 
at this time. 

 
Figure 11.2.9.  The Window menu. 

11.2.10.  Help 
This menu gives access to the help file.  In addition to this, Windows users can 
read the info about the current OLIGO version by choosing the “About Oligo” item 
(Macintosh menu has this item in the Application menu). 
The “Check for Update” is the second option.  Use it to check MBI’s server for the 
newest Oligo free updates. 
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12.  Troubleshooting 

Your OLIGO distributor provides thorough technical support for all of its products.  
In order to provide you with the best support, however, please review these 
sections before calling.  You may find your solution here, or will be able to 
provide more information to our technical support staff should you need to call. 

12.1.  OLIGO Messages 
In this section, OLIGO messages you may receive, and possible solutions to the 
situation, are listed in alphabetical order. 

3'-end dimer in both primers. 
This condition may cause low efficiency priming in PCR and sequencing.  
Choose different primers, if possible. 

3'-end Reverse Primer dimer. 
This condition may cause low efficiency priming in PCR and sequencing.  
Choose a different primer, if possible. 

3-end Forward Primer dimer. 
This condition may cause low efficiency priming in PCR and sequencing.  
Choose a different primer, if possible. 

3'-end stability range has been incorrectly set. 
Check your stability range.  It may be out of the allowable limits, or it may not be 
consistent with the PCR product size. 

Can't open file: (file name). 
Your sequence file may have some incompatible characters.  Sequence files 
interrupted with periods, semicolons, or other characters are truncated and can't 
be loaded.  Remove the characters using any standard word processing package 
and save the file as plain text. 

Database is empty. 
There are no oligo records in the database to export.  Choose a different 
database or go back to this database and import Upper and Reverse Primers, 
LCR oligos, and/or multiplexed primers. 
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Error 
Try your last OLIGO operation again.  You may have inadvertently tried a 
function that is not operable in combination with the features you are using. 

Error encountered during print. 
Check your printer and its connections. 

Excessive difference between product and primer melting 
temperatures. 

This difference may contribute to false priming of the higher Tm primer.  Remove 
nucleotides from the 5'-end to reduce and match Tms, or choose different 
primers. 

Expecting a float number. 
Check your last entry and re-enter it.  There may be a decimal point, a letter, or 
an illegal character in your entry. 

Expecting an integer number. 
It's possible that there is a decimal in your entry.  Remove the decimal and try 
again. 

Expecting a negative number. 
A positive value may have been entered.  Make sure the entry is a negative 
number and try again. 

Expecting a positive number. 
A negative value may have been entered.  Make sure the entry is a positive 
number and try again. 

Hairpin loop in the Reverse Primer. 
Check hairpin stability.  Consider redesigning the oligo if the hairpin is stable, 
particularly a 3' hairpin. 

Hairpin loop in the Forward Primer. 
Check hairpin stability.  Consider redesigning the oligo if the hairpin is stable, 
particularly a 3' hairpin. 

Invalid sequence. 
The sequence file may contain illegal characters or it may be an invalid sequence 
format.  Refer to Troubleshooting Situations - Getting Started for suggestions on 
solving this. 
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Manually modified by the user. 
You have modified the active sequence file. 

No info saved for this window. 
You saved a window that does not have "savable" data in it, so OLIGO saved a 
blank window. 

No match found. 
No nucleotide string of this sequence was found in this file. 

No primer pairs. 
No cross-compatible primers were found in this search.  You may want to change 
your search parameters and/or search ranges and try again. 

No stems longer than (X) bp. 
All hairpin stems are shorter than the minimum display setting that is selected in 
the Forward Primer/Reverse Primer/ Current Oligo hairpin stems window. 

Not accepted. 
The entry is not recognized by OLIGO.  Check your entry and try again.  You 
may be trying to enter information that cannot be accepted by a particular field. 

OLIGO cannot determine whether the sequence is DNA or RNA.  Is it 
DNA? 

The sequence file may contain illegal characters or it may be an invalid sequence 
format.  Refer to Troubleshooting Situations - Getting Started for suggestions on 
solving this. 

Oligo Tm range has been incorrectly set. 
Check your Tm range settings.  Your entry is probably outside the allowable 
range. 

Out of disk space. 
This operation has exceeded the space available on your hard drive.  If you're 
trying to save a file, you may need to erase unwanted items on your drive or 
reduce the size of the file you are saving. 

Out of memory. 
This operation has exceeded the memory of your computer.  You will need to 
reduce the search size or quit some functions and try again. 
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Overlapping primers. 
The positions and lengths of these primers have produced an overlap.  You will 
need to change the position of one or both primers and try again. 

PCR product length has been incorrectly set. 
Check your PCR product length setting.  It may be outside the allowable limit for 
the selected search range settings. 

Print error.  
Check your printer connections and settings. 

Printer initialization failed.  
Check your printer connections and settings. 

Printing canceled.  
Check your printer connections and settings. 

Printing unavailable for this window. 
This window cannot be printed from OLIGO.  If you need to print it, take a 
snapshot (Mac version, under the Window menu) and then print it from the 
Clipboard.  In the PC-Windows version use "Alt-Print screen" key combination to 
copy contents of a front window to the clipboard. 

Search ranges are incorrectly set. 
Reset your search ranges and try again.   

Sequence is too short. 
The minimum sequence size accepted by OLIGO is nine nucleotides. 

Terminal stability of the Reverse Primer is too high. 
As PCR or sequencing primers, these oligos may be susceptible to false priming 
in a complex nucleic acid sample.  Select oligos with a less stable 3'-end if your 
sample is complex, unless your application does not involve priming. 

Terminal stability of the Upper and Reverse Primers is too high. 
As PCR or sequencing primers, these oligos may be susceptible to false priming 
in a complex nucleic acid sample.  Select oligos with a less stable 3'-end if your 
sample is complex, unless your application does not involve priming. 
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Terminal stability of the Forward Primer is too high. 
As PCR or sequencing primers, these oligos may be susceptible to false priming 
in a complex nucleic acid sample.  Select oligos with a less stable 3'-end if your 
sample is complex, unless your application does not involve priming. 

That access code is incorrect. 
Check your access code and re-enter it.  If it is still incorrect, call, fax or E-mail 
for technical support. 

The computer's memory has been exceeded:  must exit OLIGO. 
Quit the program and restart it with fewer windows and/or applications open. 

The number is not within the allowable range: (range specified). 
Check the parameters again.  You may have entered something outside of the 
allowable range.   

The position numbers you wish to read may be unrelated to the 
current sequence. 

Check your sequence file and/or the source of the position data. 

This file does not contain valid oligonucleotide data. 
This is probably not a Memory Table data file.  Select a Memory Table data file 
and try again. 

This file does not contain valid oligonucleotide database. 
This is probably not an oligonucleotide database file.  Select a database file and 
try again.   

This file does not contain valid sequence data. 
Check your sequence file.  It may have some characters OLIGO does not 
recognize.  Sequence files interrupted with periods, semicolons, or other 
characters are truncated and can't be loaded.  Remove the characters using any 
standard word processing package and save the file as plain text. 
Too many potential primers - not all pairs analyzed. 
The number of primer pairs found exceed the program's memory.  Increase your 
search stringency and/or reduce your search ranges and try again. 

Two-step PCR recommended:  (70/94). 
The two-step (two-temperature cycling) PCR procedure for these primers run at 
these temperatures should yield a product with less background.  A typical two-
step PCR for these temperatures is:  Denaturation at 94°C for 30 seconds, 
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followed by annealing and extension at 70°C for 60 seconds, repeated several 
times. 

Two-step PCR recommended:  (68/94). 
The two-step (two-temperature) PCR procedure for these primers run at these 
temperatures should yield a product with less background.  Denaturation at 94°C 
for 30 seconds, followed by annealing and extension at 68°C for 60 seconds, 
repeated several times. 
 

12.2.  Troubleshooting Situations 
This section describes specific problems and solutions you may have while 
working with the OLIGO program.  They are loosely organized into "Getting 
Started," "System Problems," "Working With the Windows on the Screen," 
"Searching," and "Printing."  You may find that an explanation applies to other 
functions, as well. 

12.2.1.  Getting Started 

I can't start the OLIGO program. 
When you install the OLIGO program, you need to go through a registration 
process that identifies a "workstation code" for your computer.  Each computer 
has a separate workstation code.  For each workstation code, you will need to 
contact NBI or one of our affiliates for an access code in order to start up OLIGO.   

I can't load a sequence file. 
Check that your file is in a format that OLIGO can read.  Acceptable file formats 
include GenBank, EMBL, text, and the formats included in most sequence 
analysis packages (typically text). 
If your sequence analysis file won't open in OLIGO, it probably contains 
incompatible characters.  A sequence interrupted with periods, semicolons, or 
other characters such as ">" or "^" are truncated and can't be loaded.  Remove 
these characters using any standard word processing package and save the file 
as plain text. 
Note:  The character ">" begins a comment line.  See the CPB.SEQ file for an 

example of the proper format.  Comments should precede the sequence. 

If your sequence file was created in a word processing program and won't open, 
it may not have been saved as an text file.  Files saved as standard word 
processing files appear to have no illegal characters, but may have hidden 
characters that prevent OLIGO from reading the file properly.  Try resaving the 
file as a text file. 
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I'd like to use the reset functions, but don't know the difference. 
There are two levels of reset in the OLIGO program. 
The Reset - Data command resets all user-generated results, calculations, and 
accumulated data generated since opening the active sequence.  This erases all 
search data, erases any selected primers, and resets the temperatures for ⊗G 
calculations to 25°.  It does not, however, change search parameters, except the 
search ranges, which are reset to the full sequence length. 
The Reset - Original Defaults command changes all parameters back to the 
original program defaults and closes all but the "Sequence" window, but leaves 
the data and search ranges unaffected. 

The examples don't work the way the manual says they should. 
Make sure that all parameters and search ranges are set correctly.  Use the 
appropriate Reset option from the File menu and try the example again.  MBI 
may have changed OLIGO parameters and algorithms after the manual has been 
released and this way the results won't exactly match. 

12.2.2.  System Problems 

The program works slowly. 
Your search may take longer than expected, especially when you are checking a 
large number of oligos for false priming sites.  The false priming sites subsearch 
checks oligos against the entire sequence file, resulting in longer search times. 
Check your search stringency and increase it if possible.  More stringent 
searches are faster than less stringent searches.  

System crashes when starting OLIGO. 
This is most likely due to loading a large sequence file OLIGO could not handle 
due to too small memory allocation.  After restarting the computer, click on the 
OLIGO icon and press the <"> and <I> keys simultaneously (Mac).  Increase 
the memory used by OLIGO.  There are many reasons for crashes on Windows 
system.  Please contact the technicall support an describe the circumstances.  
Some of them are due to bugs in Oligo that can be fixed. 
It is always a good idea to check for the recent version update (Help Menu).  If 
your version has a different number, download and install it on your computer 
according to the provided instructions. 
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12.2.3.  Working with the Windows on the Screen 

There are too many windows on the screen and you can't find the 
window you want to work with. 

Use the Window menu to see all the open windows (listed at the bottom of this 
menu).   
Use the title bar (click and drag) to move each window to its optimal place so that 
you can view the windows better, and close those you do not need. 

12.2.4.  Searching 

The search is complete, but doesn't produce any results. 
Check that the "Automatically change stringency" box in the "Search Parameters" 
dialog box is checked.  This relaxes the search stringency setting and searches 
again if nothing is found at the original setting. 
Check to see that your search ranges are sufficiently wide and that the PCR 
product size is consistent with the search ranges. 
Search ranges should be at least 100 nt whenever possible (particularly for PCR 
primer searches). 
Shift your positive strand or negative strand search ranges, particularly if the 
program has selected positive and negative strand primers but no cross-
compatible pairs. 
If you want to keep the search stringency high, but the search yields nothing, turn 
off the "Automatically change stringency" button and select Primers and Probes 
Search Data from the Search menu.  Review the individual subsearch statistics.  
If one subsearch has removed most of the oligos (typically the GC Clamp), 
consider relaxing that single parameter and try the search again. 

12.2.5.  Printing 

The program doesn't print. 
OLIGO uses a standard system printer driver.  If the program is not printing for 
you, first check your printer connections.  If they are OK, check to see if your 
printer driver was installed correctly.  Refer to your printer manual. 

The printout doesn't look right. 
OLIGO uses a non-proportional font for all its printouts.  Make sure you have a 
font (like Courier) available on your system.n  If the text is too large or too small, 
use Macintosh Page Setup (File menu) and type a new value into "Reduce or 
Enlarge" box.  If you need a specially formatted document, save the data in a text 
file, open it with your favorite word processor, reformat and print it. 
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12.3.  Design Problems and Possible Solutions 
 

OLIGO Oligonucleotide Search Selection Criteria 
 

Performance 
Problem 

Application Design Remedy Selection Feature 
 

Background due to 
false priming in 
genomic or other DNA 
samples with much 
unknown sequence. 

PCR, 
Sequencing 

Select oligonucleotides 
with high specificity. 

3' Stability Window - Determine 
stability (⊗G) of the 3' ends of 
oligonucleotides; select only those 
with low or moderate stability. 

Multiple PCR product 
bands due to false 
priming within and 
near the intended 
amplification region. 

PCR, 
Sequencing 

Select only 
oligonucleotides that 
will not false prime 
within and near the 
PCR product on the 
active sequence. 

False Priming Check - Determine 
the propensity of false priming 
using stability (⊗G) calculations; 
select oligos with no strong 
priming affinity to any region on 
the active sequence. 

Background due to 
false priming and 
much of the sample is 
known but scattered 
over many active 
sequences. 

Sequencing, 
PCR 

Select oligonucleotides 
which will not false 
prime on known 
sequence outside the 
active sequence. 

False Priming Check Against 
Other Sequence Files - Check for 
false priming sites in all the 
sequence files selected by the 
user. 

High background due 
to false priming in 
repetitive active 
sequences, such as 
ALU. 

PCR, 
Sequencing 

Select oligonucleotides 
which will not false 
prime in repetitive 
active sequences. 

False Priming Check Against 
Repetitive Sequence Database 
File - Check for false priming sites 
in repetitive active sequences 
selected by the user. 
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Very low efficiency 
PCR or sequencing 
reactions because of 
3' dimerizing and 
hairpinning of 
oligonucleotide 
primers. 

PCR, 
Sequencing 
 

Select oligonucleotides 
with low dimer or 
hairpin formation 
potential at their 3' 
end. 

Duplex Formation Check - Check 
the 3' ends of all oligos, using 
stability algorithms, eliminating 
those with dimer or hairpin 
potential. 
 

Performance 
Problem 

Application Design Remedy Selection Feature 
 

Reduced efficiency 
PCR or sequencing 
reactions due to low 
primer Tm. 

PCR, 
Sequencing 

Select oligonucleotides 
with high or 
moderately high 
stability along their 
lengths, except for the 
3' end. 

GC Clamp - Determine stability 
(⊗G) of the 5' end and center 
segments of oligonucleotides; 
select only those with high or 
moderately high stability. 

Very low efficiency 
PCR reactions 
because of 3' 
dimerizing between 
the Upper (upstream) 
and Lower 
(downstream) primers. 

PCR Select cross-
compatible Upper and 
Reverse Primers 
(primers with low 3' 
dimer forming potential 
between them). 

Cross-compatibility Check - 
Check the 3' ends of Reverse 
Primers against the 3' ends of 
Forward Primers, using stability 
algorithms, eliminating those 
pairings with dimer potential. 

Background due to 
false priming of the 
higher Tm primer in a 
PCR reaction. 

PCR Match the Tms of the 
Upper and Reverse 
Primer. 

Tm Matching - Add nucleotides to 
the 3' end of the Lower Tm primer 
until its Tm most closely matches 
the higher Tm primer. 

Reduced efficiency 
due to Tms which are 
too low or too high for 
the application. 

Sequencing, 
PCR, 
Hybridization 

Select oligonucleotides 
with optimal Tms. 

Tm Window - Select only 
oligonucleotides with Tms within 
Upper and Lower Tm thresholds. 
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Mutations in the primer 
area, in the form of 
insertions or deletions. 

Sequencing, 
PCR, 
Hybridization 

Select oligonucleotides 
that cannot misalign 
on the active 
sequence. 

Homooligomer and Sequence 
Repeat Checks - Select only 
oligonucleotides which do not 
contain strings of the same 
nucleotide or sequence repeats. 
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12.4.  OLIGO Technical Support 
Your OLIGO software supplier provides technical support for all its software 
products and research services.  In order to obtain technical support for software, 
you must be the licensed user, or work for the licensed user. 
Complete the OLIGO installation and customer registration procedures to register 
your OLIGO program.  

12.4.1.  Seeking Help 
Use the standard Windows help feature.  If you still need assistance, contact 
your MBI (oligo.net).  When contacting for technical support, please have the 
following information available, or include it on your fax or E-mail: 
• Your name 
• Name of the licensed end user, if different 
• OLIGO license number 
• Phone  or the E-mail address 
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Appendix A:  Glossary of Terms 
Active Reading Frame - The reading frame currently displayed in the Edit window 

set to Mutagenesis mode. 
Active Sequence - The nucleic acid sequence currently analyzed.  OLIGO has 

the capability of loading several sequence files into memory.  Only the front 
window, or most recently selected file however, is the active sequence. 

Ambiguous Base - A degenerate or unknown base (wobble).  Symbols are listed 
in Appendix D - Theories and Formulas Used in the OLIGO Program. 

Check Box - A small box next to selectable options in a dialog box.  The options 
can be turned on (marked with an X) or off (blank box), by clicking directly on 
them. 

Click and Drag - A mouse technique used to move icons, highlight text, reposition 
windows, and move other options on the screen.  Position the pointer on the 
target, click and hold the left mouse button, and drag the target across the 
screen.  Release the button to position the target. 

Codon Display - In a single line edit window, this display shows the relative 
frequency of each codon present in a given organism. 

Codon Table Method - This reverse translation method creates a guess-mer 
made of the most frequent codons for a given organism. 

Current Oligo - The Current Oligo is the oligonucleotide displayed in a gray 
background (block) in the "Sequence" window or in red in the Melting 
Temperature and Internal Stability windows.  The Current Oligo includes both 
the positive and negative strands and is updated with each position change 
on the active sequence.  A Current Oligo may be saved as Forward or 
Reverse Primer, or Upper or Lower Oligo and/or analyzed using most options 
under the Analyze menu. 
When browsing the active sequence for a new Current Oligo, you can open 
the "Current Oligo" window from the Analyze-Key Info  menu.  Click and drag 
on the "Current Oligo" window title bar to position the window in the most 
convenient part of the screen.  The Current Oligo data is visible & updated 
simultaneously on all relevant windows. 

Degeneracy - The total number of base combinations possible in a sequence.  
The list of ambiguous (degenerate) bases is in Appendix D - Theories and 
Formulas Used in the OLIGO Program. 

Degenerate Method - Reverse translates a protein sequence into all possible 
combinations of a nucleic acid sequence. 

Delta G (⊗G) - Free energy, a measurement of nucleic acid duplex stability.  A 
DNA duplex is more stable when its ⊗G value is more negative.  The ⊗G, 
expressed in kcal/mol, depends on the nucleotide sequence, salt 
concentration, temperature, and other factors.  Only the temperature can be 
modified within the program.  Salt is fixed to 1M NaCl, except that it varies in 
the Tm calculations for hairpin loop.  See Appendix D Theories and Formulas 
Used in the OLIGO Program for the formula. 
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Dialog Box - A window that requests information from the user before a function 
or command can be carried out. 

Dimer - Two nucleic acid molecules attached to each other with hydrogen bonds. 
Dimer length- refers to a string of contiguous base pairings between two strands 

of nucleic acid. 
Duplex - A double-stranded nucleic acid.  It may be contained in one molecule 

(hairpin stem), in two molecules (dimer), or many molecules. 
False Priming - The initiation of a nucleic acid synthesis from an unintended site.  

This occurs when the 3'-end of a primer has significant homology with more 
than one site on an active sequence.  See Priming Efficiency Number (P.E. 
#). 

Filter Dissociation Temperature (Td) - Td is the temperature at which 50% of the 
nucleic acid probe is retained on a hybridization filter after five minutes of 
incubation using 1 M NaCl.  To arrive at correct Td values, OLIGO uses 100 
pM oligonucleotide concentration; however, during filter washing, the 
concentration of the oligo in the washing solution is variable but always low 
relative to the concentration used during hybridization. 

Hairpin - A nucleic acid strand forming stable hydrogen bonds (with ⊗G < zero).  
The hydrogen bonded region is referred to as a stem and the single-stranded 
region between the two stem regions is called referred to as a loop. 

Hairpin Loop - The single-stranded region in a nucleic acid hairpin between the 
double-stranded stem. 

Hairpin Stem - The double stranded region of a hairpin. 
Hybridization - Process of hydrogen bond formation (or duplex formation) 

between nucleic acid molecules. 
Hybridization Probe - an oligonucleotide used to detect a specific nucleic acid 

sequence using a hybridization method. 
Inosine Method - This reverse translation method substitutes the Inosine base 

(universal substitution nucleotide) for a certain degenerate base.  This 
method is described in Appendix D - Theories and Formulas Used in the 
OLIGO Program. 

Inverse PCR - DNA amplification of unknown sequences flanking a known 
sequence.  When using OLIGO, 3'-ends of primers should point to the outside 
of a linear active sequence.  The actual DNA template, however, must be a 
circular DNA sequence for the inverse PCR application. 

Internal Stability - This refers to the stability of subsequences within a nucleic 
acid.  OLIGO displays internal stability as the ⊗G of pentamers.  Optimal 
primers are usually very stable on their 5'-ends and less stable on their 3'-
ends (but still relatively stable).  The variable stability within an oligo is 
determined by measuring the ⊗G of the various overlapping pentamers within 
it.  The internal stability of the 3'-end of an oligo can be used to predict its 
specificity in a PCR or sequencing reaction. 

Lathe Method - This reverse translation method is based on the most probable 
codons on mammalian mRNAs and the codon bias.  (Ref. 14.)  For more 
information, see Appendix D - Theories and Formulas Used in the OLIGO 
Program. 
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LCR (Ligase Chain Reaction) - Is a method of detecting small concentrations of 
target DNA molecules, usually at mutation sites, originally described by 
Barany, et al. (Ref. 17.)  Currently, there are four basic variations of this 
technique:  blunt end ligation, single base "sticky" end ligation, fill-in ligation, 
and deblock and ligation.  OLIGO automatically selects probes for the single 
base sticky end ligation. 

Loop ⊗G (Hairpin) - The stability of the hairpin stem plus the destabilizing effects 
of the hairpin loop, expressed in kcal/mol. 

Lower Oligo - a negative strand oligonucleotide that has been selected for 
analysis.  The Lower Oligo can be manually selected by the user or 
automatically selected by OLIGO during TaqMan search. 

Melting Temperature (Tm) - The temperature at which 50% of oligonucleotides 
are in duplex (and 50% single stranded), or 50% of a long molecule is in 
duplex and 50% partially melted.  For the default Tm calculations, 1 M salt 
(Na+ or K+, neutral pH) and 100 pM nucleic acid concentrations are used.  
The OLIGO program provides Tm values for oligonucleotides based on the 
"nearest neighbor" thermodynamic method that are in line with, but 
approximately four times more accurate, than the "2xAT+4xGC" method.  
Melting temperature calculations for longer nucleic acid molecules (50-100 nt 
and longer), however, are most accurately determined by the %GC method. 

Multiplex Primers - Primers that do not form 3'-terminal dimers with each other 
that are used for PCR in one incubation mixture.  The dimer stability threshold 
can be modified by changing search parameters. 

Nearest Neighbor - The most accurate method for calculating Tm of 
oligonucleotides; see Appendix D for the formulas. 

Negative Strand - A nucleic acid sequence complementary to the sequence 
loaded from a sequence file.  In OLIGO, it is displayed in blue on the "Melting 
Temperature" window. 

Nested Primer Pair -Two cross-compatible pairs, one positioned within the other, 
used to amplify a difficult template. 

OD Unit - The quantity unit for nucleic acids (and other light-absorbing 
compounds) based on light absorption.  One unit of nucleic acid dissolved in 
1 ml of a buffer gives an absorption of 1 using a spectrophotometric quartz 
cuvette with a 10 mm path length.  Approximately 30 OD260 is equal to 1 mg 
of single stranded DNA. 

Optimal Annealing Temperature (TaOPT) - The annealing temperature, calculated 
by OLIGO, that gives the highest product yield when no false priming and 
primer dimerization occurs.  Usually, with complex templates, the optimal 
annealing temperature is higher due to the increased likelihood of false 
priming.  In these situations, use Tamax, which is three degrees higher than the 
Tm of the less stable primer.  However, in certain circumstances (short 
primers, high GC template) using the Tamax may yield no product. 

Positive Strand - A nucleic acid sequence strand identical to the sequence 
loaded from a sequence file.  It is displayed on the "Melting Temperature" 
window. 
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Primer Extension Arrow - An arrow extended from the 3'-end of the 
Upper/Reverse Primer to show the potential polymerization direction. 

Priming Efficiency (P.E.) - This number is a formulation unique to the OLIGO 
program that quantifies the likelihood that a given oligonucleotide will prime at 
a given site on the active sequence.  The priming efficiency calculation is 
derived from an algorithm that considers mismatches, duplex stability, bulge 
loops, and the distance of these elements from a primer's 3'-end. 

Reverse Translation - Prediction of a DNA sequence from a protein sequence. 
Salt Concentration - The concentration of monovalent ions - sodium or 

potassium, for example, (but not magnesium). 
Search Stringency - The level at which the search parameters are set in the 

OLIGO program to select oligonucleotides optimized for the various search 
applications.  OLIGO gives the user six global stringency options that 
automatically set the eight individual search parameters in the "Search 
Parameters" window to appropriate pre-set values.  These stringency settings 
can be automatically relaxed to a lower global setting by the program in the 
event that no suitable oligo positions remain after a search. 

SSC - Sodium Chloride/Citrate Buffer. 1x SSC is 0.15 M NaCl in 0.015 M Sodium 
Citrate, pH 7.0 (NaOH). 

Td - the temperature at which 50% of a nucleic acid probe is retained on a 
hybridization filter after five minutes of incubation in 1 M salt.  A concentration 
of 100 nM oligo is used to calculate Td by the nearest neighbor method.  Note 
that Td may be used irrespective of salt and nucleic acid concentration (like 
the "2xAT+4xGC" and the %GC methods). 

Tm - Melting temperature, the temperature at which 50% of nucleic acid 
molecules are in duplex (and 50% denatured), when the equilibrium is 
reached.  Tm depends on salt, organic solvents and nucleic acid 
concentrations. 

Terminal Stability - Terminal stability is the free energy (⊗G) for an 
oligonucleotide's 3'-terminal end.  In OLIGO, the terminal stability is 
expressed ⊗G values of the 3'-pentamer in the Internal Stability window.  An 
oligo with a 3'-end that is too stable has a greater tendency to false prime.  
Too low a stability causes the primer to have a low priming efficiency.  Usually 
a value of approximately -7.5 kcal/mol/terminal pentamer is optimal. 

Upper Oligo - a positive strand oligonucleotide that has been selected for 
analysis.  The Upper Oligo can be manually selected by the user or 
automatically selected by OLIGO during TaqMan search. 

 
 

Appendix B:  PCR and Sequencing Primer Selection 
Criteria 

There are three essential considerations in selecting PCR primers: 
• The primer has the ability to form a stable duplex with the specific site on the 

target DNA 
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• The primer has no duplex formation with another primer molecule 
• The primer has no false priming sites on the target DNA 
Primer stability can be measured in terms of the length (base pairs), the GC/AT 
ratio (free energy expressed in kcal/mol), or in Tm (°C) of a DNA duplex.  The 
most accurate methods for computing helix stability are based on nearest 
neighbor thermodynamic parameters (1). 
Calculations of melting temperature (Tm) according to the nearest neighbor 
method is complicated, and therefore not practically determined without 
computer software.  A duplex stability measure of similar accuracy, however, 
may be achieved by a simpler method - by calculating the free energy of duplex 
formation.  (See Table 1 in Appendix D - Theories and Formulas Used in the 
OLIGO Program.) 

Internal Stability 
Primers that are stable at their 5'-termini but somewhat unstable on their 3'-ends 
perform best in sequencing and PCR reactions.  This primer structure greatly  

 
Figure B.1  Internal Stability Graph.  Primers B1 and B2 are poorly functioning.  Primers G1 and 
G2 are efficient sequencing primers.  Primers G1 and G2 perform better than average (with 
almost any other compatible primer) in PCR.  The ⊗G values were calculated for all pentamers in 
each primer.  The last symbol in each inset represents the ⊗G value of the 3'-terminal pentamer. 

reduces false priming on unknown sample sequence.  These findings, based on 
primer internal stability, are supported by the experimental data presented in 
Figure B.1 - Internal Stability Graph. 
A primer with low stability on its 3'-end will function well in PCR because the base 
pairings at and near the 3'-end with non-target sites are not sufficiently stable to 
initiate synthesis (false priming).  The 5'-end and the central part of the primer 
must also form a duplex with the target DNA site in order to prime efficiently.  
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Conversely, oligonucleotides with stable, GC-rich, 3'-termini need not anneal with 
the target along their entire length in order to efficiently prime, resulting often in 
non-specific product synthesis.  Examples of highly specific primers (G1 and G2),  
non-specific primers (B1 and B2) for PCR and sequencing are presented in 
Figure B.1. 
Note the high 3'-end stability of the non-specific primers and the low stability of 
the specific primers.  The optimal annealing temperature range is unusually 
broad when primers exhibiting low 3'-terminal stability are used.  This improves 
the chances of running PCR at optimal conditions without preliminary 
optimization experiments.  In addition to optimal primers, the quality of the PCR 
product is dependent on the enzyme and the reaction buffer composition, the 
active sequence (substrate complexity), the product length, the product Tm, and 
on PCR program times and temperature settings (particularly annealing). 
Under certain conditions, primers with high 3'-terminal stability perform 
satisfactorily in PCR.  Nevertheless, oligonucleotides with 3'-terminal pentamers 
less stable than -9 kcal/mol are more likely to be specific PCR and sequencing 
primers, particularly in complex samples. 

 

Appendix C:  Effect of Primer Duplex Formation on 
PCR and Sequencing 

PCR primers should be free of significant complementarity at their 3'-termini, as 
this promotes the formation of primer-dimer artifacts that reduce product yield.  
Formation of primer-dimer artifacts may also cause more serious problems, such 
as non-specific DNA synthesis due to an unbalanced primer ratio - asymmetric 
PCRs fail more frequently than "standard" reactions.  PCR yield dependence 
upon the ⊗G of 3'-terminal duplexes is illustrated in Figure C.1 - PCR Yields. 
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Figure C.1 PCR Yields.  Dependence of PCR yield upon the ⊗G of 3'-terminal primer 
duplexes.  The ⊗G values are calculated according to the equation VI (T set to 25°). 

The values shown in Figure C.1 are approximate since the PCR yield also 
depends on the annealing temperature, the specificity of primers, and other 
parameters not considered here.  The high dependence of yield on 3'-dimer 
formation tendency is the result of the very high processivity of thermostable 
polymerases.  Duplexes need not be stable to prime DNA synthesis.  Very little 
time is required for the enzyme to recognize a 3'-terminal duplex and start 
polymerization. 

In general, oligonucleotides forming intramolecular duplexes with negative ⊗G 
should be avoided.  Although self-complementary PCR primers with hairpin stem 
⊗G approaching -3 kcal/mol (at 25°) are suitable in certain cases, a hairpin loop-
forming primer is troublesome when its 3'-end is "tied up," since this can cause 
internal primer extension, eliminating a given primer from the reaction.  Hairpins 
near the 5'-end, however, do not significantly affect PCR.  Non-3'-end primer 
dimers are well tolerated in PCR.  Internal or 5'-terminal dimer ⊗G may approach 
-20 kcal/mol usually with only slight effects on PCR. 
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Appendix D:  Theories and Formulae Used in the 
OLIGO Program 

The OLIGO program algorithms take into account several formulae.  Many of the 
formulae used in the OLIGO program are described here. 
Tm - Melting Temperature, Nearest Neighbor Method 

The melting temperature of an oligonucleotide duplex (Tm
primer), is calculated 

using nearest-neighbor thermodynamic values (Formula I).  Since these values 

were obtained in 1 M Na+, it is necessary to add a factor to correct for salt 
concentration (3), resulting in the equation: 
 

Tm (°C) = DH/(DS + R * ln[C]) + 16.6 log [K+]/(1+0.7*[K+]) – 273.15 (I) 
 

Where ∆H and ∆S are the enthalpy and entropy for helix formation, respectively, 
R is the molar gas constant (1.987 cal/°C X mol), and C is the concentration of 
the probe.  Values of ∆H and ∆S used by OLIGO are listed in Tables 3 and 4.  
For the Tmprimer calculations in the PCR window, the expression C/4 is replaced 
by C since the primer and the active sequence concentrations are different.   
Td - Filter Dissociation Temperature 
For filter hybridization applications, the dimer dissociation temperature, Td, is 
calculated: 
  Td = Tm - k        (II) 
Where k is a temperature correction for filter hybridization, and in Ref. 4 it is 
equal to 7.6°C.  Recently, new thermodynamic values have been reported (5), 
eliminating the requirement for the k value (k = 0); therefore, Td = Tm (Tm 
calculated by nearest neighbor method).  The temperature for filter hybridization 
should be approximately 10°C lower than Td. 
 
The formula OLIGO uses for calculation of sodium equivalent of magnesium 
concentration is: 

  Na+ = 4 x [Mg2+]0.5       (III) 
The bivalent cathion concentration has a profound effect in Tm calculations (16). 
 

2xAT+4xGC Method 
Add 2° for each A and T and 4° for each G and C nucleotide.  This is the 
simpliest but the least accurate method for oligonucleotide Tm calculations.  Note 
that the concentration of nucleic acid is ignored.  To roughly match these Tm 
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values with the nearest neighbor method values, the oligonucleotide and salt 
concentrations  should be set (for the nearest neighbor method) at 100 pM and 1 
M, respectively. 
 

%GC Methods: 

Tm
product (Tm of Long DNA Duplexes) 

The Tm of long DNA duplexes (Tmproduct), required in calculating the optimal 
annealing temperature for PCR (TaOPT), cannot be derived from equation I since 
the nearest-neighbor model is not applicable.  Instead, the formula of Wetmur (3) 
is used: 
 

(V) 

RNA Tm Calculation 

OLIGO uses a similar equation for RNA Tm calculation (3): 
 

  (VI) 

DNA-RNA Hybrids 
The DNA RNA Hybrid formula is calculated according to the following equation: 
 

 (VII) 

Optimal Annealing Temperature, Ta
OPT 

In order to calculate optimum annealing temperature, TaOPT, a modified empirical 
formulation is used (6): 
 
 Ta

OPT = 0.3 * Tm
Primer + 0.7 * Tm

Product – 21    (VIII) 
 
in which Tm

Primer is the calculated Tm of the less stable primer-template pair and 
Tm

Product is the Tm of the PCR product (for primer Tm calculations its actual 
concentration in actual salt concentration should be used). 
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OLIGO calculates free energy (∆G) values according to the equation: 

∆G = ∆H - T∆S      (IX) 
Where H, S, and T are the enthalpy, entropy, and temperature, respectively.  The 
default temperature used by OLIGO is 25°C. 
 
Table 1.  Free energy values of a nearest neighbor nucleotide used by OLIGO (in 
kcal/mol X (-1); from Ref. 1 and 2; adjusted to 25°). 
Second Nucleotide 
→ 

dA dC dG dT A C G U 
 

First Nucleotide ↓ 
dA or A 
dC or C 
dG or G 
dT1 or U 

 
1.9 
1.9 
1.6 
1.0 

 
1.3 
3.1 
3.1 
1.6 

 
1.6 
3.6 
3.1 
1.9 

 
1.5 
1.6 
1.3 
1.9 

 
1.1 
2.2 
2.7 
1.4 

 
2.4 
3.3 
3.8 
2.6 

 
1.9 
2.2 
3.3 
2.2 

 
1.1 
1.9 
2.4 
1.1 

Initiation2 -3 -5 
 

1Not listed nucleotides are treated as dT. 
2Initiation ∆G value is not included OLIGO ∆G calculations. 
 
Although Oligo does not calculate Tms of PNA, you may find important 
guidelines in (7, 21). 
For example, pentamer d(AACTG) ∆G is: 
∆GAACTG = ∆G(AA) + ∆G(AC) + ∆G(CT) + ∆G(TG) = -(1.9+1.3+1.6+1.9) = -6.7 
kcal/mol 
For full value of ∆G, you’d need to add the initiation values (for both Gs at the 
ends, and the dangling end values, if present. 
 
 
Table 2.  Free energy values of dangling ends (from ref. 27) 
Explanation how to read the table: 
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Table 2, continued. ∆G values calculated for 37°C. 
 
 

Sequence Values for DNA 
dH [kcal/mol] dS [cal/mol °K] dG [kcal/mol] 

5ʼ-TT 0.2 2.3 -0.51 
5ʼ-GT -6.3 -17.1 -0.96 
5ʼ-CT -3.7 -10.0 -0.58 
5ʼ-AT -2.9 -7.6 -0.50 
5ʼ-TG 0.6 3.3 -0.42 
5ʼ-GG -4.4 -12.6 -0.52 
5ʼ-CG -4.0 -11.9 -0.34 
5ʼ-AG -4.1 -13.0 -0.02 
5ʼ-TC -1.1 -1.6 -0.62 
5ʼ-GC -5.1 -14.0 -0.72 
5ʼ-CC -3.9 -10.9 -0.56 
5ʼ-AC -4.2 -15.0 0.48 
5ʼ-TA -6.9 -20.0 -0.71 
5ʼ-GA -4.0 -10.9 -0.58 
5ʼ-CA -4.9 -13.8 -0.61 
5ʼ-AA -0.2 -0.5 -0.10 

    
3ʼ-TA -0.7 -0.8 -0.48 
3ʼ-TC -2.1 -3.9 -0.92 
3ʼ-TG -5.9 -16.5 -0.82 
3ʼ-TT -0.5 -1.1 -0.12 
3ʼ-GA 4.4 14.9 -0.19 
3ʼ-GC -0.2 -0.1 -0.23 
3ʼ-GG -2.6 -7.4 -0.31 
3ʼ-GT 4.7 14.2 0.28 
3ʼ-CA -1.6 -3.6 -0.50 
3ʼ-CC -3.9 -11.2 -0.44 
3ʼ-CG -3.2 -10.4 -0.01 
3ʼ-CT -4.1 -13.1 -0.01 
3ʼ-AA 2.9 10.4 -0.29 
3ʼ-AC -4.4 -13.1 -0.35 
3ʼ-AG -5.2 -15.0 -0.52 
3ʼ-AT -3.8 -12.6 0.13 
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Table 3.  Free energy values of hairpin loop formation used by OLIGO (in 
kcal/mol; from Ref. 2 and 9; extrapolated). 
Size ⊗G  Size ⊗G  Size ⊗G  Size ⊗G 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 

5.2 
4.5 
4.4 
4.3 
4.1 
4.1 
4.2 
4.3 
4.5 
4.9 

 13 
14 
15 
16 
17 
18 
19 
20 
21 
22 

5.2 
5.6 
5.8 
6.1 
6.4 
6.7 
6.9 
7.1 
7.3 
7.5 

 23 
24 
25 
26 
27 
28 
29 
30 
31 
>35 

7.7 
7.9 
8.1 
8.3 
8.4 
8.6 
8.8 
8.9 
9.1 
9.7 

 >40 
>45 
>50 
>55 
>60 
>65 
>70 
>80 
>90 
>100 

10.2 
10.6 
11.0 
11.3 
11.5 
11.7 
11.9 
12.1 
12.2 
12.3 

 
 

Hairpin Loop Tm 
Hairpin loop Tm is calculated according to the equation: 

Hairpin loop Tm = TG0 + 2.1 x log[salt] * (n-1)  (X) 
Where TG0 is the temperature at which ∆G of the structure is equal to 0, and n is 
the hairpin loop stem length.  This equation is based on data of Groebe and 
Uhlenbeck (9).  Inosine is known to destabilize duplex formation.  Although the 
thermodynamic data are not complete, OLIGO partially corrects loop ∆G 
calculations (based on Ref. 10): for T-I, G-I, and I-I base pairs values of 0.6, 0.8, 
and 0.9 kcal/mol are added to the total hairpin ∆G. 

Hybridization Time 
Hybridization Time is calculated according to the formula: 

T1/2 = N ln 2 / 3.5 * 105 * √L * CN    (XI) 
 

Where N is the total number of base pairs in a non-repeating sequence 
(molecular complexity), L is the probe strand length, and CN is the probe 
concentration (mol nucleotides/liter; 14). 
For simplicity, N = L, therefore,  

T1/2 = √L * ln 2 / 3.5 * 105 * C    (XII) 
 

Where C is probe concentration (moles/liter). 
 
 
 
 
 



 

 174 

Table 3.  Entropy values of a nearest neighbor nucleotide (in negative entropy 
units, -cal/°K/mol; from Ref. 1, 2, and 5). 
Second Nucleotide 
→ 

dA dC dG dT A C G U 
 

First Nucleotide ↓ 
dA or A 
dC or C 
dG or G 
dT1 or U 

 
24.0 
12.9 
13.5 
16.9 

 
17.3 
26.6 
26.7 
13.5 

 
20.8 
27.8 
26.6 
12.9 

 
23.9 
20.8 
17.3 
24.0 

 
18.4 
27.8 
35.5 
22.6 

 
26.2 
29.7 
34.9 
35.5 

 
19.2 
19.4 
29.7 
27.8 

 
15.5 
19.2 
26.2 
18.4 

Initiation 15.1 10.8 
1 Not listed nucleotides are treated as dT. 

Table 4.  Enthalpy values of a nearest neighbor nucleotide (in kcal/mol; from Ref. 
1 and 2). 
Second Nucleotide 
→ 

dA dC dG dT A C G U 
 

First Nucleotide ↓ 
dA or A 
dC or C 
dG or G 
dT1 or U 

 
9.1 
5.8 
5.6 
6.0 

 
6.5 
11.0 
11.1 
5.6 

 
7.8 
11.9 
11.0 
5.8 

 
8.6 
7.8 
6.5 
9.1 

 
6.6 
10.5 
13.3 
8.1 

 
10.2 
12.2 
14.2 
13.3 

 
17.6 
8.0 
12.2 
10.5 

 
5.7 
7.6 
10.2 
6.6 

1 Not listed nucleotides are treated as dT; ∆Hini = 0 

Table 5.  Extinction coefficient values (∑, in A260 units/µmol; from Ref. 11). 
Second Nucleotide → dA dC dG dT dl dN 

 
First Nucleotide ↓ 
dA  
dC 
dG 
dT 
dl 
dN1 

 
13.7 
10.6 
12.6 
11.7 
9.3 
12.1 

 
10.6 
7.3 
8.8 
8.1 
7.1 
8.7 

 
12.5 
9.0 
10.8 
9.5 
8.8 
9.4 

 
11.4 
7.6 
10.0 
8.4 
8.4 
9.4 

 
9.3 
7.2 
8.8 
8.1 
6.8 
8.7 

 
12.0 
8.6 
10.5 
9.4 
8.4 
9.9 
 

 A C G U I N 

 
A 
C 
G 
U 
I 
N 

 
13.7 
10.5 
12.6 
12.3 
9.3 
12.1 

 
10.5 
7.1 
8.7 
8.6 
7.1 
8.7 

 
12.5 
8.9 
10.8 
10.0 
8.8 
9.4 

 
12.0 
8.1 
10.6 
9.8 
8.3 
9.4 

 
9.3 
7.1 
8.8 
8.6 
6.8 
8.7 

 
12.2 
8.6 
10.5 
10.2 
8.4 
9.9 
 

 
dA 
dC 
dG 

 
15.4 
7.4 
11.5 

 
dT 
dl 
dN 

 
8.7 
7.2 
10.7 

 
A 
C 
G 

 
15.4 
7.2 
11.5 

 
U 
I 
N 

 
9.9 
7.2 
11.0 
 

1 Not listed nucleotides are treated as dN 
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Nearest neighbor method:  

∑ABCDE = [2 (∑AB + ∑BC + ∑CD + ∑DE) - ∑B - ∑C - ∑D] 
 
 
Table 6.  Molecular weight (Mr) values used by OLIGO. 
 
A 
C 
G 
U 
I 
N 

 
329.21 
305.19 
345.21 
306.17 
330.20 
321.44 

  
dA 
dC 
dG 
dT 
dl 
dN 

 
313.21 
289.19 
329.21 
304.20 
314.20 
308.95 
 

 
MrABCDE = MrA + MrB + MrC+ MrD + MrE + 18.02 (for H2O) 

 
 
Table 7.  Ambiguous bases which are recognized by the OLIGO program (12).  
For calculations of thermodynamic parameters, all ambiguous bases and inosine 
are treated as deoxythymidine. 
Symbol Meaning 

 
 
B 
D 
H 
I1 
K 
M 
N 
R 
S 
V 
Y 
W 
X1 

 
not A 
not C 
not G 
inosine 
G or T 
A or C 
A C G T 
A or G 
C or G 
not T 
C or T 
A or T 
A C G T 
 

1This symbol is not listed in Ref. 12. 
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Figure D1.  Tm dependence of oligonucleotides length and their GC contents.  Average Td values 
(100nM oligos and 1M salt).  For searching for sequencing and PCR primers subtract 9 degrees. 
This chart may be useful when setting the Tm or/and oligonucleotide search ranges manually. 

Table 8.  Restriction Endonuclease Cleavage Efficiency (13).  Linearized 
plasmids were incubated with the indicated enzymes (10 U/µg) for 1 h.  More 
conservative values are presented. 
 
Enzyme Base 

Pairs 
from End 

Cleavage 
Efficiency [%] 

Enzyme Base 
Pairs 
from 
End 

Cleavage 
Efficiency 
[%] 

Aat II 1 95 Hind III 2 91 
Aat II 2 100 Hind III 3 90 
Aat II 3 88 Kas I 1 93 
Acc 65 I 1 75 Kpn I 1 99 
Acc 65 I 2 99 Mlu I 2 99 
Afl II 2 13 Mun I 2 100 
Age I 1 100 Nco I 2 100 
Apa I 2 100 NgoM IV 2 100 
Asc I 1 97 Nhe I 2 82 
Avr II 1 100 Not I 1 98 
BamH I 1 97 Not I 4 100 
Bgl II 3 100 Nsi I 2 95 
BsiW I 2 100 Pae I 1 75 
BspE I 1 8 Pac I 1 76 
BspE I 2 100 Pme I 1 94 
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BsrG I 1 88 Ppu10 I 3 98 
BssH II 2 100 Pst I 1 37 
BstX I 1 >70 Pst I 3 98 
Cfr9 I 0 95 Sac I 1 99 
Cla I 1 >70 Sac II 3 >70 
Dra II 3 >70 Sal I 3 89 
Eag I 2 100 Sfi I 1 93 
Eco24 I 1 80 Sma I 1 >70 
Eco88 I 0 100 Spe I 2 100 
EcoR I 1 100 Sph I 1 92 
EcoR V 1 50 Sph I 2 99 
Ecl136 II 1 100 Xba I 1 94 
Hinc II 1 33 Xho I 1 97 
Hind III 1 0 Xma I 2 92 
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Appendix E:  Amino Acid Symbols 

Nondegenerate Amino Acid Symbols 
 
Symbol Name of Amino Acid 
A   Alanine 
C   Cysteine 
D   Asparatic Acid 
E   Glutamic Acid 
F   Phenylalanine 
G   Glycine 
H   Histidine 
I   Isoleucine 
K   Lysine 
L   Leucine 
M   Methionine 
N   Asparagine 
P   Proline 
Q   Glutamine 
R   Arginine 
S   Serine 
T   Threonine 
V   Valine 
W   Tryptophan 
Y   Tyrosine 
-   Termination Codon 
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Degenerate Amino Acid Symbols  
(Used in Search for Restriction Sites in Protein) 

 
Symbol Amino Acid Equivalent 
 
a   CW- 
b   DE 
c   FL 
d   HQ 
e   IM 
f   KN 
g   RS 
h   Y- 
r   FLIV 
s   GR- 
t   LIV 
u   LMV 
v   KEQ- 
w   PAST 
x   SRGC 
y   YNDH 
z   WRG 
1   AEGIKLPQRSTV- 
2   AEGKLMPQRSTVW- 
3   ACDFGHILNPRSTVY 
4   SKRIMNT 
5   VADEG 
6   QRLPH 
7   SYFLCW- 



 

 180 

Appendix F:  References 

 
1. SantaLucia J., Jr (1998),"A unified view of polymer, dumbbell, and 
oligonucleotide DNA nearest-neighbor thermodynamics," Proc. Natl. Acad. Sci. 
USA 95, 1460-1465.  
2. Xia, T, SantaLucia J., Jr., Burkard, M.E., Kierzek, R., Schroeder, S.J., 
Jiao, X., Cox, C., and Turner, D.H. (1998), "Thermodynamic parameters for an 
expanded nearest-neighbor model for formation of RNA duplexes with Watson-
Crick base pairs" Biochemistry 37, 14719-14735. 
3. Wetmur, J.G. (1991) "DNA Probes: Applications of the Principles of 
Nucleic Acid Hybridization," Criti. Rev. in Biochem. and Mol. Biol. 26, 227-259. 
4. Rychlik, W. and Rhoads, R.E. (1989) "A computer program for choosing 
optimal oligonucleotides for filter hybridization, sequencing and in vitro 
amplification of DNA," Nucleic Acids Res. 17, 8543-8551. 
5. Sugimoto, N. (1993) "Relationship between Structure and Function of 
Nucleic Acids: The Study Using Nearest Neighbor Parameters," Konan University 
internal publication (Kobe, Japan) 33, 61-67. 
6. Rychlik W., Spencer, W.J., and Rhoads, R.E. (1990) "Optimization of the 
annealing temperature for DNA amplification in vitro," Nucleic Acids Res. 18, 
6409-6412. 
7. Griffin, T.J. and Smith, L.M. (1998) "An Approach to Predicting the 
Stabilities of Peptide Nucleic Acid: DNA Duplexes," Analytical Biochemistry 260, 
56-63. 
8. Suggs, S.V., Hirose, T., Miyake, E.H., Kawashima, M.J., Johnson, K.I., 
and Wallace, R.B. (1981) "Using Purified Genes" in ICN-UCLA Symp. Dev. Biol., 
D.D. Brown (ed.), Academic Press Inc., New York, Vol. 23, pp. 683-693. 
9. Groebe, D.R. and Uhlenbeck, O.C. (1988) "Characterization of RNA 
hairpin loop stability," Nucleic Acids Res. 16, 11725-11735. 
10. Martin, F.H., Castro, M.M., and Tinoco, Jr. I. (1985) "Base pairing 
involving deoxyinisine: implications for probe design," Nucleic Acids Res. 13, 
8927-8938. 
11. Handbook of Biochemistry and Molecular Biology (1975) Fasman G.D., 
ed., 3rd edition, Nucleic Acids - Vol. 1, pp 589, CRC Press, Cleveland, OH. 
12. Nomenclature Committee of the International Union of Biochemistry 
(1985) "Nomenclature for incompletely specified bases in nucleic acid 
sequences," Eur. J. Biochem. 150, 1-5. 



 181 

13. New England BioLabs, 2007/08 Catalog, "Cleavage close to the end of 
DNA fragments," p. 331; MBI Fermentas Catalog 96/97, p. 112; Stratagene 
Catalog 1997/98, p. 284. 
14. Lathe, R. (1986) "Synthetic Oligonucleotide Probes Deduced From Amino 
Acid Sequence Data; Theoretical and Practical Considerations," J. Mol. Biol. 183, 
1-12. 
15. Meinkoth, J. and Wahl, G.  (1984) "Hybridization of Nucleic Acids 
Immobilized on Solid Supports," Analytical Biochemistry, 138, 267-284. 
16. Wetmur, J.G.  (1994).  Personal Communication on Magnesium 
Concentrations. 
17. Barany, F.  (1991).  "Genetic Disease Detection and DNA Amplification 
Using Cloned Thermostable Ligase," Proc. Natl. Acad. Sci. USA, Vol. 88, 189-
193. 
18. Wada, K., Wada, Y., Ishibashi, F., Gojobori, T., and Ikemura, T. (1992) 
"Codon Usage Tabulated from the GenBank Genetic Sequence Data," Nucleic 
Acids Research, Vol. 20, Supplement, 2111-2118. 
19. Nakamura, Y., Gojobori, T., and Ikemura, T. (1998) "Codon Usage 
Tabulated from the International DNA Sequence Databases," Nucleic Acids 
Research, Vol. 26, No. 1, Database Issue, 334. 
20. Steffens, D.L., Sutter, S.L., and Roemer, S.C. (1993) “An Alternate 
Universal Forward Primer for Improved Automated DNA Sequencing of M13”, 
BioTechniques 15, 580-582. 
21. Giesen, U., Kleider, W., Berding, C., Geiger, A., Orum, H. and Nielsen, 
P.E. (1998) “A Formula for Thermal Stability (Tm) Prediction of PNA/DNA 
Duplexes”, Nucleic Acids Research 26, 5004-5006. 
22.  Khvorova, A., Reynolds, A, and Jayasena, S.D. (2003) “Functional siRNA 
and miRNAs Exhibit Strand Bias”, Cell, 115, 209-216. 
23.  Lipman, D.J., and Pearson, W.R. (1985) Science, 227, 1435-1441. 
24. National Institute of Standards and Technology Link: 
http://yellow.nist.gov:8444/dnaAnalysis/index.do 
25.  Wiedmann M, Wilson WJ, Czajka J, Luo J, Barany F, Batt CA. (1994) 
Ligase chain reaction (LCR)-overview and applications in PCR Methods Appl. 
Feb;3(4):S51-64. 
26.  Rychlik, W. (2007) OLIGO 7 Primer Analysis Software, in Methods in 
Molecular Biology Vol. 402: PCR Primer Design; Ed. A. Yuryev; Humana Press 
Inc., Totowa, NJ. pp. 35-59. 
27.  Bommarito, S., Peyert, N., and SantaLucia Jr. J. (2000) Thermodynamic 
parameters for DNA sequences with dangling ends, Nucleic Acids Research, 28, 
1929-34. 



 

 182 



 183 

14 Tutorial & Examples 

1 Oligo 7 Installation        184 
1.1.  Installation         184 
1.2.  Registration        184 

 
2 File Opening and Viewing       187 

 2.1.  Open a sequence file       187 
 2.2.  Open a database file       189 

 
3 Navigating in OLIGO        190 

3.1.  Moving around a sequence file      190 
3.2.  Changing windows appearance      191 
3.3.  Open and Print all relevant windows with one mouse click  193 

 
4 Search for Primers and Probes      194 

4.1.  Searching for PCR primers, a simple search    195 
4.2.  Searching for PCR primers, an example to show the options 195 
4.3.  Searching for sequencing primers     196 
4.4.  Searching for consensus hybridization probes    196 
4.5.  Searching for TaqMan Probes & PCR Pairs    198 
4.6.  Searching for Molecular Beacons & PCR Pairs   198 
4.7.  Searching for siRNA Probes      199 
4.8.  Searching multiple files (batch processing)     199 
4.9.  Searching multiple files for PCR primer pairs and than 

              multiplexing the selected sets      200 
4.10. Searching a file for probes only in the selected regions  201 

 
5 Other Search Options        203 

5.1.  Search for a sequence string      203 
5.2.  Search for restriction enzyme sites     204 
5.3.  Search for restriction enzyme sites in protein    204 



 

 184 

1.  Oligo 7 Installation 

1.1.  Installation 
Oligo software can be installed only if you have administrator privilages for this 
particular computer.  If you cannot save files to the Program Files or Applications 
Folder you need to log out and log-in with the account that has administrator 
privileages or ask your IT manager to install Oligo for you. 

1.1.1.  Installation form the Internet 
Download the zipped Oligo package, Oligo7Mac_Installer.zip (Macintosh), or 
Oligo7Win_Installer.zip (Windows) to your hard drive.  Some systems unpack the 
files automatically, and some require manual unzipping.  Double click on the zip 
file to unpack the contents.   
Double click on the Oligo7Mac_Setup installer package (Mac; sometimes you 
see the ".pkg" at the end of the name), or on the Oligo7Win_Setup (PC; 
sometimes you see the ".exe" at the end of the name) to start the installation 
process, and follow the on-screen instructions.  In Macintosh, Oligo is installed in 
Oligo sub-folder in the Applications folder.  In PC, the default folder is C:\Program 
Files\Oligo 7.  Start Oligo 7, fill out the registration form and register it, as 
described in Chapter 1.2. 

1.1.2.  Installing OLIGO from a Compact Disk 
To load the OLIGO program to your hard drive: 
1.  Insert the Oligo 7 Disk into computer's CD drive. 
2.  Mac: double click on Oligo7Mac_Setup.pkg installer package, and follow the 

instructions displayed on screen.   
  PC: Double click on the Oligo7Win_Setup.exe icon displayed in the CD drive 
window.  Follow the on screen instructions.  You would be asked for the folder 
name and location of the Oligo 7 application. 

3.  Once the installation is complete, double click on the Oligo 7 icon to start it 
and register your program license.  Alternatively you can start Oligo by 
choosing "Start" from the desktop, followed by "Programs".  

1.2.  Registration 
In order to protect your copy of the OLIGO program and provide you with prompt 
technical support, we need you to register as an OLIGO user with your distributor 
prior to accessing OLIGO or seeking technical support.   
The registration form takes a few minutes to complete and you should receive 
your access code within an hour after contacting your distributor during normal 
business hours. 
Each installation creates a unique workstation code, so you will need to register 
each computer separately.   
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To register your OLIGO software on a computer, please follow these steps: 
1.  Double-click on the OLIGO icon to call up the registration procedures. 
2.  Once the "Customer Registration" window appears, complete each field.  Use 

either the mouse or <Tab> to move to each field.  This window must be 
completed for each workstation you are registering (See the figure below)  
Your e-mail address must be entered to make the “Register” button active.  
The Fax number should be entered only to get the “Print” button active.  
Leave the Access Code field blank. 

 
The OLIGO Customer Registration window. 

Note:  Your software license number is on the OLIGO CD, User Manual or/and in 
the e-mail conformation of the purchase. 

 

3.  When you enter the license number the “Register” button should become 
active, as shown below. 
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If you’re connected to the the Internet, click the “Register” button at this point.  

The registration e-mail will be sent to MBI automatically, and upon its 
completion the window should display the message “Registration form 
successfully sent”.  If you perform the registration during the MBI's normal 
operation hours (Monday through Friday, h: 8-16, Mountain Time), expect the 
returning Access Code within an hour.  Otherwise, you may Exit the Oligo and 
start it again at later time, when you’d receive the Access Code.  Click the 
“OK” button to exit. 

3a. If your network does not permit Oligo to send e-mails to us, press the Save 
button, and this saved text file attach to your e-mail and send it to 
mbisupport@oligo.net.  No screen shots, please. 

3b. If your computer is not connected to the Internet, please print out the 
Registration Form by clicking the Print button, and fax it to MBI:  
+1 719 684 7989. 

4.  When you receive the Access Code from MBI, go back to the registration 
window by bringing it to the front or by re-starting Oligo, enter it to the “Access 
Code” box, and click the “Confirm Code” button.  The registration process is 
complete. 

To register your second and following computers, you need to complete the 
same registration process each time.  Any further updates are automatic but may 
be also performed by using Oligo's Help menu. 
Note: If you ever need to re-load OLIGO, write this message to the Comments 

field. 
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2.  File Opening and Viewing 
The tutorials in this section give you an opportunity to learn how the features of 
the OLIGO software can assist you in your research.  Some of the tutorial 
examples are intended to provide a general guide from which you can construct 
your specific application.  Others are specific, so that you can duplicate, if you 
wish, similar results (similar, not exact, because future revisions of the software 
may be slightly different in default parameters). 
Note: if you want to duplicate the results in the search examples, open Human 

eIF-4E.seq for your sequence file.  It is located in the Oligo 7 folder i Test 
sequences subfolder.  Oligo example database is in Oligo 7 folder (universal 
primers.odb). 

2.1.  Open a sequence file 
Oligo opens variety of file types, such as DNA, RNA, protein sequences and 
databases.   
1.  Choose File - Open from the File menu. 
2.  Navigate to the "Test sequences" folder by clicking at the bar displayed at the top of the 

window. 
3.  At he bottom of this window you may choose a file format available to you.  The default is 

"Nucleic Acid", so that the DNA and RNA sequence files can be opened instantly by clicking 
on the "Open" button.  However, when you click on the "Nucleic Acid" pull down menu, you 
would get this: 

 
and you would be able to choose any of the three types of files.  If youʼd choose "All Files" 
Oligo would show a slightly different window (shown below) from which youʼd need to choose 
the kind of file with “Open As” pull down menu. 



 

 188 

 
 

4.  By choosing Format "Protein" and than choosing "Human eIF-4E.ami" you would open this 
protein file and automatically reverse-translate it to DNA.  The default reverse translation 
method is Lathe (choosing most probable codons for human proteins), but if before opening a 
protein file you would "Change - Rev. Translate Method" to "Degenerate", you would end up 
with an entirely different DNA sequence - this time a degenerate one.  Please try it. 

5.  When you open a protein sequence file in a degenerate mode, you'll see lots of degenerate 
nucleotide symbols in the Sequence window, but the translation will not look exactly like the 
original amino acid file because some degenerate symbols would cover more than one amino 
acid kind.  Instead of arginine symbol, "R", for example, you will get low case "r" indicating 
that arginine is most likely, but also that some other amino acid ma exist at certain position. 

6.  Choose "Melting Temperature Graph" from the Analyze menu. 
7.  Click at the "graph" ( ) button and choose "Degeneracy".  You should get this window: 

 
8.  At this point the scale displays degeneracy.  Those numbers are usually high for a default size 

of Current Oligo of 21 bases.  To get more manageable degeneracy change the Current Oligo 
length, using the Change menu, to 17.  At this time you should be able to find oligos with 
relatively low degeneracy. 
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9.  Click on the Analyze menu.  Note that in place of former "Melting Temperature Graph" item 
you'd find "Degeneracy Graph".  You may change the display back to tm analogously as 
described in point 7. 

2.2.  Open a database file. 
1.  Choose File - Open from the File menu. 
2.  Choose "Oligonucleotide Database" as File Format. 
3.  The "Test sequences" folder doesn't have any database files, so all the files are greyed-out.  

Go up one folder higher by choosing Oligo 7 folder form the top menu. 
4.  Open "universal primers.odb".  You should see the database window: 

 
5.  Click on record #3.  From the table you can read that it forms a 3'-dimer of 4 kcal/mole, and 

that this value is above the parameters threshold (to change the thresholds you'd have to use 
"Options" button). 

6.  To see the actual dimer go to the Analyze menu (database has a different Analyze menu) and 
choose "Duplex Formation".  When you check this window you may close it. 

7.  The database has a powerful multiplexing option.  Click on "Analyze - Multiplex All - 
Oligonucleotides - Minimize Reaction #".  Oligo automatically finds compatible oligo sets 
among the entries labeled "SC", that stands for Self-Compatible.  You may view those sets by 
clicking on the triangles located at the lower right: 

 
The example above shows Group 1, consisting of oligos # 2,6,9, and 10 in the database.  All 
those four oligos do not form 3'-end dimers among themselves within currently set search 
parameters in the Database Options. 
Note: if your database contains probes instead of primers, you need to change the 
multiplexing mode from checking for 3'-dimers to checking homology (or rather inverse 
homology) to find out what probes stick to each other. In this case, use the Change menu, 
and choose "Multiplexing Mode -> Probes: check homology": 

 
8.  Let's make a new set of primers in the database.  From the Edit menu choose "Add Set".  The 

lower part of the window changes and shows four edit boxes, under "Enter Record #'s". 
9.  Enter to the Forward Primer box "9" and to Reverse enter "10".  The "Add" button activates. 
10  Click the "Add" button, followed by "Show All" button. 
11.  You should see a new row added to the database.  If the window is not tall enough, use the 

slider (a dot separating individual oligo entries from sets), and drag it up. 
12.  Close the Database window without saving. 
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3.  Navigating in Oligo 
Note: if you want to duplicate the results in the search examples, open Human 

eIF-4E.seq for your sequence file. 

3.1.  Moving around a sequence file. 
After the registration, described in the User Manual, Chapter 2.3, you may open 
a sequence file or a database.  This example describes how to move around and 
what features are immediately available to you after opening a sequence file. 
1.  Open a sequence file: use File-Open, and in the "Test sequences" Folder choose Human eIF-

4E.seq.  Click on the "CDS" row displayed at the top right of the window.  You should see the 
Sequence window, as depicted on the figure below: 
 

 
Clicking on "CDS" highlighted the coding region of eIF-4E DNA sequence (it is actually the 
mRNA sequence reverse transcribed to DNA) 

2.  Move the horizontal bar.  You will notice that the yellow-shaded box moves around the Tm 
graph.  Sequence in this box is displayed at the bottom of this window.  Click on any 
nucleotide displayed this window - you just changed the Current Oligo position.  All the 
features of the Sequence window are described in the Manual, Chapter 2.5.  You may move 
down or up the sequence using the keyboard (arrows, page up or down). 

3.  Keep the Sequence window opened, and choose "Open Reading Frames" from the Analyze 
menu.  If you click on any nucleotide position you also change the Current Oligo position: 
observe the Sequence window while playing with the ORF window.  You may change the 
reading frame just by clicking on the open reading frames displayed in the top portion of the 
ORF window. 

4.  Close the ORF window (for clarity) and open the Melting Temperature Graph and/or Internal 
Stability - Current Oligo windows from the Analyze menu.  Note that by clicking on the 
nucleotide symbols or the graph itself you are actually moving to the new positions.  If you 
zoom out the Tm window, by clicking on the loupe symbol with "-" sign, you still can change 
the Current Oligo position by clicking on the graph. 

5.  Close all but the Sequence window and choose "Selected Bases" from the Search menu.  You 
will see 4 columns there.  "Loops" (showing strong stems of the sequence) and "Strings" 
columns are empty, because you haven't searched yet for the strings, and there are no strong 
stems (below -12 kcal/mol: a default search parameter setting for "Template Loop ΔG 
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Threshold" with the "Template Loop Window Size" of 40 nt.) in this DNA sequence file.  
Columns (Hairpin loop) "Stems" and "Palindromes" are filled with numbers, as those 
searches are initiated automatically as soon as you open a sequence file.  By clicking on any 
of those numbers you change the Current Oligo position. 

6.  Another method to change the Current Oligo position is to open the  "Select New Current Oligo 
Position" from the Select menu and entering the desired position number. 

7.  Make a quick search for Sequencing Primers (Search -> for Primers & Probes...-> click 
"Sequencing Primers" followed by "Search" buttons).  After the search you'll see the Analyze -
> Selected Oligonucleotides window.  You may also select the Current Oligo by clicking on 
any row displaying Forward or Reverse Primers.  By double clicking on these primers in the 
Selected Oligonucleotides window you will not only change the Current Oligo position, but 
also you will select the actual primer (observe the Sequence window how it changes). 

3.2.  Changing windows appearance 
The display of certain windows can be customized.  The Edit windows, for 
example have two display modes, as well as all the Analyze windows with the 
"Options"  button. 
1.  Open the Edit - Entire Sequence window. You should get the "Full Screen Edit" window. 
2.  This window has its own menu.  Click on Edit item.  You should see the following menu: 

 
3.  Note a dot by the "Full Screen Edit".  It indicates the current window style. 
4.  Click on the "Mutagenesis" item.  The window changes its appearance (see the following 

figure).  If you'd be editing a primer, this type of window would open automatically. 
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5.  Close the Edit window and open the Melting Temperature window. 
6.  Click on the "Options" button.  You should see this: 

 
7.  Click on the "Bars".  Now the Tms of the oligos is displayed as bars instead of dots.  This type 

of change is available on Internal Stability and Sequence Frequency windows as well. 
8.  Click on the small graph icon ( ).  You should see this menu: 

 
At this point you may choose a different kind of Current Oligos representation.  The default 
was "tm", showing melting temperature graph of oligos without dangling ends.  Tm(+) shows 
the same but with the dangling ends, and Tm(-) shows Tm with dangling ends of oligo 
complements.  Similarly, "ΔG(+)" and "ΔG(-)" shows free energy graph with dangling ends of 
Current Oligos and their complements, respectively, while "Δg" represents the standard 
values, without the dangling ends.  "CG%" shows the CG content, and Degeneracy (active 
when the sequence is degenerate) shows the number of possible sequence combinations. 
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9.  Close the Melting Temperature window and open the Open Reading Frames window.  When 
you click the "Options" button, you'll be able to change  

 
the meaning of open reading frames color coding from amino acid type to codon frequency. 

10.  Note a slide button at the top left of the ORF window:  
By dragging it to the right you'll see zooming in the ORF graph.  This feature is very useful 
when the opened sequence is large. 

 

3.3.  Open and Print all relevant windows with one mouse click 
You can open or print all the windows of your choice with just a one click.  To set 
this up you need to: 
1.  Open the File – Print/Save Options window. The default is to print or save only the top 

(current) window, as shown below. 

 
2.  Click the “Selected” button, and than check the appropriate boxes. In this example, we check 

the Key Info for the Forward and Reverse primers and Duplex Formation windows for the 
Forward, Reverse and mixed primers, and also weʼve changed a different database print 
output to Full Analysis and the Multiplexing data, as shown below.   

 
3.  Click the OK button.  From now on, the short cut key Ctrl-X (Windows) or Command-X (Mac) 

is activated (see the last item of the Analyze menu), so with this keystroke you will open all 
the windows that youʼve checked, of course if youʼve previously selected the primers.  Saving 
Results will also save multiple windows data. 
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4.  Search for Primers and Probes 
This section describes methods in searching primers and probes, the "Search - 
for Primers & Probes..." menu item. 

 
Take a quick look at the Search for Primers dialog window.  At the top you see 
two tabs, Search Options and Subsearches.  Below this there are two check 
boxes - if both checked the search will proceed in both DNA strands.  The 
Search Mode is set to "Select", that is, the search will start from scratch, and not 
continue on already selected primers (that's the "Verify" mode).  If you uncheck 
the "Complex Substrate" box, good when working with plasmids, not with total 
organism DNA, a sub-search to eliminate frequent oligos will not take place.  
Below this box, you see a list of possible search types that Oligo can perform.  
Buttons on the right: the "Search" button starts the actual search, "Cancel" closes 
the window, and "Apply" memorizes the current type of search, so that when you 
"Cancel" the window and come back to it you'd see the most recent setting.  
"Apply" also sets the search parameters and accordingly, modifies the Sequence 
and other relevant windows.  Button "Parameters" opens the search parameters 
windows, including windows that define the stringencies and scoring system.  
Button "Ranges" opens a complex  dialog that controls not only the search 
ranges, but the number of results you need within the ranges.  Button "Defaults" 
changes all parameters to the default values.  This chapter will guide you through 
various search types. 
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4.1.  Searching for PCR primers, a simple search 
This example takes you through a quick search for a pair of optimal PCR 
primers. To run this search, open Human eIF-4E.seq file and: 
1. Choose the "Primers and Probes" option from the "Search" menu. 
2.  Verify that the "Compatible Pairs" button under "PCR Primers" in the dialog box is checked. 
3.  Click "Search" to start the search.  The "Search Status" progress window appears, and the 

message "Search Completed" appears when the search is complete.  
4.  When the search is complete, two windows open: "Oligonucleotide Sets" and "Selected 

Oligonucleotides".  You may also check the "Primers & Probes Search Data" (from the 
Search menu) window to make sure that the final search stringency is acceptable.  OLIGO 
automatically reduces search stringency if it does not find any compatible pairs. 

5.  There are six sort options on the "Oligonucleotide Sets" and "Selected Oligonucleotides" 
windows.  The sort order is indicated in the figure below by red arrows: 

 
You may change the sort order by simply clicking at the column name.  Option-click (or Alt-
click) allows for multiple sorts.  You may also sort the data by product length or any other field 
not sorted in the example above. 

9.  Click on a primer pair to select this primer pair or double click on a pair to view the "PCR" 
window for the selected pair. 

10. Choose the primers from the Analyze - Key Info menu or other Analyze menu windows to 
view the primer sequence and/or related data. 

4.2.  Searching for PCR primers, an example to show the options 
1. Choose the "Primers and Probes" option from the "Search" menu. 
2.  Verify that the "Compatible Pairs" button under "PCR Primers" in the dialog box is checked. 
3.  Click the "Parameters" button.  At this point you see the General Parameters, as indicated at 

the top of the window: 

 
This will let you change the search stringency globally, change sequence frequency table and 
salt and primers concentration in the reaction mix.  By default, the stringency search is set to 
"High".  If you experience a long search time, you may shorten the search by starting from a 
lower stringency type.  Otherwise, Oligo will reduce the stringency automatically if needed, as 
long as the "Automatically change stringency" box is checked: 

 
4.  Choose the "Fair" search stringency. 
5.  Check the "Constraints" and "More Constraints" options.  Each sub-search option that will be 

active for a given search method has a blue dot on the left.  The irrelevant sub-searches have 
no blue dots.  To the right of this dot you should see an open or closed lock.  This represents 
whether a given parameter can be changed during automatic stringency search.  You may 
wish to permanently fix a specific parameter to the displayed value by clicking on an open 
lock.  The lock should close.  Some parameters Oligo is not able to change automatically.  
These sub-searches are labeled with grey-out locks.  The image below shows one of the sub-
searches in the "More Constraints" window 
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This is active parameter for Compatible Pairs search (blue dot on the left) and the automatic 
stringency may change it, if necessary.  For sake of this example, increase this value to -6 
kcal/mol and lock this value, and click "OK".  You've just set the parameter of a sub-search 
that will eliminate all the PCR products (not the primers!) that would make a hairpin with a ΔG 
larger than -6 kcal/mol, with the size of this hairpin not larger than 40 nt. (if the "Template 
Loop Window Size" was set to 40 nt).  Note that this test sequence has only one loop like this 
around pos. 160-200 (Sequence window marks it in maroon color). 

6.  Click the "Ranges" button.  Instead choosing the search ranges manually, click the "Check 
Region(s)" button. 

7.  From the "Features" window select the #2: CDS (coding sequence), so you should see this: 

 
and click the "Accept" button. 

8.  Check the "Find products in checked region(s) only" box. 
9.  Check also the box "No multiple products in one sequence region" and "Cover the entire 

search area with" "Overlapping products". 
10. Change the PCR product length to "150 to 300". 
11. Click the "OK" button.  You should get just the coding region covered with PCR products, and 

the hairpin loop in the template gone from any PCR products. 

4.3.  Searching for sequencing primers 
1. Choose the "Primers and Probes" option from the "Search" menu. 
2.  Click on "Sequencing Primers" button 
3.  Choose the DNA strand the primers should be made of: leave checked "Search in: + Strand" if 

you want primers to sequence forward (they would be annealing to the negative strand), and 
uncheck the "- Strand". 

4.  Choose the region you want the primers located: click the "Ranges" button and type "Positive 
strand search range:" 400 to 450.  The negative strand search range is irrelevant. 

5.  Make sure the "No overlapping primers/probes" box is checked if you want to avoid multiple 
choices of almost identical primers. 

6.  Click "OK" button. 
7.  Click the "Search" button.  You should get only one primer in the "Selected Oligonucleotides" 

window.  
8.  Double click on this primer in the "Selected Oligonucleotides" window.  You've just selected a 

sequencing primer. 

4.4.  Searching for consensus hybridization probes 
1. Choose the "Primers and Probes" option from the "Search" menu. 
2.  Click on the "Hybridization Probes" button 
3.  Click on the "Subsearches" tab at the top of the window. 
4.  Click on the "Consensus Probes" box at the bottom of the window.  A new window "Select 

Files" pops out, and you need to select other homologous sequences. 
5.  Click the "Add" button and navigate to the Test sequences folder, supplied with the software 

(by default it is located in the Oligo 7  folder in the Applications folder). 
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6.  Choose the files as shown on the image below: 

 
by repetitively clicking on a file name and the "Add" button. 

7.  Click the "Done" button and return to the "Select Files" window.  The window should look 
similar to the one depicted above. 

8.  You may click "OK" now, but if you'd like to memorize this set so that you can use it at later 
time, click the "Save Set" button and give it a descriptive but short name, than click "OK". 

9.  Go back to the "Search for Primers & Probes", and click the "Search button". 
10. The results are displayed in the "Selected Oligonucleotides" window.  Sort it by "Oligo 

Position" by clicking on the "Oligo Position" title. 
11. Double click on the second oligo (pos. 57).  You've just selected a non-degenerate probe.  

You may check it on any relevant Analyze windows.  In the top right of the Selected 
Oligonucleotides window there is a check box "Select consensus oligos".  If it's checked, the 
selected probe would contain a few degenerate bases.  This is because it is a consensus 
probe.  You may check the alignment by dragging up the dot located at the bottom center of 
the "Selected Oligonucleotides" window, see below: 

 
Note that the mismatches with the File 1 (the principal sequence) are marked in red. 
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4.5.  Searching for TaqMan Probes & PCR Pairs 
1. Choose the "Primers and Probes" option from the "Search" menu. 
2.  Click the " TaqMan Probes & PCR Pairs" button. 
3.  Click the "Search" button.  The sets are found and displayed in the "Oligonucleotide Sets" 

Table. 
4.  Click once on a set to select it, or click twice to choose it and open the PCR analysis window 

at the same time. 
5.  If you don't like the default Tm difference between the primers & the probe, before the search 

you may alter it by changing the "Tm of Probe - Tm of Primer" search parameter in the 
"Constraints" window. 

6.  If you need only a specific DNA region to work with, before the search you may set the search 
range by choosing it from the "Search Ranges" window (click the "Ranges" button and enter 
the positive and negative strand search range in the top of the window, following by the "OK" 
button). 

4.6.  Searching for Molecular Beacons & PCR Pairs 
1. Choose the "Primers and Probes" option from the "Search" menu. 
2.  Click the " Molecular Beacons & PCR Pairs" button. 
3.  Click the "Search" button.  The sets are found and displayed in the "Oligonucleotide Sets" 

Table. 
4.  Double click on a set to select it and open the PCR analysis window at the same time.  Note 

that you get a seemingly disturbing comments "The Upper Oligo does not match the 
template" and "3'-end Upper Oligo dimer".  This is a sign that the beacon probe was selected 
successfully.   

5.  To see the alignment with the template choose the Sequence window and move the horizontal 
scroll bar to see the probe: 

 
6.  View the probe under various Analyze windows, especially Analyze - Hairpin Formation - 

Upper Oligo. 
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4.7.  Searching for siRNA Probes 
1.  Open Human eIF-4E.seq. 
2.  Choose "DNA to RNA" from the "Change" menu. 
3.  Choose the "Primers and Probes" option from the "Search" menu. 
4.  Click the " siRNA Probes" button. 
5.  Click the "Search" button.  The oligos are found and displayed in the "Selected 

Oligonucleotides" Table. 
7.  Double click on the first record.  You've selected the sense strand of a siRNA probe. 
6.  Choose "Lower Oligos" from the pull down menu (top left of the window). 
7.  Double click on the first record.  You've selected the antisense strand of a siRNA probe. 
8.  Check the Internal Stability window ("Analyze"- "Internal Stability" - "Lower Oligo").  It should 

like similar to this one: 

 
The negative strand probe (always a 19-mer) should start from a pentamer of -7.5 kcal/mol or 
so, its 3'-end should be slightly more stable than 5'-end, the internal 12-mer stability should 
be about -22 kcal/mol, should not form significant internal hairpin loops, should not have 
sequence repeats, and should be as unique as standard hybridization probes. 

9.  Add manually TT or attach dinucleotides corresponding to the original mRNA to the 3'-ends of 
the oligos: use "Edit" - "Upper (Lower) Oligo" options.  The dTdT is preferred for a better 
probe stability. 

4.8.  Searching multiple files (batch processing) 
1.  Start Oligo and choose "Search" - "Sequence files". 
2.  Select files: choose the entire Test sequences folder. 
3.  Choose the Method of search: Hybridization Probes. 
4.  Click the "Ranges" button and check the "Choose hybridization probes every" "1000 bp". 
5.  Click "OK", and another "OK" to get back to the "Batch Processing" window. 
6.  Click the "Search" button.  Before Oligo starts searching it asks you for a file name for the 

results data.  Default is "BatchResults.txt", a plain text file.  Enter a new name or leave it as 
is.  Note that you may save the file in three different formats:  Simple List, Full Analysis or 
Oligonucleotide Database.  Accept the name by clicking at the 'Save" button. 

7.  The Search Progress window displays how many files were processed and scheduled.  The 
search ends when this progress window disappears.  Open the BatchResults.txt file with any 
word processor. 
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4.9.  Searching multiple files for PCR primer pairs and than 
multiplexing the selected sets 

1.  Start Oligo and choose "Search" - "Sequence files". 
2.  Select files: click the "Select Files" and than "Add" in the Select Files window. 
3.  Make sure the File Format is set to "Nucleic Acid", and choose the Test sequences folder. 
4.  Select three files: Human, Mouse and Rabbit eIF-4E.seq and click "Add", and than “Done” 

button. Clicking “OK” button will accept the selected files, but before clicking OK you may 
want to save the set of files for later use with the "Save Set" button. 

5.  In the "Batch Processing" window set "Save 3 results per file" and click the "Method" button. 
6.  Choose "PCR Primers " option and click the "OK" button. 
7.  Click the "Search" button.  Before Oligo starts searching it asks you for a file name for the 

results data.  Default is "BatchResults.txt", a plain text file (Simple List).  You'd need to save 
this file in Oligo database format, so change the File Format (low portion of the window) into 
"Oligonucleotide Database".  Enter a new file name on the top or leave it as is.  Note the 
destination folder, and if it is not correct, change it.  Accept the name by clicking at the "Save" 
button. 

7.  The Search Progress window displays how many files were processed and scheduled.  The 
search ends when this progress window disappears.  Open the BatchResults.odb file with 
Oligo. 

8.  The database window should look like this: 

 
On the top you'd see the individual primers and on the bottom the sets.  You may sort data of any 

of the columns by clicking on the column title (secondary sort when holding the option or Alt 
key pressed). This applies also for the Sets portion of the window. Product length is 
calculated from the ID Number description, so if you make a set manually the product length 
may be incorrect or not show at all. 

9. From the Analyze menu choose Multiplex All - Sets - Minimize Reaction #.  The bottom of the 
window shows the compatible sets of primers,  
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where the set numbers are marked in red, and in parenthesis you see the individual primer 
numbers. Depending on the Database Options the results may vary.  You may change the 
Group display by clicking on the slider, and when you click the "Select" button all the primers 
in a displayed Group get highlighted. 

10.  You may select those primers by clicking on the check boxes individually on the left of the 
window or check all selected primers from the Export menu.  Checking may be important for 
saving or printing data, depending on how is the priting set from the Print/Save option in the 
File menu.  The Show/Hide icon (to the left of the checkbox icon)  

 
may be used to show either the first highlighted record, oligonucleotide sets or multiplexing 
results. Hide option conceals the bottom part of the Database window. 

 

4.10.  Searching a file for probes only in the selected regions 
1.  Start Oligo and open BRCA2 gene.seq located in the Test sequences folder. 
2.  Open "Search for Primers & Probes" dialog window and choose "Hybridization Probes". 
3.  Make sure that the “Parameters” Search stringency is set to “Moderate” (it actually may be 

anything, but the window snap shots here would be when the Moderate stringency is used.) 
4.  Click the “Ranges” button and click the Check Region(s) button at the lower left. 
5.  When you open the Features window, check the third check box from the top as shown below: 

 
This selects all the mRNA regions in the gene. 

5a. Note: you may create a new feature, for example, if you want probes in the end and the 
beginning of the sequence only you may click the “+” button at the low left of the window and 
type name of the featue (such as “ends”), double click in the “Location” column, and type 
“join(1..1000, 84468..85469)”, and click on the check box. 

6.  When the Feature #3 is highlighted, the bottom of the window shows a map of the regions 
where the search will be performed.  Click the Accept button, returning to the “Search 
Ranges” window. Note: not only when you enter a new feature but even if you check another 
feature you myst click the the Accept button. Later on Oligo will ask you to save the sequence 
to make this change permanent. 

7.  Check the “Find oligos in checked region(s) only, as shown: 
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Note that another option to search in discontinuous regions could be “Choose hybridization 
probes every x number bases”. 

8.  Click “OK”, and in the “Search for Primers & Probes” window click the “Search” button. 
9. The search returned 151 Upper Oligos and 148 Lower Oligos located only in the mRNA 

regions. 
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5.  Other Search Options 

5.1.  Search for a sequence string 
Oligo's search for string is not just a plain 'Find' function commonly implemented 
in most editing software. It allows searching for mismatches and for ambiguous 
bases.  This example shows the process. 
1.  Start Oligo, open Human eIF-4E.seq and choose "Search" - "for a Sequence String + strand". 
2.  Type a degenerate sequence CAYNNNNRTG. It's an Msl I recognition site and click the "Find" 

button.  

 
3.  The results pop up in the "Selected Bases" window in the "Strings" column.  Click the last 

position (1813).  You should see the following window: 

 
The pos. 1813 is highlighted.  At the same time the Current Oligo pos. 1813 is selected and you 

can see this in the Sequence window: 

 
The arrows point to pos. 1813, marked in orange.  This position is at the beginning of a 10 bp-

long palindrome (marked in green).  The palindrome itself was selected as the Upper Oligo, 
shown above as the top sequence in red. 



 

 204 

5.2.  Search for restriction enzyme sites 
1.  Start Oligo, open Human eIF-4E.seq and choose "Search" - "for Restriction Sites..." option. 
2.  Click the "Select Enzyme Database".  The files are located in the Tables sub-folder. 
3.  Click the 5&UP.ENZ file containing most 5-cutters and higher and the "Select" button. 
4.  Choose "Linear" sequence and click the "Search" button. 
5.  You should see the results in the "Restriction Enzyme Sites" Analyze window: 

 
This window consists of two parts. The top one is a graphical representation: the entire row 

represents the length of the sequence file and the blue vertical lines are the recognition sites.  
The bottom part is the enzyme listing, ended at the bottom with a list of non-cutting enzymes 
(scroll the bar down to see it: the picture above does not show it).  The actual recognition 
sites are listed in black, and the fragment sizes are in green. 

 

5.3.  Search for restriction enzyme sites in protein 
This search reverse-translates a protein sequence into all combinations of 
reading frames and finds all possible restriction enzyme sites that could be 
made.  This feature is useful in gene construction projects.  The example below 
shows how to find a protein of interest, set the proper reading frame and then 
find the restriction sites only in this protein. 
1.  Start Oligo, open BRCA gene.seq and open the Open Reading Frames window from the 

Analyze menu. 
2.  Find the longest pen reading frame in the sequence. This is the one we'd like to analyze for 

potential restriction enzyme sites. Click on the graphical representation of it to set the proper 
reading frame (see the graph below).  You may use the zoom-in slider located at the top left 
of the window for a better view. 
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3.  Choose "Search" - "for Restriction Sites in Protein..." option.  It should indicate Reading Frame 

2. 

 
4.  Type in the Start and End position numbers of the protein. You should find those numbers in 

the ORF window. 
5.  Click the "Search" button, if you want to find all possible enzyme "Cut Types". 

 
6.  After the search the results are displayed in a window with a very similar format to the 

standard "Search for restriction enzyme sites" window, except that the degenerate protein site 
is listed instead of the actual DNA recognition site sequence (all those symbols are explained 
in the Appendix E of the User Manual). 
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